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Instruction Manual

Please be sure to read this manual before using this product.
Keep this manual in a safe place for future use.
This printer should only be used by operators who are appropriately trained in its safe

operation.




. When you dispose of the machine

Required Tools
Phillips screwdriver: M3 to M5

Disassembling

(1) Remove the Cover of BACK SIDE bottom center.

(3) Pickup the Lithium Battery (1) to the direction of the arrow.

Note based on California law (USA) on the use and handling of Perchlorate

This product contains a CR Coin Lithium Battery which contains Perchlorate Material — special handling may

apply.
See http://www.dtsc.ca.gov/hazardouswaste/perchlorate.



http://www.dtsc.ca.gov/hazardouswaste/perchlorate

BB saFeETY INSTRUCTIONS

Thank you very much for buying a BROTHER printer.
Before using your new printer, please read the "SAFETY INSTRUCTIONS" and handling instructions carefully.

1. Safety indications and their meanings

This instruction manual and the indications and symbols that are used on the printer itself are provided in order to ensure
safe operation of this printer and to prevent accidents and injury to yourself or other people.
The meanings of these indications and symbols are given below.

Indications

g D AN G E R The instructions which follow this term indicate situations where failure to follow the
instructions will result in death or serious injury.

n W ARN | N G The instructions which follow this term indicate situations where failure to follow the
instructions could result in death or serious injury.

n C AUTI ON The instructions which follow this term indicate situations where failure to follow the
instructions may result in minor or moderate injury.

The instructions which follow this term indicate situations where failure to follow the
((|)) IMPORTANT . )
. instructions may result in damage to property.

(( ! )) NOTE The instructions which follow this term indicate precautions and restrictions for use.

Symbols
This symbol (/\ ) indicates something that you should be careful of.
é = = = = = The picture inside the triangle indicates the nature of the caution that must be taken. (For
example, the symbol at left means "beware of injury".)

® LRI This symbol (®) indicates something that you must not do.

This symbol (.) indicates something that you must do.
9 "o The picture inside the circle indicates the nature of the thing that must be done. (For example,
the symbol at left means "you must make a ground connection".)

2. Notes on safety

A DANGER

f Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.




SAFETY INSTRUCTIONS

>

A WARNING

Basic precautions

This printer should only be used by operators who are appropriately trained in its safe operation.
The printer is not suitable for use in places where children are present.

To prevent accidents and problems, do not modify the machine by yourself. Brother will not be held
responsible for any accidents or problems resulting from modifications made to the machine.

Do not handle the power cord with wet hands. Otherwise, it may cause electric shocks.

Installation

PO PP @PPO PePoo®

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise, it may cause fire or electric shocks.

Do not connect power to the printer on the floor near the printer. Otherwise, it may cause a fire, electric
shock, or malfunction if water drips from the printer.




A WARNING

Printing

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a
foreign object inside, it may result in fire or electric shocks or problems with correct operation.

Do not allow the printer to come into contact with liquids. Otherwise, it may cause fire or electric shocks or
problems with correct operation.

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact
the place of purchase or a qualified technician.

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise, it may cause fire or
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power
cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise, it will be caught up, which results in
injuries.
Turn off the power when you approach the fan.

A CAUTION

Environmental requirements

Use the printer in a place which is adequately ventilated. A slight odor is generated when the printed articles
are being fixed by heat.

Installation

> B PO |@

The printer machine weighs 690 kg (1521 Ib). Transporting and setting up of the printer should be held in the
proper way. Otherwise, the printer may topple over and cause injury.

Unplug the printer and contact the dealer where you purchased the printer or a trained technician if the
printer topples over. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may topple over, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power is turned on
by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. You may get injured if it becomes
unbalanced and tips over.
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A CAUTION

Printing

This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise, your
hand may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise, your hands may
touch against moving parts and this may result in injury.

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So, wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.

Be careful not to put your hands in the clearance of the cover of the lifting up/down mechanism. Doing so
may cause injury.

Maintenance

Qo PO OPoPe
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Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise, you may
be injured.

Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or
vomiting.

When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of
contact with eyes, do not rub but immediately rinse the eyes with water.

Keep the liquids out of the reach of children.

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

Follow the corresponding instructions in the manual when you put your hands inside the cover during regular
maintenance while the power is turned on.
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«1» IMPORTANT

Printing

e

Do not move the platen by hand. Otherwise, the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.

«1» NOTE

eSS

Use the printer in an area which is free from sources of strong electrical noise such as electrical line noise or
static electric noise. Sources of strong electrical noise may cause problems with correct operation.

Any fluctuations in the power supply voltage should be within £10% of the rated voltage for the printer.
Voltage fluctuations which are greater than this may cause problems with correct operation.

The power supply capacity should be greater than the requirements for the printer's power consumption.
Insufficient power supply capacity may cause problems with correct operation.

In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet.
Lightning may cause problems with correct operation.




3. Warning labels

L

Waste ink tank

\7

Cleaning solution bottle
9L

\7

Waste water tank

L

Pretreatment
5kg (11 Ib)

\7

Ink bottle
9L

Pretreatment
20 kg (44 Ib)

X1101
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This printer has the following warning labels displayed on it.

Follow the precautions given on each warning label for your work.
When the label is peeled off or illegible, contact the place of purchase.

1 /\ CAUTION

Moving platen, T-shirt tray and covers can cause bodily injury.
Keep body parts away from moving parts.

A\ VORSICHT

Druckplatte, T-Shirt-Ablage und konnen

Halten Sie Korperteile von beweglichen Teilen fern.

/N ATTENTION

Gardez les parties du corps éloignées des piéces mobiles.

Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.

A\ATENCION

Mantenga las partes del cuerpo alejadas de las partes méviles.

Moviendo la placa, la bandeja de camisefa y las cubiertas pueden causar una herida personal

A\ ATTENZIONE

Tenere le parti del corpo lontane dalle parti in movimento.

Tavoletta mobile, il fipiano per la T-shirt ed il carter potrebbero causare infortuni.

AEE

TITIRTYvY A UAEBNN—EDHIEFEREH, FH%ET D, EHENNSHERTE,

NG

FREER THIEANSERZARSBEN. SHT2REEER TS

A\ CUIDADO

Movimento do cilindro, prato de impress&o e tampas podem causar lesdes corporais.

A& R
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A DANGER A GEFAHR

Hazardous voltage wi
cause injury. Turn off main| Bitte schalten sie den hauptschalter | des blessures. Eteindre
switch and wait 5minutes | aus und warten sie 5 minuten, l'nterrupteur et attendre 5
lbefore opening this cover.| bevor sie diese abdeckung offnen. |minutes avantd'ouvrir le capot

A DANGER

A S

MRBBENS, RSBRG.
HEETERR § /S, BARES.

A PERIGRO

Hochspannung verletzungsgefahrl [Un voltage non adapte provogue| Un voltaje inadecuado puede

provocar las heridas. Apagar el
interruptor principal y esperar 5
minutos antes de abrir esta cubierta.

>s <

4 A PERIGO

A tenséo é perigosa e pode causar lesdes.
Desligar a corrente eléctrica e esperar pelo
menos 5 minutos antes de abrir esta tampa.

>pPs<

5 A CAUTION

Take care not to let the liquids come into contact with
your eyes or onto your skin,
otherwise inflammation can result.

/\ ACHTUNG

Vermeiden Sie den Kontakt der Flussigkeiten mit
Augen und Haut, sonst kdnnen diese gereizt werden.

/\ ATTENTION

Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

/\ ATENCION

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,
de otro modo inflamacién puede resultar.

A\ ATTENZIONE

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

AEE

REERTAREND D,
1Y IREDRFENBPEEICNNBRNELSCTIIE,

/\ CUIDADO

Tome cuidado para néo deixar que os liquidos entrem
em contato com os olhos ou a pele, caso contrario,
podera ocorrer inflamagéo.

6

z
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A\ CAUTION

A\ VORSICHT

V)

Do not drink the liquids under
any circumstances, as they can
cause vomiting and diarrhea.
Take care not to let the liquids
come into contact with your

Bitte trinken Sie nicht die
Flussigkeiten, da die Gefahr von
Erbrechen und Durchfall besteht.
Vermeiden Sie den Kontakt der
Flussigkeiten mit Augen und
Haut, sonst kénnen diese gereizt
werden. Halten Sie die
Flussigkeiten von Kindern fern.

eyes or onto your skin,
otherwise inflammation can

/A ATENCION

result. Keep the liquids out of
the reach of children.

A\ ATTENTION

Ne pas avaler les liquides
d'aucune maniere, car ceci
pourrait entrainer

vomissements et diarrhée.

No tome los liquidos en cualquier
caso, como pueden causar
vomitar y diarrea.Tome el cuidado
para no permitir que los liquidos
toquen los ojos nien la piel, de
otro modo inflamacién puede
resultar. Mantenga los liquidos
fuera del alcance de nifios.

Veuillez a ne pas laisser ces
liquides étre en contact avec

AE R

les yeux ou la peau, car ceci
pourrait entrainer une
inflammation.

Maintenez les liquides hors de
portée des enfants.

THR-BS5UT 2AEEN B D VTR
EDRBBERFBNT &, RAFERT
TOREMEN B Do 1 VIR EDTREEN
BB RNLSICTETE,
FHOFOBHIBNEIBCELIE,

A\ ATTENZIONE

Non bere per nessun motivo i
liquidi poiché possono causare
vomito e diarrea.

Evitare il contatto di questi
liquidi con gli occhi e con la
pelle poiché potrebbero creare
infiammazioni.

Conservare i liquidi lontano
dalla portata dei bambini.

AEE

@0

HAURE SIS Rt 57 AHE
ERINK B PTRES | R A - RIME
FRAEAE CMBIRPR AL Lo
EREELEL AR RIS .

/A CUIDADO

W Deposite in compliance with your local

N&o beba os liquidos sob nenhuma
circunstancia, pois eles podem
causar vomitos e diarréia. Tome
cuidado para ndo deixar que os
liquidos entrem em contato com os
olhos ou a pele, caso contrario,
podera ocorrer
inflamagao.Mantenha os liquidos

fora do alcance das criangas.

M Gebrauchte es gemas értlichen Richtlinien
entsorgen.

W Jetez conformément a la reglementation
locale en vigueur.

M Deseche siguiendo la normativa local.

M Smaltire in conformita alle normative locali
M Deposite em conformidade com os
regulamentos locais.

B S OEBICH>TRELTIIS,

L WsEcdcEn el 20
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Before Using Your Printer for the First Time

1-1. Be sure to read the following notes before using the printer

Keep in mind the following points before using the printer:

Precautions for proper use

e PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY.
Even when the printer is placed in standby mode, it performs such maintenance as white ink circulation inside
the main unit automatically to prevent sedimentation of the white ink.

o Please use the printer within the scope covered by its warranty for the best print result (temperature: 18
to 30°C (64.4 to 86°F) and humidity: 35 to 85%).
Otherwise, the print heads may be clogged with ink and ink may splash.

e  Adjust the height of the platen according to the print medium before using it.
Adjust the height and check that the platen is not detected by the obstacle sensor.

o Do not excessively lower the platen.
Otherwise, ink mist will be scattered inside the printer, which may result in staining of the printing surface,
blurring of the printed image, and malfunction of the sensor and the main unit. Increase the platen height if the
platen too low sensor is activated.
="5-4-2. Platen height adjustment >>P.156"

e Never power off the printer or open the cover while the printer is in operation.
Otherwise, the printer may break down or a print job may end up in failure.

e  Until the ink is firmly fixed, do not touch the printed part.

If a T-shirt is soiled with such ink that has not been firmly fixed on its surface, such ink stain cannot be removed
even by washing.

About ink bottle

Refill ink into the ink bottle of the same color as the ink bottle seal.

o  Shake the white ink well until no deposits remain on the bottom of the bottle.
Otherwise, the white ink may precipitate.
="6-1-2. Refilling white ink >>P.179"

e Store consumable goods in a place where they are not exposed to direct sunlight, high temperatures,
or low temperatures.

o Use up the ink and pretreatment before their shelf life.
Use of an expired ink bottle may make you liable for the cost of repairs even during the guarantee period.

¢ In order to take full advantage of the printer capabilities, we recommend to use the ink specified by us.
In cases where the printer malfunctions due to the use of non-genuine ink, you may be liable for the cost of
repairs even during the guarantee period.

o Be sure to close the ink tank lid once you have refilled the ink.

° Handle the ink bottle with care.
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Before Using Your Printer for the First Time

e Handle the IC stick with care.
Take care not to lose the IC stick.
Once you have refilled ink, you cannot print until you insert the IC stick.

About pretreatment

e  Apply the pretreatment when using white ink.
If a T-shirt to which the pretreatment is applied is coated with only color inks, its stains may be wiped off by
washing.

o  After a T-shirt is coated with the pretreatment, store pretreatment in a place where it is not exposed to
direct sunlight, and wash it with clean water at an early stage after ink is applied to it.
When a white or light-colored T-shirt is coated with the pretreatment, the coated surface color may change, and
cannot be restored to the original color even if the T-shirt is washed.

e  When performing printing for the first time, try pretreatment in an unnoticeable area.
Some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they
are washed.

e  Wash away any imprint of the pretreatment with water.

e  When a color transfer occurs, wipe the color-transferred area clean of dirt with a soft and clean cloth or
a toothbrush that is moistened with a small amount of mild detergent for home use or alcohol.
If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer
may occur.
Also, when a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer
may occur in the same fashion.

About maintenance

e If you put your hands inside the cover during regular maintenance while the power is on, follow the
instructions in this manual.

¢ In order to keep good printing quality, perform maintenance on a regular basis.
="6. Precautions to keep good printing quality/use printer over the long term >> P.176"

e We recommend to use the genuine cleaning solution that is specified by us when cleaning the head or
cap.
This allows you to take full advantage of the printer's intrinsic capabilities and use it for a long period.
Using commercially available alcohol or cleaning solution could cause damage to the print heads.

e Never remove the print heads except when they are replaced with new ones.
Because they are precision components, the print head may fail.

What to do when not using printer

¢  When the printer will not be used for a prolonged period of time, take appropriate procedures before
storing the printer depending on storage period or condition.
=7"6-3. When Not Using for a Long Period of Time >> P.239"

16



Before Using Your Printer for the First Time

About waste handling

o Dispose of the residual wastes and waste ink properly as water-based waste fluid in accordance with
applicable laws and ordinances.

Others

¢ Inthe event that the printer is relocated elsewhere for layout change, etc., place a level gauge on the
top surface of the platen to make such an adjustment that the printer will be placed horizontally level.

e You cannot connect this product directly to the communications lines, including the public wireless LANs, of
telecommunication carriers like mobile communications companies, fixed communications companies, or
internet providers. Ensure that the product is connected through a router, if it is to be used over the internet.

<NOTE>

° This apparatus is Class A information technology equipment based on the standards of the Voluntary Control Council for
Interference by Information Technology Equipment (VCCI). Using this apparatus in a home environment may cause radio
interference. In that case, the user may be required to take appropriate measures.

About trademarks

The names of operating systems described in the main context of this manual are abbreviated. Product names used in
this manual are, in general, trademarks or registered trademarks of their respective developer or manufacture. However,
in this manual, the ® marks or TM marks are not used.

Brother logo is registered trademark of Brother Industries, Ltd.

Apple, Macintosh, Mac OS, iOS, OS X, macOS, Safari, iPad, iPhone, iPod and iPod touch are the trademarks or
registered trademarks of Apple Inc. in the United States of America and other countries.

The official name of Windows® 10 is Microsoft® Windows® 10 operating system (represented as Windows 10 in this
manual). The official name of Windows® 11 is Microsoft® Windows® 11 operating system (represented as Windows 11 in
this manual).

Microsoft®, Windows® 10 and Windows® 11 are trademarks and registered trademarks of Microsoft Corporation in the
United States of America and other countries.

Corel, Corel's logo and CorelDRAW are trademarks and registered trademarks of Corel Corporation.

Adobe, Adobe's logo, Acrobat, Photoshop, and lllustrator are trademarks of Adobe Systems Incorporated (Adobe
Systems).

Other product and company names mentioned herein may be the trademarks or registered trademarks of their
respective owners.

Information in this document and the specifications of this product are subject to change without notice.

About the CE declarations

Downloadable from: https://www.brother.com
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About software

This printer uses its own software.
To use this printer, you are required to agree with the End-User License Agreement for Brother Software as mentioned
below.

End-User License Agreement for Brother Software
You can use this software if you agree to comply with the terms of the End-User License
Agreement. You cannot use this software unless you agree to comply with the terms.
1. Ownership
The rights for this software and its reproductions belong to Brother Industries, Ltd. (hereafter
referred to as the “Company”) or its suppliers. The Company does not transfer the copyright
related to this software to you under this agreement.
2. Permission for license
2.1 The Company grants you a non-exclusive right to use this software.
2.2 You cannot conduct any of the following acts:
(1) Modifications of all or part of this software,
(2) Reverse engineering, disassembly, or decompilation,
(3) Loaning or leasing this software,
(4) Keep this software available for download in public.
3. No warranty
The Company provides this software without any warranty, either expressed or implied, including
but not limited to a warranty for free of defects, fithess for a particular purpose, and
non-infringement of third party rights.
4. Limitation of liability
The Company shall not be liable for any direct or indirect damages caused by or connected with
this software.
5. Termination of license
The Company may terminate this agreement without notice if you violate the terms and conditions
outlined in this agreement.
6. Governing law
This agreement shall be construed in accordance with Japanese law.
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1-2. Components included with printer

The components included with the printer are shown below. However, in the event that there is any missing
component(s), please contact your dealer.

@® @ ® @ ®
2 ; o
/ @® ©O :

uEluElvEerE©@
uEldEluEl (@

® ®

&
2y 24 © &

U U
X1102
No. Name Quantity | No. Name Quantity
1 Main tank cover 1 11 | USB hub 1
2 Main tank cover installation screw (M4) 2 12 | Key to main body door ™ 6
3 | Hole cap (black) 2 43 | Cleanstick R 10
4 | Print switch unit 2 Clean stick T 10
5 | Print switch cover installation screw 8 14 | Cleaning cup 1
6 | Print switch unit installation screw 8 15 | Gloves 2
7 | Carriage foam 1 16 | Cam fixing pin 2
8 Humidifier pipe R 1 17 | Wiper blade 6
9 | Waste ink tank 1 18 | Flushing foam 3
10 | Waste water tank 1 19 | Setup Manual 1

*The print heads and mist fan filter are attached to the main body before shipping.

<TIPS>
: The administrator should keep the key.
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Before Using Your Printer for the First Time

1-3. Other items you must make available for use

What you buy from our distributors

9-L Ink bottle
Cleaning solution
Pretreatment
AC power cord
<NOTE>
3 There is a risk of malfunction or fire if you use other cables than the specified one. Purchase the cable (optional item) from

your dealer. Also, do not use any extension cable.

Others

e  LAN cable (10BASE-T/100BASE-TX/1000BASE-T)

e  USB flash memory
Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You
cannot use a USB memory with security functions such as password lock function or beyond 32 GB.
<NOTE>
° Use the supplied USB hub if the USB flash drive cannot be recognized.

e  Pure water
Pure water refers to clear water, such as distilled water or purified water, to dilute the pretreatment and
supply to the humidifier.
<NOTE>
. Avoid using such water as tap water in which impurities are contained.

e  Heat press
It must deliver the performance through which the print range of the size of a platen to be used can be
covered and 180°C (356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be
sure to use the heat press, but not an oven, to smoothen the surface fluff.

e  Peel-off sheet
Always use this sheet to flatten the fixed surface and enhance the peel property when fixating the

pretreatment and ink by means of the heat press. ="5-3-1. Provisions for pretreatment >> P.145"

e  Silicone foam (of open-cell structure)
It is the foamed mattress which resists heat. Use this at a fixing stage through the use of the heat press.

° Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.

e  Water supply to the humidifier
="1-5-2. Water supply >>P.33"
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Before Using Your Printer for the First Time

e  T-shirt (printing medium)
¢ 100% cotton
e Polyester blended yarn fabric

<TIPS>
. Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.
. Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.
3 Perform a printing test beforehand. Then, the following phenomena may occur:
- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.
- Fabric material may turn yellow after the pretreatment is fixed.
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1-4. Name and function of each component

1-4-1. Front part
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Before Using Your Printer for the First Time

>

No. Name Function
1 | Top cover Open this cover when cleaning the internal area of the printer.
2 | Carriage Holds the print head.
Checks the presence of any obstacles by their height (such as wrinkled T-shirt)
Obstacle sensor I ; . .
3 that are within range to collide with the print head.
“Platen too low” sensor Make sure that the clearance between the head and platen is not too large.
4 | Platen sheet It helps to keep the T-shirt from moving/shifting during printing so that an image
can be clearly printed.
5 | Platen Set the T-shirt to be printed.
6 | Shoulder bar Align the position of a T-shirt with this bar.
, This T-shirt tray holds such portions of T-shirt that droop down on it and feeds
7 | T-shirt tray . L .
the entire T-shirt into the printer.
Use this handle to secure the platen in place.
8 | Platen fixing handle Tighten or loosen it when attaching/removing the platen. Keep it tightened
when printing.
9 | Mist fan filter It absorbs ink mist which is generated inside the printer on its surface.
10 | Operation panel Operate the printer using this panel.
There is no print data when this button remains off. This button blinks during
11 | Print button reception of print data, and it illuminates when such reception is completed.
Printing will begin if you press this button when it is illuminated.
Press either one to cancel operations, such as printing and platen movement.
12 | Stop button Printer will come to a stop after necessary actions for keeping the printer's good
quality, such as retracting operation of print heads and capping operation, are
completed.
13 | Monitor mounting frame You can mount the monitor by using the monitor arm.
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1-4-2. Right side view

/

[ '{ |

3 2
No. Name Function
1 | Right side cover Open this cover when cleaning the internal area of the printer.
5 Ink tank White (W), magenta (M), cyan (C), yellow (Y), black (K), green (GR), and orange
(OR) from the right side.
3 | Cleaning solution tank It is the tank that reserves the cleaning solution used for maintenance.
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Before Using Your Printer for the First Time

1-4-3. Left side view/Rear side view

>

No. Name Function
1 | Upper left side cover Open this cover when cleaning the internal area of the printer.
2 | Lower left side cover Open the cover and replace the waste ink tank and waste water tank.
3 | Waste ink tube This tube is used to direct the flow of waste ink down into the waste ink tank.
4 | Waste ink tank This tank collects waste ink.
5 | Drainage tube This tube is used to drain water.
6 | Waste water tank This tank collects drain water.
7 | Model plate On this plate, a product serial number is inscribed.
8 | Power cord insertion port Insert the power cord into this port.
Use this button to turn the power on/off to the printer.
9 | Power switch To turn off the power, execute [Prepare Power OFF] on the operation panel, and
turn off the power switch after completing the operation.
10 | LAN port Into this port, insert the LAN cable which is to be connected with a PC.
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Before Using Your Printer for the First Time

1-4-4. Inside the cover

<IMPORTANT>
o If you put your hands inside the cover during regular maintenance while the power is on, follow the instructions in this manual.

3 2 1 8 9

No. Name Function
1 | Print head (front: on the color side) It ejects the color ink.
2 | Print head (center: on the OR/GR side) It ejects the OR/GR ink.
3 | Print head (rear: on the white side) It ejects the white ink.
4 | Carriage linear guide This shaft supports the carriage.
In order to keep good printing quality, this unit performs
5 | Maintenance unit maintenance functions to the print heads on a regular basis.

(Example: Auto-Cleaning Function)

The caps protect the color and white head surfaces and suck ink
when cleaning the heads.

Wiper unit It wipes away ink from the head surface.

7 | Wiper cleaning tank (Under the wiper unit) | This tank keeps cleaning solution and soaks and cleans the wiper.
To keep good printing quality the foam absorbs the ink-jet droplets
ejected from the print head.

9 | Flushing receiver Set the flushing foam.

To prevent drying of print heads, it fixes the carriage to the cap
position of the maintenance unit.

11 | Carriage foam It absorbs ink and prevents printed materials from being stained.

6 | Caps (color, white)

8 | Flushing foam

10 | Carriage locker solenoid
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1-4-5. Operation panel

>

No. Name

Function

1 | Liquid crystal panel

It indicates the job name or file name of print data, the active status of the
printer, and the menu for various settings.

2 | Error LED

When it remains off: No error has occurred.
When it remains on: One or more errors have been detected.

While the menu screen is being displayed, use this button to select your

3 | Up-arrow button * desired menu item.
In the numeric value setting menu, use this button to increase the target value.
4 | USB flash insertion slot Insert a USB flash memory into this slot.
While the menu screen is being displayed, use this button to select your
| desired lower-level (right) menu item.
5 | Right-arrow button L (right)

While the standby mode screen is being displayed, use this button to display a
warning when any warning message appears.

6 | IC stick insertion slot

This slot accommodates the IC stick that contains the color information for use
when refilling the ink.

7 | MENU/OK button

®

If this button is pressed when the printer is placed in the standby state, the
menu screen will appear.

While the menu screen or the error screen is being displayed, use this button to
finalize and accept the currently displayed content.

8 | Down-arrow button

A 4

While the menu screen is being displayed, use this button to select your
desired menu item.
In the numeric value setting menu, use this button to decrease the target value.

Back button /
Left-arrow button

bl

While the menu screen is being displayed, use this button to return to only one
upper-level (left) menu screen.

If this button is pressed when the printer is placed in the standby state, the
printer status will be displayed.
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>

No.

Name

Function

10

Stop button

),

With this button, such actions as printing and platen movement can be
canceled.

Printer will come to a stop after necessary actions for keeping the printer's good
quality, such as retracting operation of print heads and capping operation, are
completed.

While the menu screen is being displayed, the screen will exit and return to the
standby mode screen.

11

Platen button

It is used to move the platen toward the rear or front of the printer. Use this
button to ascertain whether the platen is set to a proper height after the platen's
height is adjusted.

12

Shortcut button

Performs the action assigned to the shortcut function.

13

Power LED

When it remains off: The power of the printer is turned off.
When it remains on: The printer remains turned on (powered on).
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Liquid crystal panel

The picture shown below indicates a state under which the printer has received print data. On this screen, the printer's
current state and necessary information for printing are displayed.

1

10
Sample Data.png

1001

02/72 @ 2|

3 4 5 6 7

No.

Indications

Function

Preview image

The preview display screen of received print data is shown in this window. The
preview display screen shown here is indicated upside down as opposed to the
page orientation (the upper side of the preview image is oriented toward the front
of the printer main unit).

Furthermore, it is possible to change the direction of the preview display screen
as well.

Remaining cleaning solution
volume indication area

In this area, the current remaining cleaning solution volume in the tank is
displayed.

Remaining ink volume
indication area

In this area, the current remaining ink volume of each tank is displayed.
In the left-to-right order, the remaining ink volume in the orange (OR), green
(GR), black (K), yellow (Y), cyan (C), magenta (M), and white (W) ink cartridges
are shown here.

g : The remaining ink volume is running low. Make ink available for use in the

next printing session. !

.: Ink has been depleted.

Waste ink tank replacement
indication

This indication shows a guideline for replacing the waste ink tank.

Ink volume to be used

The required ink volume (cc) for printing out one sheet of the received print data
is displayed here.
(CMYK + White)

Auto-Cleaning

Head cleaning is automatically performed every time a predetermined number of
sheets are printed in order to provide stable printing quality.
It is possible to make displayed icon changes in [Standby Display Icon Settings].
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No. Indications Function

This mark appears when any warning is issued. Pressing = | causes the

7 | Warning mark
9 0 current screen to move to the warning screen where the applicable warning

message is indicated.

The total number of printed sheets of which printing operation is completed in
response to the received print data is displayed here. (0 to 999)
Platen size that is specified by the printer driver during data creation is indicated

8 | Number of printed sheets

9 | Platen Size
here.
10 Text string display area on In this area, the print job name or file name, auto cleaning, receiving state,
basic display screen standby state, etc. are shown.
11 | Progress bar display area It displays a state of progress during the process of printing.
<IMPORTANT>

"2 If you perform printing that requires a large volume of ink when the remaining ink level is low, the ink may be depleted
during the printing process. As a rough indication, refill the ink before you perform printing that requires 20 cc or more
ink.
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When receiving print data, press the left arrow button on the screen to switch it over to the following screen to display
print information.

20/01/2022 15:35

7
T ™
, % 1200dpi
o w1z
) 2] 0K ] ON
Lyl
: 7 W 02/72 ¢ © 18:00
20/01/2022 15:19
T -
% 1200dpi = £ |1
2 2 OFF
7
Lyl
4 @ O 18:00 .
5
No. Indications Function
1 | Time/Date Displays the current date and time.
2 | Resolution icon The printing resolution of received print data is displayed here.
e The print direction is displayed here in the form of either bi-directional or the
3 | Print direction icon o )
uni-directional icon.
The humidifier operates to keep the humidity of the unit between 65% and 75%.
4 | Humidity display “Suitable” will be displayed if the humidity is appropriate, and “Low” will be displayed if
it is less than 65%RH.
Head cleaning is automatically performed every time a predetermined number of
sheets are printed in order to provide stable printing quality.
At the next print, will be displayed on the right side if auto cleaning is activated
5 | Auto-Cleani
Hio-Lieaning before or after printing.
(The conditions for performing auto cleaning will change as appropriate depending on
changes in temperature and humidity, the length of printing intervals, etc. Therefore,
the presence or absence of auto cleaning may differ at the time of actual printing.)
6 | Platen position The current platen position is displayed.
The humidifier runs automatically. Therefore, you can see if it is currently running.
idifier ON/OFF
7| Humidifier E will be displayed on the right side when the waste water tank is filled with water.
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Before Using Your Printer for the First Time

>

time

No. Indications Function
The time of the next white ink circulation is displayed.
8 White ink circulation The time set by the maintenance tool is displayed.

The reinforced circulation of white ink will be performed if E

is displayed.
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Before Using Your Printer for the First Time

1-5. About the humidifier

The humidifier works to maintain the image quality and keeps the humidity of the unit properly.

Furthermore, the water accumulated inside the humidifier will be regularly discarded for hygiene control.

<IMPORTANT>

. If the humidity inside the printer is low, the amount of ink consumed will increase to maintain the functionality of the printer.

. If excessive water is supplied to the humidifier, the water will be released through the hose on the lower right front side of the
printer. Do not connect power cords on the floor near the printer. Doing so may result in electric shock.

<TIPS>

. The humidifier will not operate if the ambient humidity is high and the humidity inside the unit is sufficiently high.

1-5-1. About the water used

Use pure water.

<IMPORTANT>

. If non-pure water, such as tap water, is used, white powdery impurities will adhere to the inside of the unit, causing damage to the
printer and heads.

o Electrical conductivity of Pure water have to be less than 10 uS/cm.
For the measurement method, contact the dealer where you purchased the printer.

1-5-2. Water supply

Select the water supply to the printer from the following two methods.
Please refer to the Setup Manual for how to connect to the printer.

Optional items

e  Water tank supply ASSY
o  Water tube T6040 15M
e  L-shaped fitting 06-06

Commercially available item

e  Regulator
e  Pure water equipment

Supply from a water pipe

Water ' Pure water ' Printer

pipe equipment

<NOTE>
. If supplying water from a water pipe, perform piping according to the applicable laws and regulations.
. If necessary, use a regulator so that the supply pressure will be 40 kPa or less.
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Before Using Your Printer for the First Time

Supply from a tank

Tank ' Printer

<IMPORTANT>

. Fill the tank with pure water.

. Use a clean container to supply water to the tank.

o Install the tank about 31.5 in. (80 cm) above the installation location of the printer.
If the height is insufficient, water may not be supplied to the printer.

. The tube should be laid on the floor, and the length should be 49.2 ft. (15 m) or less. Piping should be done so that the height
difference between the tubes is about 5.9 in. (15 cm).

. Limit the number of L-shaped fittings to three per flow path.

. Be sure to mount a cable cover with sufficient strength to the tube.
Water will not be supplied and may leak to the floor if the tube is broken or cut off.

o Lay the tube so that the bending radius is 2.0 in. (5 cm) or more.
If the bending radius is small, the tube may break.

. If the tube is broken during laying, do not use the broken part.

. Do not use the optional humidifier water supply tube to connect to tap water piping.

. Loosen the tank's cap during use.

. Verify that the faucet is in the closed position before inserting or removing the tube. Failure to do so could allow the water to flow
out of the tank.

. Check inside the water supply tank once a month. Clean inside the tank if you notice any bad odor or discoloration.
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Menu list

On-screen menu manipulation

What to do How to operate

Pressing @ in the wait state causes the current screen to move to the menu
Start

selection screen.

By means of A ¥, change a menu item to another menu item to be displayed.

Pressing P causes the current menu to change to another menu item which is

Select / Acknowledge .
one level lower in the menu layer.

Pressing @ causes the currently displayed menu to be acknowledged.

Return to previous menu in Pressing ¥ causes the current menu to change to another menu item which is

upper menu layer ) )
Y one level higher in the menu layer.

e Ifyoupress #) whenamenu in the uppermost menu layer remains
Exit displayed, the menu will exit and the system will return to a standby state.
e Ifyou press @ when an optional menu remains displayed, the menu will

exit and the system will return to a standby state.
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Menu list
1st layer 2nd layer Description
[Position A]
[Position B]
[Position C]
[Position D]
[PI?ten height [Pos!t!on El This menu item is used to set the platen height.
adjustment] [Position F]
[Position G]
[Position H]
[User settings 1]
[User settings 2]
[Normal Cleaning] If no ink-jet droplets are' ejected, this menu item enables you
to perform nozzle cleaning.
In the event that the poor ejection of ink-jet droplets is not
. [Powerful Cleaning] improved by means of the normal cleaning, use this menu
[Head Cleaning] itom.
In the event that the poor ejection of ink-jet droplets is not
[Super Cleaning] improved by means of the powerful cleaning, use this menu
item.
[Nozzle Check CMYK] This is the test pattern to check to see if ink-jet droplets are
ejected from the color heads properly or not.
est Prinf [Nozzle Check White] This is the test patte.rn to check to see if ink-jet droplets are
ejected from the white head(s) properly or not.
This is the test pattern to check whether ink-jet droplets are
[Nozzle check OR/GR] ejected from the OR/GR head(s) properly or not.
[Black]
[Yellow]
[Cyan]
[Ink refill] [Magental Use when refilling the ink.
[White]
[Cleaning solution]
[Orange]
[Green]
Any print data stored in a USB flash memory (ARXG6E file,
[Print Data Load] ARXG file, ARXP file, or ARX4 file) is loaded into the system
with this menu item.
By selecting this menu item, you can display any print data
- , received in the order in which they are sorted from the
[Receiving History]
newest to the oldest ones, and you can select any one of
them.
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1st layer

2nd layer

Description

[Maintenance]

[Maintenance Part
Clean/Replace]

[White Ink Circulation]

[White Ink Tank Agitation]

[Humidification]

[Humidifier unit]

[Waste Ink Tank Disposal]

[Humidifier Drain Tank Disposal]

[Tank remaining volume sensor
correction]

[Wiper Cleaning Tank Operation]

[Head Replacement]

[Install Ink after Replacing Head]

[Initial Ink Installation]

[Recovery after Long Power—
OFF]

[Tube air bleed]

[Cap pump check]

[Log copy to USB]

Use when performing printer maintenance.

[Printer Setting]

[Print Direction]

[Back Light]

[Auto Screen Erase Time]

[Menu TimeOut Setting]

[Speaker Volume]

[Temperature]

[Preview display settings]

[File name display setting]

[Standby Display Icon Settings]

[Platen Setting]

[Low Temperature Mode]

[Low Humidity Mode]

[Post-circulation Auto Cleaning]

[Auto Cleaning Setting]

[Auto Cleaning Start Timing]

[Auto Multiple Pass Setting]

[Flushing Interval Setting]

[Flushing Volume Setting]

[Auto Job Delete]

[Network filtering]

[IP Address Set]

[Shortcut button setting]

Use when configuring the printer.

[Total Print]

[Temperature/Humidity Info]

[Confirm network
setting]

[IP Address]

[Subnet Mask]

[Default Gateway]

[Host name]

[MAC address]

Use when needed.
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1st layer

2nd layer

Description

[Check circulation schedule]

[Check humidification schedule]

[Language]
[Prepare Power OFF]
[Firm Version]
[Version] [Data Info]
[Serial No.]

[Head information]

Use when needed.
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Installation and preparation

Be sure to use the printer after making correct setting in accordance with the instructions described in this chapter.

AA\WARNING

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise it may cause fire or electric shocks.

> @ PP

A\ CAUTION

The printer machine weighs 690 kg (1521 Ib). Transporting and setting up of the printer should be held in the
proper way. Otherwise, the printer may topple over and cause injury.

Unplug the printer and contact the dealer where you purchased the printer or a trained technician if the
printer topples over. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may topple over, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power switch is
turned on by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. You may get injured if it becomes
unbalanced and tips over.

B> B Bk e
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3-1. Installation of printer

Please refer to the Setup Manual included with the printer, for details of unpacking procedures and installation
procedures of accessories.
For an installation site of the printer, please bear the following points in mind:
e  When installing the printer, avoid any place that presents direct sunlight or a large amount of dust.
e Thesizeis 66.5 in. (width) x 69.3 in. (depth) x 63.0 in. (height) (169 cm (width) x 176 cm (depth) x 160 cm
(height)). The main unit weighs 690 kg (1521 Ib).
e Do not use any extension cable.
e  Keep a minimum workspace of 31.5 in. (80 cm) in front and on the left and right sides of the printer. Also, keep
15.7 in. (40 cm) or wider clearance at the back of the printer. Keep 23.6 in. (60 cm) or wider space free above
the unit as well. If this space is not secured, you will have to move peripherals or the printer when making a
repair.
e  When installing the printer, place a level gage on the top surface of the platen to make adjustments so that the
main unit is set horizontally level.

Printer installation dimensions

4 23.6in. (60 cm) or more
N

~
31.5in. (80 cm)

or more

‘/1:.7 in. (

40 cm) or more

31.5in. (80 cm)
31.5in. (80 cm)

or more
or more -
129.5in. (329 cm)
or more 116.5 in. (296 cm)
or more

X1103
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3-2.

Installation and preparation >

Initial installation of printer

Please refer to the Setup Manual for the following initial installation procedures:

3-2-1.

Main tank unit

Print switch

Waste ink tank/Waste water tank
Humidifier pipe

Carriage belt tension adjustment
Humidifier water supply tube
Water supply tank (optional item)
Turning on the power

Level adjustment

Prepare a level gage and a 1.4-in. (35-mm) wrench.

(1) On the operation panel, press , and move the platen toward the front of the printer.
_

(2) Place a level gage on the top surface of the platen.

(3) Adjust the level by rotating the lower nuts that secure the legs (4 points) so that the main unit is set horizontally level

while checking the level gage.
<IMPORTANT>

Adjust so that the adjusters protrude 4.9 in. (125 mm) or less from the bottom of the frame.

4.9in. (125 mm)
or less
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Installation and preparation >

(4) Tighten the upper nuts on the lefts (4 points) upwards after adjusting the level.

<IMPORTANT>
. Check the level again with a level gage after fixing everything.
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Installation and preparation

3-3. Power supply of printer

Even when the printer is placed in standby mode, such maintenance as white ink circulation is performed automatically.

PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY.

<IMPORTANT>

. Do not turn off the power because if you do so, the machine mail fail because necessary maintenance operations are
not performed.

3-3-1. Turning on the power

Please refer to the Setup Manual, after the unpacking procedures and installation procedures are completed.
Please check the following points, before connecting the power cord to the printer:
e Ascertain whether the ink tube is connected to the print head correctly.
e  Ascertain whether the waste ink tube is inserted into the waste ink tank and waste water tank that have been
made available.
e  Ascertain whether at least about 31.5 in. (80 cm) of space required for the platen is secured.
<IMPORTANT>
o Turn on the power before you refill the ink.

(1) Connect the power cord to the power cord insertion port.
(2) Insert the power plug into an electric outlet.
(3) Make sure that the printer's earth terminal is properly grounded.

(4) Turn on the printer power switch with each door and cover closed.

<IMPORTANT>

. Never power off the printer while it is in operation. Otherwise, the printer may be damaged.

. Do not activate the printer with the ink tube not connected to the print head. Otherwise, the printer may be damaged.

. Make sure that no flushing foam extends off the outboard end portions of the flushing foam. If it sticks out of the end
portions, it may interfere with any nozzles and may result in non-ejection of ink-jet droplets.

<TIPS>

3 If the printer is activated after having been off for a long time, the maintenance operation including white ink agitation will be
performed for up to 4 hours, depending on how long the power was off.

Power switch
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Installation and preparation

3-3-2. Turning off the power

When you need to turn off the power

Turn off the power in the following cases.
e When moving the printer elsewhere.
¢ Inthe event that the power supply interruption is anticipated in advance, including the case where a planned
power outage is scheduled.

How to turn off the power
(1) From the menu, select [Prepare Power OFF] and press @

If the printer is operating, wait for it to finish.

(2) Cleaning will start at the end of the print job.

Follow the instructions on the panel and turn off the power.

<IMPORTANT>

. No cleaning will be performed at the end of the print job to keep the print heads in good condition if you turn the power off or
disconnect the AC power cable before the operation of [Prepare Power OFF] is completed. In these cases, the print heads
may fail to eject ink-jet droplets. For this reason, be sure to activate the printer once again and perform the head cleaning

after activation.
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Installation and preparation >

3-3-3. When there is no prospect of electric power recovery for a while due to power outage

Print head capping will be performed to prevent the print heads from drying out if there is a power failure while the printer

is operating and no prospect of recovery for a while.

<IMPORTANT>

. Be sure to turn off the power switch before starting work.

<TIPS>

° Perform the work specified below when no print heads are capped, e.g., when a power failure occurs during printing. The
specified work is not required if the print heads are capped.

(1) Unlock the upper left-hand-side cover and top cover and open them.

A

. “"Keyhole

eynoe BB

(2) Remove two screws to remove the cover.

\%E/?l. Screw m—
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Installation and preparation

(3) Place the cap fixing plate stored on the lower right side of the maintenance unit on the frame, and move the

carriage toward you until the carriage comes in contact with the cap fixing plate.

i Cap fixing plate

Cap fixing plate

<IMPORTANT>
° Be careful not to let the carriage come in contact with the protrusion on the cap.
. Return the parts to the storage position.

(4) Insert the two pins stored on the lower right side of the maintenance unit into the holes marked A and B,

T

respectively.

(5) Turn the lever clockwise until it comes in contact with the pin inserted in A.
<IMPORTANT>
. If any print head rises, unlock and reinstall the print head.
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Installation and preparation
(6) Push the carriage in the maintenance direction after the carriage comes in contact with the lever.
<IMPORTANT>
. Make sure that the protrusion on the cap touches the side of the print heads when pressing the carriage in the maintenance
direction. Non-ejection may occur if the carriage comes in contact with the nozzle surface of a print head.

(7) Pull out the pin inserted in A and turn the lever clockwise until the lever comes in contact with the pin inserted in B.

Print head capping will be performed correctly in this state.

<IMPORTANT>
. Make sure that the lever will not come in contact with the nozzle surfaces of the print heads when turning the lever.

. A print head may rise if you press the protruding part of the cap strongly against the nozzle surface of a print head. Do not
forcibly turn the lever in that case, and start over the work from the beginning.

(8) Pull out the pin inserted in B and attach the cover with the two screws.

<TIPS>
. Return the pins to the storage position.

(9) Turn on the power and restart the printer as soon as the power failure is restored.

<IMPORTANT>
. For this reason, be sure to restart the printer and perform the head cleaning after activation.
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Installation and preparation

3-4. Connection between Printer and PC (for Windows)

This chapter provides information about installing the GTX-6 Extra Colors ORGR printer driver and connecting the
printer to a PC.

Proceed with the next step while checking each procedural step.

1 Installing the printer driver
"3-4-1. Installing printer driver onto your PC >>P.49"
9 Printer static IP Address Set
"7-19. Static IP address setting >>P.255"
3 Add a Printer to PC

"3-4-2. Connecting the printer to your PC via a LAN cable: Adding a printer to PC >>P.50"

Adjusting Printer

"3-6-1. Initial settings after head replacement >>P.61"
4 "3-6-2. Color adjustments between color/ORGR heads >>P.62"
"3-6-3. Firing adjustment >>P.63"

"3-6-4. 2 same color heads position adjustment >>P.64"
"3-6-5. Platen-rolling adjustment >>P.65"

"3-6-6. White and Color/ORGR Alignment >>P.66"

X1104
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3-4-1. Installing printer driver onto your PC

Installation and preparation

>

To begin with, on your PC, install the printer driver for file output, "Brother GTX-6 Extra Colors ORGR FileOutput".
At this stage, do not connect the printer to the PC yet.
<TIPS>

™
)
()
(4)
(5)

You must log into your PC with administrator privileges.

Activate the PC.

Complete all of the current sessions.

Double-click on the "Setup.exe" to execute the installer.

Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation.

When the dialog box shown below appears, click [Install].

=] Windows Security

MName: Brother Printers
& Publisher: Brother Industries, Ltd.

Would you like to install this device software?

id.",

O iAhways trust software from "Brother Industries,

device software is safe to install?

@ You should only install driver software from publishers you trust. How can | decide which

m Don't Install

(6) After the installation is completed, reactivate the PC.
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Installation and preparation

3-4-2. Connecting the printer to your PC via a LAN cable: Adding a printer to PC

Before connecting via LAN, refer to ="7-19. Static IP address setting >>P.255" and set the IP address for the printer.
Then, add the printer to your PC according to the procedure specified below.

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the

printer.
<TIPS>
. For this connection of the LAN cable, secure it in place by means of the cable clamp as required.

(2) Select [Settings] > [Devices] > [Devices and Printers].

(3) Click the [Add a printer].

e Devices and Printers - O

— v A s <« Hard... » Devices... v & Search Devices and Printers

Add a device Add a printer &= -
_—=

@ v x

v Devices (4)

DESKTOP-OMS8 RDT235WLM USB Keyboard USB Optical
M6M Mouse

v Printers (6)

=55 = = &

Brother GTX-6 Brother GTX-6 Fax Microsoft Print Microsoft XPS OneNote for
(LAN) FileOutput to PDF Document Writer Windows 10

10 items

=

(4) Select [The printer that | want isn't listed].

r Add a device

Choose a device or printer to add to this PC
No devices found

I The printer that | want isn't listed I
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Installation and preparation

(5) Select [Add a local printer or network printer with manual settings], then click [Next].

= Add Printer

Find a printer by other options

(O) My printer is a little older. Help me find it.
() Select a shared printer by name

Browse...

Example: V\computername\printername or
http://computername/printers/printername/. printer

(O Add a printer using a TCP/IP address or hostname

(O) Add a Bluetooth, wireless or network discoverable printer

(@) Add a local printer or network printer with manual settings

==

(6) Select the [Create a new port], then select [Standard TCP/IP Port] for [Type of port], and finally click [Next].

x
& d=h Add Printer
Choose a printer port

A printer port is a type of connection that allows your computer to exchange information with a printer.

(O Use an existing port: LPT1: (Printer Port)

Type of port: Stanclard TCP/IP Port w

=
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Installation and preparation

(7) Inthe [Hostname or IP address] field, enter the already-setup static IP address of the printer, make sure that [Query
the printer and automatically select the driver to use] is checked, and click [Next]. (One instance of each value is

cited as shown in the window below.)

X
4 @ Add Printer
Type a printer hostname or IP address
Device type: TCP/IP Device
Hostname or IP address: 192.168.0.2
Port name: 192.168.0.2 |

lu Query the printer and automatically select the driver to use l

<TIPS>

e  You can omit steps (8) through (11) if the printer driver to use is automatically selected. Follow the steps if it cannot be
selected automatically.

3 If you set the printer's IP address by automatic acquisition, you must check the IP address of the printer in advance. You
can confirm the IP address by selecting [Confirm network setting] -> [IP Address] from the menu. ="7-23. Confirm network
setting >>P.258"

. If you are using a DNS server, you can use a host name and domain name instead of the IP address. Enter the host name
of your choice. ="7-23. Confirm network setting >>P.258" As for the domain name, check with your network administrator.

(8) Then, the detection window of TCP/IP port appears, and the current window will automatically go to the additional

port information window after the detection is completed.

(9) After the window shown below appears, select the [Custom] in the [Device Type], and click [Settings].

X

4 @ Add Printer

Additional port information required

The device is not found on the network, Be sure that:

. The device is tumed on.

. The network is connected.

. The device is properly configured.

The address on the previous page is correct.

oo =

If you think the address is not correct, click Back to return to the previous page. Then correct the
address and perform another search on the network. If you are sure the address is comect, select the
device type below.

Device Type

TiStandard  Generic Network Card

(@ Custom Settings...
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Installation and preparation

(10) In the [Protocol], select the [LPR], enter "BINARY_P1" in [Queue Name] of the [LPR Settings], and click [OK].

When the current screen goes back to the previous screen, click [Next].

Configure Standard TCP/IP Port Monitor x

Port Settings

Port Mame: [ 192.168.0.2

Printer Name or IP Address: ‘ 192.168.0.2

o

r~ Raw Settings
Mumb |£—| 0O

 Protocol

r~ LPR Settings

Queue Name: |BIN#RY_P1

[~ LPR Byte Counting Enabled

[~ SNMP Status Enabled

_ommunity Mame |F:L.-L'-|ic

for [Printer] and click [Next].

«  d=h Add Printer

Install the printer driver

«=  Choose your printer from the list. Click Windows Update to see more models.
==

To install the driver from an installation CD, click Have Disk.

[ Brother | 4 Brother GTX-6 Extra Colors ORGR

Windows Update Have Disk...

Next Cancel
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(11) When the window below is displayed, select [Brother] for [Manufacturer] and [Brother GTX-6 Extra Colors ORGR]



Installation and preparation

>

(12) After the window shown below appears, select the [Replace the current driver], and click [Next].

X
& d=h Add Printer

Which version of the driver do you want to use?

Windows detected that a driver is already installed for this printer.

(O Use the driver that is currently installed (recommended)
I@ Replace the current driver I

(13) Enter [Printer name], and click [Next].

b Add Printer

Type a printer name

Printer name:

I Brother GTX-6 Extra Colors ORGR (LAN)| I

This printer will be installed with the Brother GTX-6 Extra Colors ORGR driver.

Next Cancel
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Installation and preparation >

(14) Then, the specified printer will be added to the system, following which the window shown below appears, select
the [Do not share this printer], and click [Next].
. .

) = Add Printer

Printer Sharing

If you want to share this printer, you must provide a share name. You can use the suggested name or
type 2 new one. The share name will be visible to other network users.

~) Share this printer so that others on your network can find and use it

(15) Click [Finish]. This exits the setting for the PC.
<TIPS>
. If the PC cannot recognize the Printer, a correct static IP address might not be assigned. Consult your administrator.

x

= Add Printer

You've successfully added Brother GTX-6 Extra Colors ORGR (LAN)

] set as the default printer

To check if your printer is working properly, or to see troubleshooting information for the
printer, print a test page.

Print a test page

| Cancel

(16) Adjust the printer using "GTX-6 Extra Colors ORGR Maintenance".
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3-5. Connection between Printer and PC (for Macintosh)

This chapter provides information about installing the GTX-6 Extra Colors ORGR printer driver and connecting the
printer to a PC.

Installation and preparation >

3-5-1. Installing printer driver onto your PC

To begin with, on your PC, install the printer driver for file output, "Brother GTX-6 Extra Colors ORGR FileOutput".
At this stage, do not connect the printer to your PC yet.
<TIPS>

™
@)
@)
(4)
(5)

You must log into your PC with administrator privileges.

Activate the PC.

Complete all of the current sessions.

Double-click on "GTX-6E_ORGR_Ver***.pkg" to execute the installer.

Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation.

After the installation is completed, reactivate the PC.
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Installation and preparation >

3-5-2. Connecting the printer to your PC via a LAN cable

Before connecting via LAN, refer to ="7-19. Static IP address setting >>P.255" and set the IP address for the printer.
Then, add the printer to your PC according to the procedure specified below.

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the

printer.
<TIPS>
. For this connection of the LAN cable, secure it in place by means of the cable clamp as required.

(2) Open [System Preferences] from the Apple menu and click [Printers & Scanners].

° = System Preterences

Signin to your Apple ID .
Set up iCloud, the App Store, and more. Sign In

E @B EO O amE

General  Desktop & Dock Mission siri Spotlight  Language Notifications
Screen Saver Control & Region

2 © 0 . 9

rs&  Accessbility ScreenTime Extensions  Security
s &Privacy

@ 0 VN|&|= @

N =
.y &G B e &
[ ] < i Printers & Scanners Q
Brother GTX-6 Extra Colors

< Brother GT-3 FileOut... N4 i
T q“’? e

— i1y =1 Open Print Queve...

fteC...
] '
- \_l Options & Supplies...

—, Brother GTX-4 FileOu.
W e

- ST Brother GTX-6 Extra Colors ORGR
ate

<= Brother GTX-6 FileOu...
13 o e

Share this printer on the netwark Sharing Preferences.

. Printer sharing is turned off
' :

Default printer: ~ Last Printer Used

Default paper size: A4 e

(4) Select[IP].

e
@

Address:
Enter host name or IP address.
Protocol:  Line Printer Daemon - LPD
Queue:

Leave blank for default queue.

Name:
Location:

Use:

57



Installation and preparation >

(5) Enter the IP address of the printer for [Address].
Select [Line Printer Daemon - LPD] from [Protocol].
Enter "BINARY_P1" for [Queue].

Enter the printer name for [Name].

Select and click [Select Software...] under [Use].

[ ] [} Add Printer

@ ® @

)| Address: 192.168.000.002 | |

Valid and complete host name or address.
Protocol:  Line Printer Daemon - LPD [%]
Queue: BINARY_P1

Leave blank for default queue.

I Name: | GTX-6 Extra Colors ORGR (LAN) 1

Location: Auto Select
Use: | v Generic PostScript Printer
Generic PCL Printer

Select Software...

Other...

(6) Select [Brother GTX-6 Extra Colors ORGR] and click [OK].

[ ) Printer Software

Q

Brother GT-3
Brother GTX pro
Brother GTX-4

Brother GTX-6 Extra Colors ORGR

il

(7) Click [Add].

o0 e® Add Printer

B & @

Address: 192.168.000.002
Valid and complete host name or address.
Protocol:  Line Printer Daemon - LPD a
Queue: BINARY_P1
Leave blank for default queue.

Name: | GTX-6 Extra Colors ORGR (LAN)

Location:

Use: Brother GTX-6 Extra Colors ORGR (2]
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Installation and preparation

>

(8) The screen returns to the [Printers and Scanners] screen, and the GTX-6 Extra Colors ORGR printer (LAN) is
added.

Select GTX-6 Extra Colors ORGR printer under [Default Printer] if necessary.
This exits the LAN settings.

i Printers & Scanners

< Brother GT-3 FileOut. — GTX-6 Extra Colors ORGR (LAN)
= R Open Print Queue.
Brother GTX pro FileO...
A e e Options & Supplies.
~— Brother GTX-4 FileOu...
A o e
Ty Brother GTX-6 Extra Brother GTX-6 Extra Colors ORGR
1 o e
e

Idle
-, Brother GTX-6 FileOu...
o idie

GTX-6 Extra Colors O...
! Idle, Dafault

| [

Share this printer an the netwark  Sharing Preferences.

Default printer:  GTX-6 Extra Colors ORGR (LAN) &
eTauT paper size
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3-6. Adjustment

Adjust the printer using "GTX-6 Extra Colors ORGR Maintenance".

Refer to the operating

Menu name Description Things to prepare procedure with GTX-6 Extra
Colors ORGR Maintenance
[Initial settings after Make settings after print head "3-6-1. Initial settings after
head replacement] replacement. head replacement >>P.61"
Make adjustments after
[Color adjustments replacin Jthe rint head if the "3-6-2. Color adjustments
between color/ORGR p. g ,p o White paper between color/ORGR heads
horizontal stripes (banding) in .,
heads] , ) >>P.62
the picture are noticeable.
Make adjustments after print Black paper or
iy ) head replacement if the print is transparent sheet (such | "3-6-3. Firing adjustment
Firing Adjustment
[Firing Adju ] blurred and the printed result as OHP sheet) >>pP.63"
appears too granular. White paper

[2 same color heads

Make adjustments if
misalignment occurs in

Black paper or
transparent sheet (such

"3-6-4. 2 same color heads

displayed on the nozzle
check pattern]

scheduled time settings for white
ink circulation have been made.

position adjustment] white-only, color-only, or as OHP sheet) position adjustment >>P.64"
OR/GR-only printing. White paper
Make adjustments if the
Platen-rollin horizontal stripes (banding) in "3-6-5. Platen-rollin
! , ng IZ_ P (_ ing) White paper , 9
adjustment] the picture are noticeable after adjustment >>P.65"
printing.
) Make adjustments for white, Black paper or "3-6-6. White and
hite and Color/ORGR
%\i/ rl1ment] color, and OR/GR image pretreated black or dark | Color/ORGR Alignment
g misalignment, if any. color T-shirt >>P.66"
[Setting of the time No settings are required if "3-6-7. Setting of the time

displayed on the nozzle
check pattern >>P.67"

[Set the scheduled time
for white ink circulation]

Make settings when making a
time reservation for white ink
circulation or canceling the
reservation.

"3-6-8. Set the scheduled
time for white ink circulation
>>pP.69"

[Humidification
Schedule Settings]

Set the start time and end time
for humidification.

"3-6-9. Humidification
Schedule Settings >>P.72"
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3-6-1. Initial settings after head replacement

Installation and preparation

>

Set V-rating after replacing the print head or completing the setup procedure.

(1) Make sure that the printer and PC are connected via a LAN cable.

(2) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

GTX-6 Extra Colors ORGR Tools".

(3) After the window shown below appears, select [Initial settings after head replacement] and click [Next].

\S*}F Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

(@ Initial settings after head replacement

Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

() Color adjustments between color/extra color heads
Make adjustments after head replacement if the horizontal stripe (banding)} of the picture is noticeable.

() Firing Adjustment
Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is
replaced.

()2 same color heads position adjustment
Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

() White and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation

Fanfinura thie radbinn a0 end ar canenl Fhn crhadolad Fieen far adhibn inle cieenlabine

ped

(4) Perform the required operation by following the on-screen instructions in the dialog box.

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.

61



Installation and preparation >

3-6-2. Color adjustments between color/ORGR heads

Make adjustments after replacing the print head or completing the setup procedure, or if horizontal stripes appear in the
printing.

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing before you do so.

(1) Make several sheets of Ad-size or letter-size white paper available for use.

(2) Make sure that the printer and PC are connected via a LAN cable.

(3) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother
GTX-6 Extra Colors ORGR Tools".

(4) When the window shown below is displayed, select [Color adjustments between colorfORGR heads] and click

[Next].

RS'}P Brother GTX-6 Extra Colors ORGR Maintenance x

Confirm the printer is turned ON and connected to your PC.

Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

Select an item from the menu below and click "Next".

(O Initial settings after head replacement ~
Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

Color adjustments between color/extra color heads

Make adjustments after head replacement if the horizontal stripe (banding) of the picture is noticeable.

() Firing Adjustment
Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is
replaced.

(C) 2 same color heads position adjustment
Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.
() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation

Cranfinura thic ratrinn +a rak ar ancal Fha cehadulad fimmn far ahita inle circobtine

(5) Follow the instructions in the dialog box that appears on the screen.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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Installation and preparation >

3-6-3. Firing adjustment

Because the ejection timing varies depending on the platen's height and properties of each print head, this function is
provided to adjust the ejection timing for each print head when any print head is replaced with a new one or after the
completion of the setup procedure, for instance. If you want to make adjustments after replacing the print head,
configure the initial settings after print head replacement before you do so.

(1) Make several sheets of Ad-size or letter-size paper (black paper or transparent sheet such as OHP sheet, and
white paper) available for use.

(2) Make sure that the printer and PC are connected via a LAN cable.

(3) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother
GTX-6 Extra Colors ORGR Tools".

(4) After the window shown below appears, select [Firing Adjustment] and click [Next].

\E}' Brother GTX-6 Extra Colors ORGR Maintenance x

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

Select an item from the menu below and click "Next".

(O Initial settings after head replacement ~
Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

() Color adjustments between color/extra calor heads
Make adjustments after head replacement if the horizontal stripe (banding) of the picture is noticeable.

 when the edges of the print look vague, solid areas are not even, or after a Print Head is

replaced.

Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

() Platen-rolling adjustment

Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation &

Cranfinura thic ratrinn +a rak ar ancal Fha cehadulad fimmn far ahita inle circobtine

it e Y

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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3-64. 2 same color heads position adjustment

Installation and preparation >

This function is used to align the print position of two heads of the same color. Make adjustments after replacing a print

head or completing the setup procedure.

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement

and adjust the firing timing before you do so.

(1) Make several sheets of Ad-size or letter-size paper (black paper sheets or transparent sheets, such as OHP sheets,

along with white paper sheets) available for use.

(2) Make sure that the printer and PC are connected via a LAN cable.

(3) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

GTX-6 Extra Colors ORGR Tools".

(4) When the window shown below is displayed, select [2 same color heads position adjustment] and click [Nex].

\E}' Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR w

Select an item from the menu below and click "Next".
(O Initial settings after head replacement

() Color adjustments between color/extra calor heads

() Firing Adjustment

2 same color heads position adjustment

() Platen-rolling adjustment
() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation

Cranfinura thic ratrinn +a rak ar ancal Fha cehadulad fimmn far ahita inle circobtine

Search

Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

Make adjustments after head replacement if the horizontal stripe (banding) of the picture is noticeable.

Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is

Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

Close

X

(5) Follow the instructions in the dialog box that appears on the screen.

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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Installation and preparation >

3-6-5. Platen-rolling adjustment

Make adjustments after replacing the print head or completing the setup procedure, or if horizontal streaks appear in the
printing.

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing before you do so.

(1) Make several sheets of Ad-size or letter-size white paper available for use.

(2) Make sure that the printer and PC are connected via a LAN cable.

(3) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother
GTX-6 Extra Colors ORGR Tools".

(4) When the window shown below is displayed, select [Platen-rolling adjustment] and click [Next].

‘&?E Brother GTX-6 Extra Colors ORGR Maintenance x

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

Select an item from the menu below and click "Next".

(O Initial settings after head replacement ~
Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

() Color adjustments between color/extra color heads
Make adjustments after head replacement if the horizontal stripe (banding)} of the picture is noticeable.

() Firing Adjustment
Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is
replaced.

()2 same color heads position adjustment
Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

' vV e ald Ul exXlra ] [u] Al e
Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation

Fanfinura thie radbinn a0 end ar canenl Fhn crhadolad Fieen far adhibn inle cieenlabine

(5) Follow the instructions in the dialog box that appears on the screen.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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Installation and preparation >

3-6-6. White and Color/ORGR Alignment

This function is used to align the print position of the white and color heads or the white and OR/GR heads. Adjust
white/color alignment after replacing a print head or completing the setup procedure.
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing before you do so.

™
@)
@)

(4)

Prepare a sheet of black paper or a pretreated black or dark color T-shirt.

Make sure that the printer and PC are connected via a LAN cable.

GTX-6 Extra Colors ORGR Tools".

On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

After the window shown below appears, select [White and Color/ORGR Alignment] and click [Next].

&7 Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

Select an item from the menu below and click "Next".

(O Initial settings after head replacement
Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

() Color adjustments between color/extra color heads
Make adjustments after head replacement if the horizontal stripe (banding)} of the picture is noticeable.

() Firing Adjustment
Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is
replaced.

()2 same color heads position adjustment
Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a

White and Color/Extra Color Alignment

Adjust if white and color/extra color images are misaligned.

() setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation

Fanfinura thie radbinn a0 end ar canenl Fhn crhadolad Fieen far adhibn inle cieenlabine

perature and humidity have already been verified.

ped

Close

(5) Perform the required operation by following the on-screen instructions in the dialog box.
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Installation and preparation

3-6-7. Setting of the time displayed on the nozzle check pattern

>

Set the time displayed on the nozzle check pattern.

™
(2

3)

Make sure that the printer and PC are connected via a LAN cable.

On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

GTX-6 Extra Colors ORGR Tools".

After the window shown below appears, select [Setting of the time displayed on the nozzle check pattern] and click

[Next].

&7 Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR = Search

Select an item from the menu below and click "Next".

() Initial settings after head replacement ~

Make initial settings after head replacement. (Factory initial settings have been made before shipping.)

O Color adjustments between color/extra color heads
Make adjustments after head replacement if the horizontal stripe (banding) of the picture is noticeable.

OFiring Adjustment
Adjust this setting when the edges of the print look vague, solid areas are not even, or after a Print Head is
replaced.

O 2 same color heads position adjustment
Adjust this setting when When small characters are blurred, or after a Print Head is replaced.

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

etting of the time displayed on the nozzle check pattern:

This is not necessary if you have configured the scheduled time for white ink circulation.

() set the scheduled time for white ink circulation &

Farfinura thie cadbinn Fa end ar manenl Fhn crhadolad Fieen far adhibn inle cieenlabine
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Installation and preparation >

(4) Perform the required operation by following the on-screen instructions in the dialog box.
<CAUTION>
. Confirm that the date and time of your PC are set correctly, and continue.

@ Brother GTX-6 Extra Colors ORGR Maintenance X

Step 1:

Set the time displayed on the nozzle check pattern.

Current time 16:23

Before proceeding, make sure that the date and time settings on your PC
match the current time.

- Set to the above mentioned time.

< Back Cancel

(5) After the setting is completed, the currently displayed screen will go back to the Main screen.

GTX-6 Extra Colors ORGR Maintenance X

Time has been set,
Return to Main screen.

OK
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Installation and preparation

3-6-8. Set the scheduled time for white ink circulation

>

White ink circulation can be performed at a specified time. If not set, white ink circulation will be performed automatically

every four hours.

(1) Make sure that the printer and PC are connected via a LAN cable.

(2) On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

GTX-6 Extra Colors ORGR Tools".

(3) After the window shown below appears, select [Set the scheduled time for white ink circulation] and click [Next].

\Ei‘ Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.

Select the printer.

Brother GTX-6 Extra Colors ORGR o Search

Select an item from the menu below and click "Next".
AQJUSE This Setting when YWhen small characters are blurred, or arter @ Print Head 15 replaced.

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.
() White and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink drculation.

et the scheduled time for white ink circulation:

Configure this setting to set or cancel the scheduled time for white ink circulation.

() Humidification Schedule Settings
Set the humidification start time and end time.

(O set an P Adrress
Assign a static IP address to the printer.

(D) Log Data Retrieval
Execute if there was a request after troubleshooting service.

pd
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(4) After the next window appears, select [Set the scheduled time for white ink circulation.]. Then, click [Nex{].

Installation and preparation

'&7 Brother GTX-6 Extra Colors ORGR Maintenance

Step 1:

Set or cancel the scheduled time for white ink circulation.

(@) Set the scheduled time for white ink circulation.

() cancel the scheduled time for white ink circulation.

every 4 hours.

- If the scheduled time of white ink circulation is not set, the white ink circulation is automatically turned ON

- Enter setting that results in @ white ink circulation interval of between 1 and 6 hours.

- One of the scheduled times of white ink circulation is enhanced circulation.

X
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Installation and preparation

(5) Set the scheduled time for white ink circulation and click [Next].

<CAUTION>

. Confirm that the date and time of your PC are set correctly, and continue.

. Enter at least six start-time settings.

° Set the white ink circulation interval to be between one hour and six hours.

. Input a time range of "0:00" to 23:59".

<TIPS>

. You can check on the main unit the scheduled time you set. ="7-24. Check circulation schedule >>P.259".

@ Brother GTX-6 Extra Colors ORGR Maintenance

Step 2:

Set the scheduled time for white ink circulation.

Current time 16:27

Start time for white ink circulation

o[ T ] om[ ] om[ | ow[ ]
om[ ] ow[ ] om[ | om[ ]

Before proceeding, make sure that the date and time settings on your PC
match the current time.

- Enter the start time for white ink circulation.

- Input a time range of "0:00" to "23:59".
For example, when setting the time "8:00," either "800" or "8:00" can be input.

- Enter at least & start times.
- Enter setting that results in a white ink circulation interval of between 1 and 6 hours.

- Select the time to start the enhanced white ink circulation with the corresponding radio button.

Cancel
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3-6-9. Humidification Schedule Settings

Installation and preparation

>

Make settings when reserving the operation schedule of the humidifier.

™
(2

3)

Make sure that the printer and PC are connected via a LAN cable.

On the PC, from [All Programs] in the Start menu, select "GTX-6 Extra Colors ORGR Maintenance" from "Brother

GTX-6 Extra Colors ORGR Tools".

After the window shown below appears, select [Humidification Schedule Settings] and click [Next].

\g*}' Brother GTX-6 Extra Colors ORGR Maintenance

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR Lo Search
Select an item from the menu below and click "Next".
AQJUSE This Setting when YWhen small characters are blurred, or arter @ Print Head 15 replaced.

(D) Platen-rolling adjustment

() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

() Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink drculation.

() set the scheduled time for white ink circulation
Configure this setting to set or cancel the scheduled time for white ink circulation.

umidification Schedule Settings

Set the humidification start time and end time.

(O set an P Adrress
Assign a static IP address to the printer.

() Log Data Retrieval
Execute if there was a request after troubleshooting service.
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Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.

pd

Close




Installation and preparation

(4) After the window shown below appears, click the [Set the scheduled time for humidification]. Then, click [Next].

@ Brother GTX-6 Extra Colors ORGR Maintenance X

Step 1:

Set or cancel the humidification schedule.

(@ Set the humidification schedule.

() cancel the humidification schedule settings.

- If you set the schedule, the humidification will begin at the start time and finishes at the end time.

- Regardless of the humidification schedule, humidification will begin if you select "Start humidification” from the
printer’s menu or if you start printing.

- Select "Stop humidification” from the printer’s menu, or otherwise the humidification will finish after a certain
period of time outside the set humidification schedule.
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Installation and preparation
(5) Set the start time and end time for humidification and click [Next].

<CAUTION>

. Confirm that the date and time of your PC are set correctly, and continue.

. You can enter the start time and end time if you check the day of the week.
Humidification will not start or end in time on days that are not checked.

. Humidification will start at the start time.
Specify one hour before printing. Insufficient humidification can affect print quality.
Waste liquid increases to prevent the printer from malfunctioning.

<TIPS>

3 You can check on the main unit the scheduled time you set.

7 Brother GTX-6 Extra Colors ORGR Maintenance X

Step 2:

Enter the start time and end time of humidification.

Current time 16:28

Day of the Start time End time

week

[]sun. - When you check a day of the week, you can enter the start
time and end time.

- - If the day of the week is unchecked, humidification will not start
Mon. | 09:00 | | 17:39 | automatically.
|:|Tue - Humidification will start when the humidification time comes.
' Set about one hour before printing for the time. Insufficient

humidification may affect the print quality and speed.

[ wed. | 09:00 | | 17:59
- The humidification will stop at the end time.

[7hu.

[ 1Fri.

[]sat.

Before proceeding, make sure that the date and time settings on your PC match
the current time.
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Installation and preparation

(6) Select the elapsed time to finish humidification and click [Next].

@ Brother GTX-6 Extra Colors ORGR Maintenance -

Step 3:

Set the time to finish the humidification actuated outside the humidification schedule.

Humidification will finish when the following time has elapsed since the last print.
However, humidification will not finish even if the following time has elapsed in the humidification schedule.

() Finish in 30 minutes

©Finish in 1 hour

()Finish in 2 hours

- Click "Mext".
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3-7. Moving the printer

When moving the printer elsewhere, please contact your dealer.
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Creating print data

4-1. Types of applications

You can create print data by either "using Brother products” or "using other applications". Select applications to use
depending on your needs.

You are recommended to use Brother product applications as far as possible. If you want to use other applications,
however, you are recommended to use one of the three recommended applications to achieve high-quality print results.
This chapter describes the procedures for using other applications.

Using Brother products

Applications to use Reference
GTX Graphics Lab Graphics Lab Instruction Manual
When using other applications

Applications to use Reference
CorelDRAW (2021/2022) "4-3-1. When using CorelDRAW >>P.80"
Adobe Photoshop CC "4-3-2. When using Adobe Photoshop >>P.87"
Adobe lllustrator CC "4-3-3. When using Adobe lllustrator >>P.92"

<TIPS>

. Make proper settings, such as color settings and printing conditions, of each application, in accordance with the setting contents
of the application.

. In this chapter, the value RGB=(254,254,254) is described as "RGB=254", and the value RGB=(255,255,255) is described as
"RGB=255".
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About color mode (color space)

The GTX-6 Extra Colors ORGR printer is a printer of RG type.

Be sure to create image data in RGB mode, and always set the color space (input) you use for such data to sSRGB

(sRGB IEC61966-2.1).

<TIPS>

. When such application as Adobe and Corel is used, there are instances in which an image in CMYK mode cannot reproduce the
color that is intended.

. Even for an image in RGB mode, a similar color reproduction failure occurs when other color space than the specified one, such
as Adobe RGB, is used.

About print layout

Specify the platen size that uses the paper size specified in the Print menu, and confirm the print layout.

Moreover, use the "Brother GTX-6 Extra Colors ORGR FileOutput" printer driver for file output, then display and check

the print preview.

<TIPS>

° For a print image to be oriented properly at all times, it is advisable to set the GTX-6 Extra Colors ORGR printer to the [Set as
default printer] for the PC.

How to create white data

When creating print data with [Color + White Ink] or [White Ink Only], RGB=255 is treated as "Transparent color",
ejecting no ink.
For an image that you want to print pure white color with white ink, make sure that the white areas are set to RGB=254.
<TIPS>
. The treatment of RGB=255 varies depending on the applications.

Configure the settings appropriately.

About ARXGE/ARXG file

Use the "Brother GTX-6 Extra Colors ORGR FileOutput" printer driver for file output to save your print data in

ARXBE/ARXG6 format.

If your print data is saved in ARX6E/ARX6 format, its information and the amount of used ink will be able to be reviewed.

<TIPS>

° There are two types of print data: ARX6E format and ARX6 format.

- The ARX6E format is data that uses orange/green ink.
- The ARX6 format is data that does not use orange/green ink.

o When performing file output, use the printer driver, "Brother GTX-6 Extra Colors ORGR FileOutput". If the file output is performed
using the [Print to file] command that is supplied with each application, there may be some cases where the file extension cannot
be saved as .arx6/.arx6e or the file destination cannot be specified.

. ARX4 files created with the GTX-4, ARXP files created with the GTX pro and ARXG files created with the GTX-6 can be printed
with the GTX-6 Extra Colors ORGR.

° The GTX-6 Extra Colors ORGR printer cannot print out the print data that has been created for the GT-541/GT-782/ GT-3 series.

. If you make a printer driver setting from the Control Panel of your PC, such setting sometimes will not take effect in each
application. For this reason, verify that your printer driver has been set up properly before you begin printing.
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4-2. Sending print data using Brother GTX-6 Extra Colors ORGR FileOutput (for Macintosh only)

Saving print data to a file

Check that the "GTX-6 Extra Colors ORGR File Viewer" is running when saving print data to a file using the "Brother

GTX-6 Extra Colors ORGR FileOutput".

The error shown below will occur, and you will not be able to save the data if you output without "GTX-6 Extra Colors

ORGR File Viewer" running.

<TIPS>

o Depending on the application, the following error may or may not appear. Try again with the "GTX-6 Extra Colors ORGR File
Viewer" running.

Error

This is an unsupported platen size.
Change the platen size.

<TIPS>
o The procedure for outputting a file from "Brother GTX-6 Extra Colors ORGR FileOutput" is the same as for a Windows PC.

Sending print data

Follow the procedure below to send print data to the printer if the print data has been saved using the "Brother GTX-6
Extra Colors ORGR FileOutput" printer.
<TIPS>

o The procedure for sending print data is the same as that for a Windows PC.

(1) Double-click the file with the extension ".arx6" or ".arx6e" saved using the "Brother GTX-6 Extra Colors ORGR
FileOutput" printer.
(2) "GTX-6 Extra Colors ORGR File Viewer" will be launched, and the print data will be sent when you click [Send to

Printer].
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4-3. Using other applications

4-3-1. When using CorelDRAW

First of all, perform the following procedures:
e  Color setting
e  Printsize

As required, perform the following procedures:
e  Create print data (ARX6E/ARXG file).
e  Use the color palette in Useful Tools.
e  Convert data to bitmap image data.
o  Replace RGB=255 in bitmap image data with RGB=254.

<TIPS>
. For this printer, it is recommendable to use CoreDRAW 2021/2022. The display screen is described assuming CoreDRAW
2022.

Color management settings

(1) Inthe menu bar, select [Tools] > [Color Management].

(2) Establish the settings in [Color management settings] as follows:
¢ [RGB Profile]: [sSRGB IEC61966-2.1]
e  [Primary color mode]: [RGB]
¢ [Rendering intent]: [Relative colorimetric]

Coler Management Settings X

Default

Preset: | Custom » E

RGB profile: | (Default) sSRGB IEC61966-2.1 -

CMYK profile: | (Default) U.5. Web Coated (SWOP) v2 -
Grayscale profile: | (Default) Dot Gain 20% v
Primary color mode: | RGB v
Rendering intent: | Relative colorimetric b

Color conversion
Color engine: | Microsoft ICM CMM -

Preserve pure black
+| Map gray to CMYK black

? 0K Cancel

80



Print size
(1) Inthe menu bar, select [File] > [Print].
(2) Set the [Printer] to either "Brother GTX-6 Extra Colors ORGR" or "Brother GTX-6 Extra Colors ORGR FileOutput",
click on [Apply], and close the [Print] dialog box.
<TIPS>
. If [Printer] is set to "Brother GTX-6 Extra Colors ORGR", the print data will be sent to the printer at the time of printing.
If [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data at the time of printing will be saved as an
ARXGE/ARXG file.
Print X
General Color Composite Layout Prepress 1 Issue
Destination
Printer: Brother GTX-6 Extra Colors ORGR FileOutput '| {:}
Qrientation: Use printer default (Portrait) -
Status: Ready
Location; GTXASPFPOrt Print to file
Comment:
Print range Copies
@ Current document Documents Number of copies: -
Current page Selection -
Print as bitmap: 300 dpi
Print style: Custom (Current settings not saved) - Save As..
? Print Preview Z Print Cancel
(3) Inthe menu bar, select [Layout] > [Page Layout].

Creating print data
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(4)

Make the following settings in the [Page Size] window:

o  [Size]: [Custom]
e [Width]: 14.6 in. (370 mm)
e  [Height]: 16.5in. (420 mm)

e  Page orientation: Portrait
<TIPS>

Creating print data >

. Set the width and height to the size of platen to be used. The above size is the standard 14X16 platen size.
= In the case of print data using white ink ="4-4-2. Select the platen size >>P.100"

= In the case of print data using color ink and black ink only ="4-5-2. Select the platen size >>P.119"

Document Options

General
Page Size
Layout
Background
Guidelines
Grid

Rulers

Save

? Save as Default...

® Page size Label presets

Size and orientation

Sizefl Custom - E ﬁ
Widthfl 370 | milimeters =
Heightl§ 420 -0l

Apply size to current page only
|+| Show page border
Add Page Frame

Rendering resolution: * | dpi

Bleed: 4.0

Show bleed area

oK
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Create print data (ARX6E/ARXG6 file).

Save the image data and print settings as a print data set in ARX6E/ARXG file format.
The following will be made available if the print data is converted into an ARX6E/ARXG file:

Image data and print settings can be put together and stored.
Without connection to a PC, the printing can be performed directly from a USB flash memory.

<TIPS>

™
(2

(4)

Image editing is unavailable for any ARX6E/ARXG file. As such, save your image data for an editing purpose in advance.

For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Use the printer driver "Brother GTX-6 Extra Colors ORGR FileOutput".

For details of directly sending data to the printer from an application, ="5-6-2. Sending print data from applications >>P.164"

In the menu bar, select [File] > [Print].

On the [General] tab, select [Printer] and select "Brother GTX-6 Extra Colors ORGR FileOutput" for file output.
<TIPS>
. The print data will be sent to the printer if the specified [Printer] is set to "Brother GTX-6 Extra Colors ORGR".
If the specified [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an
ARXGE/ARXG file.

Open the [Color] tab, and make the following settings:

e  Place a checkmark in the [Document color] checkbox.
e [Color conversions]: "Brother GTX-6 Extra Colors ORGR" or "Brother GTX-6 Extra Colors ORGR FileOutput"
e [Color Profile]: [sSRGB IEC61966-2.1]

¢ [Rendering intent]: [Relative colorimetric]

Print X

General Color Composite Layout Prepress 1 Issue

Colar: ® Composite

Separations

Settings: ® Document color

Color proof

Color conversions: Brother GTX-6 Extra Colors ORGR FileOutput

Color profile: (Document) sRGE IECG1966-2.1

+| Preserve pure black

Rendering intent: Relative colorimetric

The color settings and preview available in this dialog box are set for the Windows Graphic
device printer that you selected on the General tab.

? Print Preview m Print Cancel Apply

On [Preferences], create your settings of printer driver.
¢ Inthe case of print data using white ink ="4-4-1. Setting up the printer driver >>P.98"
o Inthe case of print data using color ink and black ink only ="4-5-1. Setting up the printer driver >>P.117"
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(5) When you press [OK] in the [Print] dialog box, the dialog box shown below will be displayed. After that, click [Save].

<TIPS>

. There may be cases where this saving process takes several minutes.

&

Job Name

Date

Platen Size

Resolution:

SelectInk
Extra Colors ORGR :
Highlight
Mask
Print Time
Whiteness
Use background black color

Color Multiple Pass Printing :

Details...

Color Ink
White Ink
Print

Save Close

IMG_1404.JPG
19/12/20221735

14x16
1200dpi x 1200dpi

Color+White Ink
On

5

3

x1

400 %

off

off

032cc
192¢cc

1 piece

0
BD. v
4 »

100%

PresentLayer 1 W+CMYKOG « | | White Data

.

© 600%

(6) Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6E/ARXG file to your PC.

Use the color palette in Useful Tools.

(1) Save the color pallet files for CoreIDRAW, "GT_Colors.xml" and "GT_Tshirts.xml", on your PC, following the

instructions on screen.

(2) Inthe menu bar, select [Window] > [Color Palettes] > [Open Palette].

(3) Select the files having such filename as "GT_Colors.xml" and "GT_Tshirts.xml", respectively.

<TIPS>

. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from

the resulting print color.
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Convert data to bitmap image data

(1) Inthe menu bar, select [Bitmaps] > [Convert To Bitmap].

(2) Setthe [Color mode] to [RGB Color].

<TIPS>
. When the white ink is used for performing the printing, unmark the [Anti-aliasing] checkbox.

Convert To Bitmap X

Resolution: | 300 ~ | dpi

Colormode: | RGB Color (24-bit) \ 4

Options
| Anti-aliasing
+| Transparent background

Uncompressed file size: 3.33 MB

7 oK Cancel

<TIPS>
. Even when the platen size to be used has been selected from the printer driver, the current setting in [Page Layout] may change

to [Settings from printer].
In the [Page Layout], be sure to change the width and the height according to the size of the platen.
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Replace RGB=255 in bitmap image data with RGB=254

RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) Inthe menu bar, select [Effects] > [Adjust] > [Replace Colors].

(2) From the [Original] pull-down menu, set RGB=255 in [Replace Colors].

Replace Colors x

mO@ aQaaqm

Range

Original New

After

vIPr ' AR

RGB=255

(3) Inthe same manner, set [New color] to RGB=254.

(4) Check the [Single Color] check box, and click on the [OK] button.
Replace Colors X

oo QQad

Before

Range

Qriginal
|-

[¥]Single color

Hue
Saturation

Lightness

| Preview Reset

<TIPS>
. For the vector data, change the fill color to RGB=254.
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4-3-2. When using Adobe Photoshop

In Photoshop, configure the settings mentioned below:
e  Color setting

As required, perform the following procedures:
e  Create print data (ARX6E/ARXG file).
o  Use the color palette in Useful Tools.
e Replace RGB=255 with RGB=254

<TIPS>
. For an image created in the CMYK color mode, select [Image] > [Mode] in the menu bar, and change the color to the RGB color
(sRGB). In order to edit an image, select [Image] > [Adjustments] in the menu bar and edit it, or edit it by means of the image
quality improvement of the printer driver.
* In the case of print data using white ink ="4-4-11. Set up the image quality >>P.113"
= In the case of print data using color ink and black ink only ="4-5-7. Set up the image quality >>P.125"
. For this printer, it is recommended to use Photoshop CC. The display screen is described in Photoshop CC.

Color setting

(1) Inthe menu bar, select [Edit] > [Color Settings].

(2) Establish the settings of [Color Settings] as follows:
[Working Spaces]
o [RGB]: [sSRGB IEC61966-2.1]
[Conversion Options]
e  [Engine]: [Adobe(ACE)]
¢ [Intent]: [Relative Colorimetric]
[Color Management Policies]
e [RGB]: [Convert to Working RGB]
e  [CMYK]: [Convert to Working CMYK]
e  [Gray]: [Convert to Working Gray]
o  [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.
e  [Missing profiles]: Mark the [Ask When Opening] checkbox.

Color Settings X

Intent:

Advanced Controls

Desaturate Monitor Colors By:

Blend RGB Colors Using Gamma:

2 Ask When Opening % Ask When Pasting Blend Te: ing Gamma:

2 Ask When Opening

Description
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Create print data (ARX6E/ARXG file)

Save the image data and print settings as a print data set in ARX6E/ARXG file format.
The following will be made available if the print data is converted into an ARX6E/ARXG file:
e Image data and print settings can be put together and stored.
e  Without connection to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
o Image editing is unavailable for any ARX6E/ARXG file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Use the printer driver "Brother GTX-6 Extra Colors ORGR FileOutput".
. For details of directly sending data to the printer from an application, ="5-6-2. Sending print data from applications >>P.164"

(1) In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-6 Extra Colors ORGR" or
"Brother GTX-6 Extra Colors ORGR FileOutput", the layout is set to the platen size.

(2) Make the settings as follows:
e  [Color Handling]: [Printer Manages Colors]
e [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup
Printer:  Brother GTX-6 Extra Colors ORGR FileO... ~

Copies: 1 Print Settings...
Layout: [ Bl

»  Color Management

Remember to enable the printer’s colc
management in the print setting

P it el ~UAD TEFCANEE A 4

Color Handling:  Printer Manages Colors

Rendering Intent:  Relative Colorimetric -

~  Description

Cancel ( Print

(3) From [Printer], select "Brother GTX-6 Extra Colors ORGR FileOutput" for file output.
<TIPS>
. If [Printer] is set to "Brother GTX-6 Extra Colors ORGR", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an ARXGE/ARXG file.

(4) On [Print Settings], make your settings for the printer driver.
¢ Inthe case of print data using white ink ="4-4-1. Setting up the printer driver >>P.98"
e Inthe case of print data using color ink and black ink only ="4-5-1. Setting up the printer driver >>P.117"
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(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].

<TIPS>

. There may be cases where this saving process takes several minutes.

&

Job Name

Date

Platen Size

Resolution:

SelectInk

Extra Colors ORGR :
Highlight
Mask
Print Time

Whiteness

Details...

Color Ink
White Ink
Print

Use background black color

Color Multiple Pass Printing :

Close

IMG_1404.JPG
19/12/20221735

14x16
1200dpi x 1200dpi

Color+White Ink
On

5

3

x1

400 %

off

off

032cc
192¢cc

1 piece

0
BD. v
4 »

100%

PresentLayer 1 W+CMYKOG « | | White Data

0

© 600%

(6) Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6E/ARXG file to your PC.
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Use the color palette in Useful Tools.
(1) Save the color pallet file for Photoshop, "GT_Colors_T.ase", on your PC, following the instructions on screen.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Clickon == to open the submenu.

(4) From [Read Swatches], select [Swatch Exchange (*.ASE)] for the type of file and then select the file name

[GT_Colors_T.ase].

Swatches

ﬁ GT _Colors T

<TIPS>
. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from

the resulting print color.
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What to do when replacing RGB=255 with RGB=254

RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) On the menu bar, select [Layer] > [New Adjustment Layer] > [Selective Color], and create a new layer.

(2) Setthe opacity to 20%, and click [OK].

alective Color 1

Use Previous Layer to Create Clipping Mask

Color: [X]None

Mode: Normal Opadcity:

(3) From the [Selective Color], make the following settings:
e [Colors]: [Whites]
o [Black]: 1%
e Mark the [Absolute] option

Properties

m n Selechve Color

<TIPS>
. The method to replace RGB=255 with RGB=254 as shown above can be used only when the [Color mode] is set to [8 bit] of
[RGB Color].

. For Photoshop, the action file "SolidWhite.atn" is made available in Useful Tools, which changes RGB=255 to RGB=254 (=~
"4-6-2. Replace RGB=255 with RGB=254 (for Photoshop only) >>P.129"). For how to use it, refer to the Help feature that
Photoshop is provided with.
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4-3-3. When using Adobe lllustrator

>

In lllustrator, perform the required procedures mentioned below:

Color setting
Open a new file

As required, perform the following procedures:

Create print data (ARX6E/ARXG file).
Use the color palette in Useful Tools.

<TIPS>

Take one of the actions mentioned below, in order to avoid such troubles that no image data is inserted into the print range or part
of image data is cut off.

- Before start-up, specify the PC's default printer as the "Brother GTX-6 Extra Colors ORGR" or the "Brother GTX-6 Extra Colors
ORGR FileOutput".

* Use the "Brother GTX-6 Extra Colors ORGR FileOutput" printer driver to output a file, then display and check the print preview.
For an image created in CMYK color mode, load the image into Photoshop, select [Image] > [Mode] in the menu bar, and change
the color to the RGB color (sRGB). In order to edit an image, load the image into Photoshop, edit it in the form of bitmap data, or
edit it by means of image quality improvements in the printer driver.

- In the case of print data using white ink ="4-4-11. Set up the image quality >>P.113"

* In the case of print data using color ink and black ink only =-"4-5-7. Set up the image quality >>P.125"

For this printer, it is recommended to use lllustrator CC. The display screen is described in lllustrator CC.
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Color setting

(1) Inthe menu bar, select [Edit] > [Color Settings].
(2) Click on the [More Options].

(3) Ensure selection of the settings as mentioned below, and click [OK].
e  [Settings]: [Custom]
[Working Spaces]
o [RGB]: [sSRGB IEC61966-2.1]
[Color Management Policies]

o [RGB]: [Convert to Working Space]
e  [CMYK]: [Convert to Working Space]
°

[Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.
e [Missing profiles]: Mark the [Ask When Opening] checkbox.

[Conversion Options]

e  [Engine]: [Adobe(ACE)]

¢ [Intent]: [Relative Colorimetric]

Color Settings

5B: SRGB IEC61966-2.1

YK: U.5. Web Coated (SWOP) v2

Color Manageme
R( Convert to Working Space
CMYK: Convert to Working Space

es: B Ask When Opening [ Ask When Pasting
es: I Ask When Opening

Conversion Options
ngine: Adobe (ACE)

ntent: | Relative Colorimetric

Use Black Point Compensation

g for additional information.

Less Options
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Open a new file

(1) Setup anew document as follows:

o [Width]: 14.6 in. (370 mm)

e  [Height]: 16.5in. (420 mm)

e  [Orientation]: Portrait

e  [Color Mode]: [RGB]

<TIPS>

. Set the width and height to the size of platen to be used. The above size is the standard 14x16 platen size.
= In the case of print data using white ink ="4-4-2. Select the platen size >>P.100"
= In the case of print data using color ink and black ink only ="4-5-2. Select the platen size >>P.119"

More Settings

Name: Untitled-1
Profile: [Custom]

" il ~F - ) i
Number of Artboards: J 1

Size: [Custom]
Width: 370 mm Units: Millimeters

Height: 420 mm

Top
i -~
i

= S A o
0 mm 0 mm +~ 0 mm

Color Mode: | RGB
Raster Effects: High (300 ppi)

view Mode: Default

Templates... Create Document

94



Creating print data

Create print data (ARX6E/ARXG file)

Save the image data and print settings as a print data set in ARX6E/ARXG file format.
The following will be made available if the print data is converted into an ARX6E/ARXG file:
e Image data and print settings can be put together and stored.
e  Without connection to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
o Image editing is unavailable for any ARX6E/ARXG file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Use the printer driver "Brother GTX-6 Extra Colors ORGR FileOutput".
. For details of directly sending data to the printer from an application, ="5-6-2. Sending print data from applications >>P.164"

(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
e  [Document Profile]: [sSRGB IEC61966-2.1]
e  [Color Handling]: [Let lllustrator determine colors]
e  [Printer Profile]: [sSRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX-6 Extra Colors ORGR FileQutput

General Color Management

Marks and Bleed Print Method

Ot Document Profile: U.S. Web Coated (SWOP) v2
Graphics
Color Handling: Let Illustrator determine colors

Color Management

Printer Profile: sRGB IEC61966-2.1

Rendering Intent: Relative Colorimetric

Description

14inx 16in
ia: 14 in x 16 in
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Creating print data >

From [Printer], select "Brother GTX-6 Extra Colors ORGR FileOutput" for file output.
<TIPS>
. If [Printer] is set to "Brother GTX-6 Extra Colors ORGR", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an ARX6E/ARXG file.

On the [Advanced], make your settings for the printer driver.
¢ Inthe case of print data using white ink ="4-4-1. Setting up the printer driver >>P.98"
¢ Inthe case of print data using color ink and black ink only ="4-5-1. Setting up the printer driver >>P.117"
<CAUTION>
. For Adobe lllustrator, set the platen size for the paper size in the Print dialog box in the application.
The size or placement of the image may not be set correctly if you make settings in the Print Settings dialog.

When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].
<TIPS>
3 There may be cases where this saving process takes several minutes.

ol O X
70 0 70
Job Name IMG_1404 JPG 20
Date 19/12/2022 17:35 : =
Platen Size 14x16
Resolution: 1200dpi x 1200dpi
Selectlnk Color+White Ink
Exira Colors ORGR On H‘ :
Highlight 5 il
Mask : 3 v OO
Print Time x1
Whiteness 400 %
Use background black color off
Color Multiple Pass Printing off
Details.
Color Ink 032 80 =
olor Inl cc w7 v
White: Ink 192 cc 1 ' o . . '
P 5
Print 1 piece s 3 . ' ' ' o L
Present Layer 1 W-CMYKOG v | [ White Data
gackground Coor ||| | | | oo
G

Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6E/ARXG file to your PC.
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Use the color palette in Useful Tools.

(1) Save the color pallet file for lllustrator, "GT_Colors_T.ase", on your PC, following the instructions on screen.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Clickon ==, and select [Open Swatch Library] from the submenu.

(4) Select [Other Library].

(5) On the [Open] screen, select the file having such filename as "GT_Colors_T.ase".
<TIPS>
. Unlike the Photoshop or CorelDRAVW, this Swatch needs to be selected each time a file is opened.
However, you can fix the Swatch library in the following method to display the screen automatically whenever you start the
application if you are using lllustrator CC.
Click — on the top right corner of the Swatch library and select [Fix] from the submenu.

BT Coboss T .
S Cok Add to Swatches
e Sort by Name
| A NPW W PP 5 Sort by Kind
ad BV . VL L VL . T
AAAJAAEAJAAAAJAAA'A?A‘A'A Show Find Field

a4 4 APaVa 4 ; )
P Y P Small Thumbnail View

Medium Thumbnail View
Large Thumbnail View
Small List View
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4-4. Driver settings for print data using white ink

4-4-1. Setting up the printer driver

<TIPS>

° The GTX-6 Extra Colors ORGR printer driver treats RGB=255 as a "Transparent color" and does not eject the ink. For such an
image that you wish to print out in pure white color with white ink, make such a setting as RGB=254.

. For the color replacement method, refer to a relevant page (="4-3. Using other applications >>P.80") or help menu of each
application software.

(1) By following the printing procedures of each application software, open the print setup dialog box of the printer

driver.

##0 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties *

Paper/Quality Main Setting

Platen Size : 14x16 »

Platen Height : Mo designation e

Select Ink Color+White Ink ~

Mode
Color: (@ Vibrant (O Natural
White (@ Normal () Eco-Mode
Resolution : (C)1200dpi x 1200dpi HQ (®) 1200dpi x 1200dpi
(7) 1200dpi x 300dpi (7) 1200dpi x 600dpi
White Ink Settings : 1 3 5 7 g

Highlight I

Mask : I
Print Time : x1 Whiteness : | 400 %

[J2 Layer White

[CJwhite/Color Pause

kC

[JUse background black color (for black T-shirts only)
DColorMuItip\e Pass Printing Default

Advanced:
Click to open advanced menu.
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(2) Inthe dialog box for setting the printer driver, configure required settings.
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be
configured.
<TIPS>
. Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary.
. The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse
the help feature.
. For the detailed description of setup items, refer to each chapter mentioned below.

Brother GTX-6 Extra Colors ORGR Advanced menu X

White Ink Settings
- green (0,199,0) Custom

Minimum Whiteness : (@) Normal () special
1) 2

=1
-
[S]
[
S
%]
@
~
-]
[r=]
=
=]

EINE

Choke Width : I

[ ] ORGR Bleeding Reduction

Color Processing
0 10 20 30 40

Saturation : I
Brightness : I
Contrast : I

Color Balance

£

o peet B R DA e T B
Cyan : I ,T
Magenta : I ,T
Yellow : I ,T
Black : I ,T
Green : I ,T
Orange : I ’T

[] uni-pirectional Printing

Transparent Color @

Selecting a color to make it transparent, RGB=255 white is always transparent. Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB values
for custom transparent color. It is recommended that the [Use background black color] function is

turned OFF to produce better colors.

(3) After your settings are completed, click [OK].
<TIPS>
. You can refer to each value you have set up here by opening an ARX6E/ARXG file from the "GTX-6 Extra Colors ORGR
File Viewer".
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4-4-2. Select the platen size

From the pull-down menu of [Platen Size:], select a platen size for print area.
<TIPS>

. The platen size is equivalent to the paper size.

Setup item Platen to be used Size
[24x24] 24x24 platen 24.0in.x24.0in. (610 mm x 610 mm)
[18x22] 18x22 platen 18.0in. x 22.0 in. (457 mm x 559 mm)
[16X18] 16X18 platen 16.0in. x 18.0in. (406 mm x 457 mm)
[14X16] 14X16 platen 14.0in. x 16.0in. (356 mm x 406 mm)
[10X12] 10X12 platen 10.0in. x 12.0 in. (254 mm x 305 mm)
[7X8] 7X8 platen 7.0in.x 8.0 in. (178 mm x 203 mm)
##1 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting

Platen Size :

Advanced
Platen Height :
Select Ink
Mode :
Color: (@ Vibrant (O Natural
White (@ Normal () Eco-Mode
Resolution : (7 1200dpi x 1200dpi HQ (@) 1200dpi x 1200dpi
() 1200dpi x 900dpi () 1200dpi x 600dpi
White Ink Settings : ] 3 5 7 g s ,
Highlight: I 5
1 2 3 4 5
Mask : I 3

Print Time : x1 Whiteness | 400 %

[]2 Layer White

DWhite}CoIorPause

.

[[JUse background black color (for black T-shirts only)
DColorMuItip\e Pass Printing Default

[Platen Size :

Selectthe size ofthe platen used for print.
24x24 (609 6x609.6mm)

[18x22 (457.2¢558.8mm)

[16x18 (406.4x457.2mm)

[14x16 (355.6x406.4mm) *standard

[10x12 (254.0x304.8mm)

|7x8  (177.8x2032mm)
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4-4-3. Selecting platen height

From the pull-down menu of [Platen Height:], select the platen height.
When the printer receives print data, the platen automatically changes to the specified platen height.
e  You can select the height from [No designation], [A], [B], [C], [D], [E], [F], [G], and [H].

<TIPS>
o The platen height is not changed if you select [No designation].

#2 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties e

Paper/Quality Main Setting

Platen Size : 14x16 v

Platen Height : No designation

Select Ink Color+White Ink ~

Mode :
Color: (@ Vibrant (O Natural
White (@ Normal (C)Eco-Mode
Resolution : (0) 1200dpi x 1200dpi HQ (@) 1200dpi x 1200dpi
(7)1200dpi x 300dpi (7 1200dpi x 600dpi
White Ink Settings : 1 3 5 7 g i |
Highlight: I 5
1 2 3 4 5
Mask : I 3

Print Time : x1 Whiteness : | 400 %

[J2 Layer White

]

[CJwhite/Color Pause

[JUse background black color (for black T-shirts only)
DColurMuhip\e Pass Printing Default

:A'dvanced':
(Click to open advanced menu.
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4-4-4. Select the ink type

Creating print data

>

From the [Select Ink:] option, select a combination of inks to be used.

Setup item

Description

[Color+White Ink]

This option enables a color image to be printed out on the mask layer of white ink.

[White Ink Only]

This option enables the white ink only to be used for printing out a monochrome image.

[Color Ink Only]

pale color background.

This option enables a color image to be printed out on a white background or lighter and

[Black Ink Only]

This option enables the black ink only to be used for printing out monochrome image.

[Extra Colors ORGR]

This option will be enabled if you have selected [Color+White Ink] or [Color Ink Only].
Orange/Green ink will be used if the check box is ON.
Orange/Green ink will not be used if the check box is OFF.

##1 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

Paper/Quality Main Setting
Platen Size : 14x16

Platen Height :

Mo designation

i Advanced

Select Ink Color+White Ink
B
White Ink Only
Color Ink Only
Black Ink Only
Mode :
Color: (@ Vibrant (O Natural
White (@ Normal () Eco-Mode
Resolution : (7 1200dpi x 1200dpi HQ (@) 1200dpi x 1200dpi

() 1200dpi x 900dpi

White Ink Settings :

Highlight: I

Mask : I
Print Time : x1

[]2 Layer White
DWhite}CoIorPause

[[JUse background black color (for black T-shirts only)
[ Color Multiple Pass Printing

SelectInk :
Selects ink combination.

Color+White Ink : Prints colorimages on White ink mask.
White Ink Only : Prints monochrome images with only white ink.

() 1200dpi x 600dpi

Whiteness | 400 %

ok

Default

Color Ink Only : Prints only color images on white or light color materials.

|Black Ink Only : Prints monochrome images with only black ink.

Cancel
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4-4-5. Select the mode

Creating print data

>

If you set [Mode:] > [White:] to [Eco-Mode], the white ink volume serving as the background is automatically adjusted to

reduce the overall ink consumption.
For colors, you can set [Vibrant] and [Natural] in [Color:] only when you select [Extra Colors ORGR] in [Ink Selection:].

Setup item Description
[Vibrant] Orange and green ink colors will be emphasized.
[Natural] Orange and green ink assertions are suppressed and adjusted to natural tints.

<TIPS>

o The luminance on the finished print may be slightly reduced depending on the color.

Platen Size :

Platen Height :

Paper/Quality Main Setting

14x16

No designation

#1 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

o Advanced

Select Ink ‘Color+White Ink

Extra Colors ORGR

(@ Vibrant
(@ Normal

Resolution : (C)1200dpi x 1200dpi HQ

(0) 1200dpi x 300dpi

White Ink Settings :

Highlight: I

Mask : I

Print Time : %1

[J2 Layer White
[CJwhite/Color Pause

[JUse background black color (for black T-shirts only)
[ Color Multiple Pass Printing

Mode - Color:
ibrant The extra color ink is emphasized.

() Natural

(D) Eco-Mode

(@ 1200dpi x 1200dpi

(7) 1200dpi x 600dpi

Whiteness - | 400 %

kC

Default

[Matural: Color output is adjusted to reduce the emphasis of orange and green ink colors

Cancel
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4-4-6. Select the resolution

Creating print data

>

The range that can be set for highlighting will change, and the printing time will also differ, depending on the resolution

selected in [Resolution:].

Resolution

##1 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

Paper/Quality Main Setting

Platen Size : 14x16 i Advanced
Platen Height : Mo designation W
Select Ink ‘Color+White Ink P
Extra Colors ORGR
Mode :
Color: (@ Vibrant (O Natural
White (@ Normal () Eco-Mode

Resolution :

(7)1200dpi x 1200dpi HQ

(@) 1200dpi x 1200dpi

() 1200dpi x 900dpi () 1200dpi x 600dpi

White Ink Settings

1 3 5 7 9
Highlight: I 5

1 2 3 4 5
Mask - I 3

Print Time : x1 Whiteness : | 400 %

[J2 Layer White
[JwWhite/Color Pause

[JUse background black color (for black T-shirts only)

[ Color Multiple Pass Printing Default

Resolution: Select the resolution of'the"image youwantto p}im_

1200 dpi x 1200 dpi HQ: Take your time to print high quality. You can select a highlight from 1
through 5.

1200 dpi x 1200 dpi: You can select a highlight from 1 through 9. f you turn 2 Layer White OM, you
\can also select a highlight from 10 through 13.

1200 dpi = 900 dpi: You can select a highlight from 1 through 3.

1200 dpi x 600 dpi: You can select only highlight 1.

Cancel

Resolution

Description

1200dpi * 1200dpi

Prints at 1200 dpi x 1200 dpi.

1200dpi x 1200dpi HQ

Prints at 1200 dpi x 1200 dpi (High Quality Mode).
Valid for white + color ink and white ink only.

1200dpi x 900dpi

Prints at 1200 dpi x 900 dpi.

1200dpi x 600dpi

Prints at 1200 dpi x 600 dpi.

<TIPS>

° Depending on the settings of [Resolution:], [Print Time:] will change.
. Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink

consumption.
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4-4-7. Set up the white ink

Creating print data

>

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], the setup items for [White Ink Settings:] will

appear.

Adjust the white ink volume separately in the [Highlight:] (visible white ink volume) and in the [Mask:] (white ink volume to

cover the background color).

Also, set the white ink time in the [2 Layer White] and [White/Color Pause].

Paper/Quality Main Setting

## Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

White Ink Settings :

Highlight

[J2 Layer White

[CJwhite/Color Pause

(7) 1200dpi x 300dpi

[ color Multiple Pass Printing

Platen Size : 14x16 i Advanced
Platen Height : Mo designation e
Select Ink ‘Calor+White Ink ~
Extra Colors ORGR

Mode

Color: (@ Vibrant (O Natural

White (@ Normal () Eco-Mode
Resolution : (C)1200dpi x 1200dpi HQ (®) 1200dpi x 1200dpi

(7) 1200dpi x 600dpi

Whiteness | 400 %

Default

nk

[You can set "Highlight" and "Mask" when "Color+White Ink" or "White Ink Only" is selected.
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Highlight
This enables you to select whiteness (thickness) of RGB=254 in such nine levels as [1] to [13]. When you increase this

value, the White ink volume will increase.
You can specify [10] to [13] only if [2 Layer White] is enabled.

>

Highlight setpoints Ink volume

[1] White ink volume 200%
[2] White ink volume 250%
[3] White ink volume 300%
[4] White ink volume 350%
[5] White ink volume 400%
[6] White ink volume 450%
[7] White ink volume 500%
[8] White ink volume 550%
9] White ink volume 600%
[10] White ink volume 650%
[11] White ink volume 700%
[12] White ink volume 750%
[13] White ink volume 800%
<TIPS>

. Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate highlight setting value before creating print data. Perform a highlight check pattern print and select an appropriate
setting value. ="4-6-6. Print out of highlight check pattern/mask check pattern >>P.133"

° Depending on the settings of [Highlight:], [2 Layer White], [White/Color Pause], and [Color Multiple Pass Printing], the [Print
Time:] and [Whiteness:] will change accordingly.

o [Print Time:] will be set to [x1] if the setup value of [Highlight:] is [5], and [2 Layer White], [White/Color Pause] and [Color Multiple
Pass Printing] are turned OFF. With this [X1] serving as a reference value, how many times relates to how long the print time will
take when printing.

. Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink
consumption.

Mask

This enables you to select the volume of white ink which is used as background color for color inks in such five levels as
[1] to [5].

Setup value Description

[1]or[2] These setup values are suitable for such lighter and pale background colors as pale pink,
ash and cream.

[3] This is the default value.
This value will reproduce the most smooth white-gray-black gradation.

[4] This value is suitable for vivid background colors, e.g., red, purple, and green. It
suppresses the influence of the color of the fabric.

[5] This value enables the printing with the largest amount of white ink under all colors except
darker color areas.

<TIPS>

° Perform a mask check pattern print and select an appropriate setting value. ="4-6-6. Print out of highlight check pattern/mask

check pattern >>P.133"
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2 Layer White

You can make highlight settings at a level of [1] to [13] when 2 Layer White is enabled.

Set 0-60 seconds for the time from the start of printing the first white ink layer to the start of printing the second white ink
layer.

If you set a time shorter than the time it takes to print the first layer, the additional waiting time will be set to 0 seconds.
<TIPS>

° Only if you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:] settings, this setting menu will be enabled.

White/Color Pause

Set 0-60 seconds for the time from the start of printing the previous white ink layer to the start of printing the color ink

layer.

If you set a time shorter than the time it takes to print the previous white ink layer, the additional waiting time will be set to

0 seconds.

<TIPS>

o Only if you have selected [Color+White Ink] in the [Select Ink:] settings, this setting menu will be enabled.

. Check this checkbox to activate it when you print a tiny image.

. Tiny images may become black when printed. When that occurs, print a white layer first and wait for a while (waiting time) to print
the color layers.
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4-4-8. Specify whether or not to use the background black color

Creating print data

>

If you have selected [Color+White Ink] in the [Select Ink:], the setup items of [Use background black color (for black

T-shirts only)] will appear.

In the event that you wish to print a black T-shirt making use of the T-shirt's background black color, mark the [Use

background black color (for black T-shirts only)] checkbox.

Paper/Quality Main Setting
Platen Size : 14x16

Platen Height : Mo designation

Select Ink Color+White Ink
Extra Colors ORGR
Mode :
Color: (@ Vibrant
White (@ Normal
Resolution : (0)1200dpi x 1200dpi HQ

() 1200dpi x 900dpi

White Ink Settings :

Highlight : I

Print Time : x1

[J2 Layer White

DWhite}CoIorPause

se background black color (for black T-shirts only]\

[ |Color Muluple Fass Printing
fl'_'jse"bacl-'cground' black color:

Black (RGB = 0) is automatically transparent

w

Mask : I

## Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

i Advanced

() Natural
() Eco-Mode

(@) 1200dpi x 1200dpi
() 1200dpi x 600dpi

Whiteness | 400 %

] [

lC

Default

|Turn ON this item when printing an image on black material with its black colorused.

'Turn OFF this item when you select some transparent color in advanced menu.

Cancel
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4-4-9. Specify whether or not to perform Multiple Pass Printing

The setup items for [Color Multiple Pass Printing] will appear if you have selected the [Color+White Ink], [Color Ink Only],

or [Black Ink Only] in the [Select Ink:].

In cases where small and horizontal stripes are noticeable in the print result, mark the [Color Multiple Pass Printing]

checkbox.

<TIPS>

° Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of ink to be consumed will remain unchanged.

. It takes longer to complete the print when the [Color Multiple Pass Printing] checkbox is marked. For a typical print time, refer to
[Print Time:].

#2 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting

Platen Size : 14x16 e Advanced
Platen Height : No designation w
Select Ink Color+White Ink ~

Extra Colors ORGR

Mode :
Color: (@ Vibrant () Natural
White (@ Normal (C)Eco-Mode
Resolution : (7)) 1200dpi x 1200dpi HQ (@) 1200dpi x 1200dpi
(7)1200dpi x 300dpi (7) 1200dpi x 600dpi
White Ink Settings 1 3 5 7 g
Highlight I 5
1 2 3 4 5
Mask : I 3

Print Time : x2 Whiteness: | 400 %

[J2Layer White

[CJwhite/Color Pause

lC

[ |Use background black color (for black T-shirts only)

olor Multiple Pass Printing: Default

ColorM'uIti'pIe Pass Pri'ming:
Color Multiple Pass printing, for color print data, increases the number of platen line feeds to
produce finer ink dots. It takes longer to print but enables better color printing.
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4-4-10. Set up the white ink

Creating print data

>

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], this setting menu will be enabled.
When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [White Ink Settings]

appear.

In the [White Ink Settings], you can make settings for [Transparent Color:], [Tolerance:], [Minimum Whiteness:], [Choke
Width:], and [ORGR Bleeding Reduction].

Brother GTX-6 Extra Colors ORGR Advanced menu X

White Ink Settings

I green (0,199,0) Custom...

Minimum Whiteness : (@ Normal () special
1 2

01 23456 7 8 9 10
Choke Width : I

[ ] ORGR Bleeding Reduction

Color Processing

0 10 20 30 40
Saturation : I o
Brightness : I 5
Contrast : I s
Color Balance
Seliey on TS B | G S B

Cyan : I ,T
Magenta : I ’T
Yellow @ I ’T
Black : I ’T
Green : I ’T
Orange : I ’T

[] uni-Directional Printing

[Transparent Color :

Selecting a color to make it transparent, RGB=255 white is always transparent. Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB values
for custom transparent color. It is recommended that the [Use background black color] function is

fturned OFF to produce better colors.
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Transparent color

With this option, specify a color which is treated as a transparent color without using any color during the printing
process. If you want to specify other colors excluding the RGB=255 as "Transparent color", perform the following
procedures to make your setting.

<TIPS>

o The RGB=255 is treated as a "Transparent color" (non-printing color).

o You would be better off making [Use background black color (for black T-shirts only)] OFF to produce better colors.

(1) Click the [Transparent Color:] checkbox.
Then, the pull-down menu for color selection becomes active.

(2) In the pull-down menu, select a color which serves as a background color of T-shirt, or click on the [Custom...] to

specify a RGB value.

<TIPS>

. This custom color you have specified is valid only for one color which is specified immediately before. This color cannot be
saved in the list.

Brother GTX-6 Extra Colors ORGR Advanced menu X

(a]
e
o
g
X

White Ink Settings

[#] Transparent Color : I green (0,199,0) | Basic
green (0,199,0)

I biue (0,108,255)

B royal blue (30,0,255)

I purple (118,0,235)

[ yellow (255,255,0)

[ gold (255,174,0)

I orange (255,108,0)

I r<d (255,0,0)

I pink (255,0,150)

B deep red (255,0,102)

DURGR Bleeding Reductiol M marcon (109,0,62)

[ pale orange (255,221,154)

[ sand (204,196,171)

[ light green (96,255,0)

I kelly green (0,154,70)

I olive (117,115,51)

[ Jlime (213,255,44)

Custom colors:
I 2quamarine (0,126,82)
Contrast : I spruce (0,98,110)

[ aquatic blue (36,213,255) I_ I_ I_ I— I_ I_ I_
Color Balance =:::th‘;9&1;1115;5?;) . I_ I_ I_ I_ I_ I_ I_

lors:

8

Tolerance :

EI

Minimum Whiteness :

ERE

Choke Width :

Color Processing

HEEEN 1]
MEENA
HEENEEN N
EEENET
TTHEERN
EEEERNT
IHEEEN

Saturation :

Brightness :

=[]
[ |

Cyan @ I ,T

Magenta : I IT Mm Cl.lm'n Cohm 2>
Yellowr @ I ,T

Black : I ,T me

Green : I ,T

Orange : I IT

D Uni-Directional Printing

'Transparent Color :

Selecting a color to make it transparent, RGE=255 white is always transparent. Turning this feature
ON allows you to select another coler in the image and make it transparent, you can input RGB values
for custom transparent color. It is recommended that the [Use background black color] function is

{turned OFF to produce better colors.
o ][ cone

Tolerance

Specify the gradation range (RGB values) to smoothly connect the zone between "Unprinted color" and "Printed color"

to be gradually changed in tone.

<TIPS>

. If this value is increased, the gradation range in which the mask white is generated from a state in which no mask white exists will
increase.

o The gradation's image quality depends on image data. For this reason, it is advisable to perform a test printing beforehand.
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Minimum white ink volume

When printing with [Color+White Ink], the volume of background white color ink for dark or black color ink can be
controlled.

When printing with [Color+White Ink], you can increase the amount of the white ink volume used as the base in a dark
area by specifying a larger value.

Selecting [Special] allows you to select a value of [3] or higher.

<TIPS>

. The larger the value is, the more likely that blurring occurs.

White Ink Choke Width

This enables you to select the white ink choke width in such ten levels as [1] to [10]. When you increase this value, the

choke width increases. By decreasing the print range of white ink, the white ink will be prevented from extending off from

under the color inks.

<TIPS>

. Check the original image if white lines and/or dots are seen around the image, this may be caused by "Anti-alias" bitmap.

. There are instances in which fine lines (characters or photographs) will disappear if this level is increased. For this reason, it is
advisable to perform a test printing beforehand.

ORGR Bleeding Reduction

You can select [ORGR Bleeding Reduction] only when [Normal] is selected in [Mode:] > [White:].

When you select [ORGR Bleeding Reduction], the white ink under orange or green ink is automatically adjusted to
reduce bleeding.

<TIPS>

. The luminance on the finished print may be slightly reduced depending on the color.
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4-4-11. Set up the image quality

Creating print data

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear.

In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:].
Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application

software.
Setup item Description
[Saturation:] The more vivid the color is, the higher its value.
[Brightness:] The brighter the color is, the higher its value.
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value
increases.
<TIPS>

. If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear.

. For this reason, it is advisable to perform a test printing beforehand when you specify a higher value.

Brother GTX-6 Extra Colors ORGR Advanced menu

White Ink Settings

I oreen (0,199,0) Custom..
Minimum Whiteness : (@) Normal () special
1 2

01 2 3 45 & 7 8 9 10

i
Choke Width : I 2

[] ORGR Bleeding Reduction

Color Processing

.
=1

Saturation :

Brightness :

Contrast :

N
s
=

Color Balance

SR an A e R T e S B
Cyan : I ,T
Magenta : I ’T
Yellow : I ’T
Black : I ’T
Green : I ’T
Orange : I ’T

[ uni-Directional Printing
Saturation :

Saturation increases the color brightness. Use for grayish and colorless images, artwork created in
CMYK color mode, scanned data, etc.

X
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4-4-12. Set up the color balance

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear.
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], [Black:], [Green:], and [Orange:].

You can adjust the color in 11 gradations, -5 to +5.

<TIPS>

. If you select [Black Ink Only] for ink selection, you can adjust [Black:] only.

° You can make [Green:] and [Orange:] adjustments only when [Extra Colors ORGR] is ON.

Setup item Description
[Cyan] Adjust the cyan ink volume.
If you increase its value, the color becomes light bluish overall. If you decrease its value,
the color becomes reddish overall.
[Magenta:] Adjust the magenta ink volume.
If you increase its value, the color becomes reddish-purple overall. If you decrease its
value, the color becomes greenish overall.
[Yellow:] Adjust the yellow ink volume.
If you increase its value, the color becomes yellowish overall. If you decrease its value,
the color becomes bluish overall.
[Black:] Adjust the black ink volume.
If you increase its value, the color becomes blackish overall. If you decrease its value, the
color becomes whitish overall.
[Green:] Adjust the green ink volume.
Increasing the value makes green stronger in the yellow to cyan gamut.
Reducing the value weakens green in the yellow to cyan gamut.
[Orange] Adjust the orange ink volume.
Increasing the value makes orange stronger in the magenta to yellow gamut.
Reducing the value weakens the orange in the magenta to yellow gamut.
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Brother GTX-6 Extra Colors ORGR Advanced menu X
White Ink Settings
I oreen (0,199,0) - Custom...
g] 1 20 30 40 S0
Tole | 30
Minimum Whiteness : (@ Normal () special
1 2

[ [+

01 23456 7 8 9 10
Choke Width : I |2

[_] ORGR Bleeding Reduction

Color Processing

Saturation : I

Brightness : I

Contrast : I

Color Balance

o
—
=1
=)
=
w
=1
s
=1

EBE

Cyan :
Magenta :
Yellow @
Black :
Green :

Orange :

o
o
o
o
[o
[o

[ uni-Directional Printing

Green :

djust the green ink volume.
Increasing the value makes green stronger in the yellow to cyan gamut.
Decreasing the value weakens the green in the yellow to cyan gamut.
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>

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional

Printing].
<TIPS>

. What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print

direction specified on the printer side is set to [Auto].
o Print time will be doubled.

Brother GTX-6 Extra Colors ORGR Advanced menu

White Ink Settings

I green (0,199,0)

Minimum Whiteness : (@ Normal
1
0 1 2 3 4 5 6
Choke Width : I
[ ] ORGR Bleeding Reduction
Color Processing
0 10 20

Saturation : I

Brightness : I

Contrast : I

Color Balance
=53 =7 -1 B L

Cyan :
Magenta :
Yellow @
Black :
Green :

Orange :

[ ] uni-Directional Printing

ni-Directional Printing :
Makes the print uni-directional.
The value of Print Direction set by the Panel has priority. This is available only if [Auto] is selected in
Print Direction through the Control Panel.

Custom..

() special

2

] ]

7 8 9 10
30 40
5
5
o
253 R h

SREEEE

Cancel
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4-5. Driver settings for print data using color ink and black ink only

4-5-1. Setting up the printer driver

<TIPS>

° The GTX-6 Extra Colors ORGR printer driver treats RGB=255 as a "Transparent color" and does not eject the ink. For such an
image that you wish to print out in pure white color with white ink, make such a setting as RGB=254.

. For the color replacement method, refer to a relevant page (="4-3. Using other applications >>P.80") or help menu of each
application software.

(1) By following the printing procedures of each application software, open the print setup dialog box of the printer

driver.

1 Brother GTX-6 Extra Colors ORGR (LAN) Document Properties x>

Paper/Quality Main Setting

Platen Size : 14x16 v

Platen Height : MNo designation w
SelectInk: Color Ink Only ~
[#]Extra Colors ORGR
Mode
Color (@ Vibrant () Natural
Normal Eco-Mode
Resolution : 1200dpi x 1200dpi HQ (@ 1200dpi x 1200dpi
() 1200dpi x 300dpi () 1200dpi x 600dpi

Color Ink Settings

Ink Volume I 10
Double Printing : I 1

] color Muttiple Pass Printing Default

Advanced
Click to open advanced menu.
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(2) Inthe dialog box for setting the printer driver, configure required settings.
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be
configured.
<TIPS>
. Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary.
. The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse
the help feature.
. For the detailed description of setup items, refer to each chapter mentioned below.

Brother GTX-6 Extra Colors ORGR Advanced menu X

White Ink Settings

Transparent Color : I green (0,199,0) Custom

MNormal Special

ENA

ORGR Bleeding Reduction

Color Processing

.
=1

10 20 30

Saturation :

Brightness : I
Contrast : I

Color Balance

-
wu

e seon T L i S T

Cyan : I ,T
Magenta : I ,T
Yellow : I ,T
Black : I ,T
Green : I ,T
Orange : I ’T

[] uni-pirectional Printing

Transparent Color @

Selecting a color to make it transparent, RGB=255 white is always transparent. Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB values
for custom transparent color. It is recommended that the [Use background black color] function is

turned OFF to produce better colors.

(3) After your settings are completed, click [OK].
<TIPS>
. You can refer to each value you have set up here by opening an ARX6E/ARXG file from the "GTX-6 Extra Colors ORGR
File Viewer".
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4-5-2. Select the platen size

From the pull-down menu of [Platen Size:], select a platen size for print area.
<TIPS>

. The platen size is equivalent to the paper size.

Setup item Platen to be used Size
[24x24] 24x24 platen 24.0in.x24.0in. (610 mm x 610 mm)
[18x22] 18x22 platen 18.0in. x 22.0 in. (457 mm x 559 mm)
[16X18] 16X18 platen 16.0in. x 18.0in. (406 mm x 457 mm)
[14X16] 14X16 platen 14.0in. x 16.0in. (356 mm x 406 mm)
[10X12] 10X12 platen 10.0in. x 12.0 in. (254 mm x 305 mm)
[7X8] 7X8 platen 7.0in.x 8.0 in. (178 mm x 203 mm)
@ Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting

Platen Size : Advanced
Platen Height:
SelectInk:
Mode :
Color (@ Vibrant (O Natural
Normal Eco-Mode
Resolution : 1200dpi x 1200dpi HQ (@ 1200dpi x 1200dpi
() 1200dpi x 900dpi () 1200dpi x 600dpi

Color Ink Settings

Ink Volume : I 10
Double Printing : I 1

[ Color Multiple Pass Printing Default

Platen Size :

Selectthe size ofthe platen used for print.
24%24 (609.6x609.6mm)

18x22 (457.2%558.8mm)

16x18 (406.4x457.2mm)

14x16 (355.6x406.4mm) “standard

10x12 (254.0x304.8mm)

T8 (177.8x203.2mm)
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4-5-3. Selecting platen height

Creating print data

>

From the pull-down menu of [Platen Height:], select the platen height.

When the printer receives print data, the platen automatically changes to the specified platen height.
You can select the height from [No designation], [A], [B], [C], [D], [E], [F], [G], and [H].

<TIPS>

. The platen height is not changed if you select [No designation].

@ Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting
Platen Size :

Platen Height:

SelectInk:

Mode :

Color

Resolution

Color Ink Settings

Ink Volume :

Double Printing :

[ Color Multiple Pass Printing

Advanced
Click to open advanced menu.

14x16

No designation

1200dpi x 1200dpi HQ

() 1200dpi x 900dpi

Color Ink Only b
Extra Colors ORGR
(@ Vibrant () Natural
Normal Eco-Mode

(@ 1200dpi x 1200dpi

() 1200dpi x 600dpi

4 5 6 7 8

-
ra

9 10
I 10
3

I 1

Default
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4-5-4. Select the ink type
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>

From the [Select Ink:] option, select a combination of inks to be used.

Setup item

Description

[Color+White Ink]

This option enables a color image to be printed out on the mask layer of white ink.

[White Ink Only]

This option enables the white ink only to be used for printing out a monochrome image.

[Color Ink Only]

pale color background.

This option enables a color image to be printed out on a white background or lighter and

[Black Ink Only]

This option enables the black ink only to be used for printing out monochrome image.

[Extra Colors ORGR]

This option will be enabled if you have selected [Color+White Ink] or [Color Ink Only].
Orange/Green ink will be used if the check box is ON.
Orange/Green ink will not be used if the check box is OFF.

Paper/Quality Main Setting
Platen Size : 14x16

Platen Height:

No designation

@ Brother GTX-6 Extra Colors ORGR (LAN) Document Properties

e Advanced

SelectInk: Color Ink Only
Color+White Ink
White Ink Onl
Black Ink Only
Mode :
Color (@ Vibrant (O Natural
Normal Eco-Mode
Resolution : 1200dpi x 1200dpi HQ (@ 1200dpi x 1200dpi
() 1200dpi x 900dpi () 1200dpi x 600dpi
Color Ink Settings 1 2 3 4 5 7 8 9 10
Ink Volume : I 10
0 1 2 3
Double Printing : I 1

[ Color Multiple Pass Printing

Selectink :
Selects ink combination.

Color+White Ink : Prints colorimages on White ink mask.

W hite Ink Only : Prints monochrome images with only white ink.

Default

Color Ink Only : Prints only colorimages on white or light color materials.

Black Ink Only : Prints monochrome images with only black ink
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4-5-5. Specify whether or not to perform Multiple Pass Printing

The setup items for [Color Multiple Pass Printing] will appear if you have selected the [Color+White Ink], [Color Ink Only],

or [Black Ink Only] in the [Select Ink:].

In cases where small and horizontal stripes are noticeable in the print result, mark the [Color Multiple Pass Printing]

checkbox.

<TIPS>

° Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of ink to be consumed will remain unchanged.

. It takes longer to complete the print when the [Color Multiple Pass Printing] checkbox is marked. For a typical print time, refer to
[Print Time:].

@ Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting

Platen Size : 14x16 e Advanced
Platen Height: No designation w
Selectink: Color Ink Only ~
[v]Extra Colors ORGR
Mode :
Color (@ Vibrant (O Natural
Normal Eco-Mode
Resolution : 1200dpi x 1200dpi HQ (@ 1200dpi x 1200dpi
() 1200dpi x 300dpi () 1200dpi x 600dpi
Color Ink Settings 1 5 3 4 5 6 7 8 9 10
Ink Volume o
0 1 2 3

Double Printing : I 1

olor Multiple Pass Printing Default

Color M'ulti'p'le Pass Pri'nting
Color Multiple Pass printing, for color print data, increases the number of platen line feeds to
produce finer ink dots. lttakes longer to print but enables better color printing.
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4-5-6. Set up the color ink

If you have selected [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items of [Color Ink Settings:] will

appear.
You can make your setting from the [Ink Volume:] or [Double Printing:] option in the [Color Ink Settings:] window.

@ Brother GTX-6 Extra Colors ORGR (LAN) Document Properties X

Paper/Quality Main Setting

Platen Size : 14x16 s Advanced
Platen Height: No designation w
SelectInk: Color Ink Only w
[#] Extra Colors ORGR
Mode :
Color (@ Vibrant (O Natural
White Narmal Eco-Mode
Resolution : 1200dpi x 1200dpi HQ (@) 1200dpi x 1200dpi
() 1200dpi x 900dpi () 1200dpi x 600dpi

Color Ink Settings

Ink Volume :

Double Printing :

] Color Muttiple Pass Printing Default

[Color Ink Settings :

Enables you to set"Ink Volume" and "Double Printing" when "Color Ink Only" or "Black Ink Only" is
|

selected
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Ink volume

This enables you to select the ink volume in such ten levels as [1] to [10].

>

Setup value Description

[10] This is the default value.
This value corresponds to 100%-cotton fabrics as well as for blended yarn fabrics (hemp
50%/polyester 50% or cotton 50%/polyester 50%).

[O]to[7] These values correspond to a thinner T-shirt, thick towel, and cotton products woven with
twill fabrics.

[6] to [4] These values correspond to thin and plain fabrics as well as for blended yarn fabrics that
consist of cotton, polyester and polyurethane.

[B]to [1] These values correspond to polyester jerseys and synthetic fabrics that have no water
absorbency.

<TIPS>

. When you print other clothes than a thick T-shirt, check on the actual blurring first, then adjust a value in the [Ink Volume:] option.

Double Printing

Performing the print cycle two times separately will make the printed color stand out more.

Setup value Description
[0] No separate processes
[1] Separate processes (wait time between the 1st and 2nd print cycle)
[2] Separate processes (longer wait time than the case with setting [1] between the 1st and
2nd print cycle)
[3] Separate processes (longer wait time than the case with setting [2] between the 1st and
2nd print cycle)

<TIPS>
. For the options [1] to [3], the platen will reciprocate two times.
. The higher the setpoint is, the longer the print time will be.
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4-5-7. Set up the image quality

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear.
In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:].

Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application
software.

Setup item Description
[Saturation:] The more vivid the color is, the higher its value.
[Brightness:] The brighter the color is, the higher its value.
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value
increases.

<TIPS>
. If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear.
. For this reason, it is advisable to perform a test printing beforehand when you specify a higher value.

Brother GTX-6 Extra Colors ORGR Advanced menu X
White Ink Settings

Transparent Color : Il oreen (0,199,0) Custom..

Normal Special

A

ORGR Bleeding Reduction

Color Processing

Saturation :

Brightness :

Contrast :

Color Balance

0

Cyan : I
Magenta : I
Yellow : I
Black : I
Green : I
]

Orange :

[ uni-Directional Printing
Saturation :

Saturation increases the color brightness. Use for grayish and colorless images, artwork created in
CMYK color mode, scanned data, etc.
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4-5-8. Set up the color balance

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear.
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], [Black:], [Green:], and [Orange:].

You can adjust the color in 11 gradations, -5 to +5.

<TIPS>

. If you select [Black Ink Only] for ink selection, you can adjust [Black:] only.

° You can make [Green:] and [Orange:] adjustments only when [Extra Colors ORGR] is ON.

Setup item Description
[Cyan] Adjust the cyan ink volume.
If you increase its value, the color becomes light bluish overall. If you decrease its value,
the color becomes reddish overall.
[Magenta:] Adjust the magenta ink volume.
If you increase its value, the color becomes reddish-purple overall. If you decrease its
value, the color becomes greenish overall.
[Yellow:] Adjust the yellow ink volume.
If you increase its value, the color becomes yellowish overall. If you decrease its value,
the color becomes bluish overall.
[Black:] Adjust the black ink volume.
If you increase its value, the color becomes blackish overall. If you decrease its value, the
color becomes whitish overall.
[Green:] Adjust the green ink volume.
Increasing the value makes green stronger in the yellow to cyan gamut.
Reducing the value weakens green in the yellow to cyan gamut.
[Orange] Adjust the orange ink volume.
Increasing the value makes orange stronger in the magenta to yellow gamut.
Reducing the value weakens the orange in the magenta to yellow gamut.
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Brother GTX-6 Extra Colors ORGR Advanced menu X
White Ink Settings
Transparent Color : Ml green (0,193,0) - Custom...
8] 1 20 30 40 S0
Tole 30
T it Normal Special
1 2

Choke Width

ORGR Bleeding Reduction

Color Processing

10 20 30 40
Saturation : | o
Brightness : | 5
Contrast : | 5

Color Balance

Cyan :
Magenta :
Yellow @
Black :
Green :

Orange :

o
o
o
o
[o
[o

[ uni-Directional Printing

Green :

djust the green ink volume.
Increasing the value makes green stronger in the yellow to cyan gamut.
Decreasing the value weakens the green in the yellow to cyan gamut.
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>

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional

Printing].
<TIPS>

. What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print

direction specified on the printer side is set to [Auto].

. Print time will be doubled.

Brother GTX-6 Extra Colors ORGR Advanced menu X

White Ink Settings

Transparent Color : Il oreen (0,195,0) Custom...

MNormal Special

7

ORGR Bleeding Reduction

Color Processing

Saturation : .

Brightness : I

Contrast : I

Color Balance

=}
=
=}
=)
=
w
=1
s
=1

]

EE

e st Sl ] G S S

Cyan : I ,T
Magenta : I ’T
Yellow @ I ’T
Black : I ’T
Green : I ’T
Orange : I ’T

[] uni-Directional Printing

\Uni-Directional Printing :

Makes the print uni-directional.

The value of Print Direction set by the Panel has priority. This is available only if [Auto] is selected in
Print Direction through the Control Panel.
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4-6. Using Useful Tools

Useful tools and print data are provided for adjusting colors or searching for an appropriate print setting.

The "Useful Tools" will be installed onto the subdirectory under the "Brother GTX-6 Extra Colors ORGR Tools"
subdirectory on your PC.

For the details of each tool, please refer to the chapters described later.

4-6-1. Use the color palette

The different color palettes are available for each software application as follows:
e  Adobe Photoshop/lllustrator: "GT_Colors_T.ase"
e  CorelDRAW: “GT_Colors.xml" and "GT_Tshirts.xml"

For more information, refer to a relevant page (=-"4-3. Using other applications >>P.80") or help menu of each

application software.

<TIPS>

. When using the printer driver by default, use one of them as a color sample to check color reproduction and create/edit the
image data. (Because CorelDRAW cannot contain identical color in the same palette, the color palette is divided into two files.)

4-6-2. Replace RGB=255 with RGB=254 (for Photoshop only)

For Photoshop, use this to change RGB=255 to RGB=254.

(1) From the "Useful Tools", click "SolidWhite.atn", and follow the on-screen instructions to save the file on your PC.
(2) Inthe menu bar of Photoshop, select [Window] > [Action file].

(3) Clickon == to open the submenu.

(4) From the [Load Actions], select "SolidWhite.atn" saved on your PC.
<TIPS>
. For information on using action files, refer to the Help feature that Photoshop is provided with.
° "SolidWhite.atn" can be used only when the [Color mode] is set to [8 bit] of [RGB Color].
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4-6-3. Check the color sample

Use when checking the color sample.

Please use this color chart as a color sample like the one that is commonly provided by an ink maker, for the print data
(ARX® file) you created using your desired printer driver setting.

<TIPS>

. Make use of this color chart when you perform the printing after changing the settings of the printer driver.

RECESE MESHIW ROLHE
Uptial  DdCea? - Oalde

Brother GT Garment Printer Tshtrt Mnsparent Colors

(1) From the "Useful Tools", click a required file name to download the data. The following files are provided as color

samples.
e  GT_Blues.pdf
e  GT_Greens.pdf
e  GT_Oranges.pdf
e  GT_Reds.pdf
e  GT_ColorChart.pdf

(2) Configure the printer driver and create print data.
<TIPS>
. For details of the printer driver's setting procedures.
- In the case of print data using white ink ="4-4-1. Setting up the printer driver >>P.98"
= In the case of print data using color ink and black ink only ="4-5-1. Setting up the printer driver >>P.117"
3 For information on creating print data, ="4-3. Using other applications >>P.80"

(3) Send the created print data to the printer and perform printing. =™"5. Basic printing procedures >>P.141"
<TIPS>
. Check the print result and adjust the printer driver's settings.
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4-6-4. Print a grid pattern on the platen sheet

You can print a grid pattern onto a new platen sheet.

Platen sheet Grid

N /

/

Platen

X0163

(1) From the "Useful Tools", open such an ARXG file (for example, Grid14x16.arx6) that has a grid size suitable to the

platen size.
(2) Send the print data of grid pattern to the printer.

(3) Without putting a T-shirt in place, print the grid pattern directly onto the platen sheet.

<TIPS>
. After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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4-6-5. Adjust the ink volume

Set an optimum setting for [Ink Volume:] of the printer driver.

Download the data from "Useful Tools" and perform printing (="5. Basic printing procedures >>P.141") to check the
blurring beforehand.

<TIPS>

e  Appropriate ink volume setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate ink volume setting value before creating print data.

. There are four types of ink volume printing data. Select the ink volume print data to match the [Double Printing:] setting for the
printer driver.

(1) Select the desired file from "Ink Volume SinglePrint.arx6", "Ink Volume DoublePrint1.arx6", "Ink Volume
DoublePrint2.arx6", and "Ink Volume DoublePrint3.arx6" from the "Useful Tools" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result and adjust the value for [Ink Volume:] of the printer driver.

i+ = (m] X
-70 FA
Job Name : ink Volume SinglePrint o ! i L At
A
e s tiiiiiitii
rvther Gurest intr o et Te Pl 100 - Pleuts Plteg
Platen Size : 14x16 1
Resolution : 1200dpi x 1200dpi
Select Ink : Color Ink Only
0
Color Ink Volume : 10
Double Printing : ]

Color Muttiple Pass Printing : ~ OFf

Details...
80 &
Calor Ink 041cc o ’
Print : 1 piece 1oox | po
Browse... Close

132



Creating print data

4-6-6. Print out of highlight check pattern/mask check pattern

Set an optimum setting for [Highlight:] of the printer driver.

Download the data from "Useful Tools" and print the highlight check pattern for checking whiteness, background hiding
level, and blurring beforehand.

<TIPS>

. Please print on a pretreated T-shirt. ="5. Basic printing procedures >>P.141"

. Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate highlight setting value before creating print data.

(1) From the "Useful Tools", click "Highlight-Mask Check at MW1.zip" or "Highlight-Mask Check at MW2.zip" to

download data.

<TIPS>

. The file you should select differs depending on whether "Minimum Whiteness:" is set to [1] or [2].
Check the number at the end of the file name before downloading the file.

(2) Unzip the file and the following print data will be displayed.
e  "HighlightCheckPattern"
e  "MaskCheckPattern" at each highlight

(3) Print "HighlightCheckPattern" and select the optimum highlight setting.
(4) Print "MaskCheckPattern" for the optimum highlight setting and select the optimum mask setting.
(5) Check the print result and adjust the values for [Highlight:] and [Mask:] of the printer driver.

w - o x
7.0 7!

Job Name : Highlight Check MW1 80 i 0
Date : 09/04/2018 17:05 e
Platen Size : 1416
Resolution : 1200dpi x 1200dpi
Select Ink : ColorsWhite Ink

Highlight : 1

Mask 3 0

Print Time : %1

Whiteness : 200 %
Use background black color:  Off
Color Muttiple Pass Printing Off

Details ..
80
Color Ink : 064 cc
White Ink : 1066 cc 100% 600 %
Print - 1 piece
P Total + | []White Data
Sendto Printer
oo I | e
Browse: Close
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4-6-7. Color adjustments between color/ORGR heads
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>

Check the color adjustment of the color side and OR/GR side heads.

Color adjustment for color side heads

(1) From the "Useful Tools", click "COLOR ADJUSTMENT _COLOR.arx6 " to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the color adjustment has been set correctly.

(4) Ifthe adjustment is not good, readjust the print head according to E Making print head adjustments" in the Setup

Manual.

w - o X
Jab Name : COLOR ADJUSTMENT il ¢ i
OT Mad Go i A ctuant A
Date : 05/07/2021 14:51
Platen Size : 14x16 .........
Resolution : 1200dpi x 1200dpi
Select Ink : Color Ink Only
0 -
Color Ink Volume : 10
Double Printing : 0
Color Multiple Pass Printing : ~ OFf
Detas...
80 ¥
Color Ik : 0.07cc = e >
Print : 1 piece 100% | 600 %
Browse... Close
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Color adjustments to OR/GR side heads

(1) From the "Useful Tools", click "COLOR ADJUSTMENT_ORGR.arx6e" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the color adjustment has been set correctly.

(4) If the adjustment is not good, readjust the print head according to "E Making print head adjustments” in the Setup

Manual.

¥ o m} X
dob Nama COLOR ADJUSTMENT =i 0 70
20 . X
Date : 05/07/2021 14:51 R —
Plsten Size : 1416 BEEEENEEEE
Resolution : 1200dpi x 1200dpi
Sefect Ink : Color Ink Orly
0
Color Ink Volume : 10
Double Printing : 0
Color Mutiple Pass Prirting: ~ Off
Detais
80 @
Color Ink : 007cc < o)
Print 1 piece 100% | 500 %
Browse... Close
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4-6-8. Check the ejection timing

Check whether or not the ejection timing is correct.

™

)
©)

download data.

Send the data to the printer and perform printing.

From "Useful Tools", click "FIRING CHK COLOR A.arx6", "FIRING CHK COLOR B.arx6", "FIRING CHK WHITE
Aarx6", "FIRING CHK WHITE B.arx6", "FIRING CHK ORGR_A.arx6e" or "FIRING CHK ORGR_B.arx6e" to

Check the print result to make sure the ejection timing has been set correctly.

Job Name : FIRING CHK COLOR_A i
8.0k W -
Date : 17/09/2015 16:05 WA - (-
A G G
Platen Size : 14x16 1
Resolution : 1200dpi x 1200dpi
Select Ink : Color Ink Only
0
Color Ink Volume : 10
Double Printing : ]
Color Muttiple Pass Printing : ~ OFf
Details
8.0
Color Ink : 0.05¢c -
Prnt 1 piece 00% |
Browse... Close

= [m} X

70

A

(4) If the adjustment is not good, readjust the print head according to "E Making print head adjustments" in the Setup
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4-6-9. Position adjustment for the 2 heads of the same color

Check the position of the print head.

(1) From the "Useful Tools", click "HEAD POSITION ADJUSTMENT_COLOR.arx6", "HEAD POSITION

ADJUSTMENT_WHITE.arx6", or "HEAD POSITION ADJUSTMENT_ORGR.arx6e" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the position adjustment has been set correctly.

Job Name HEAD POSITION ADJUS...
Date : 16/04/2021 16:32
Platen Size : 14x16
Resolution : 1200dpi x 1200dpi
Select Ink : Color Ink Only
Color Ink Volume : 10
Double Printing : (]
Color Muttiple Pass Printing :  OFf
Details
Color Ink : 0.13cc
Print 1 piece
Browse... Close

80 E Ty =—

8.0

100% ||

70

(4) If the adjustment is not good, readjust the print head according to "E Making print head adjustments” in the Setup

Manual.
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4-6-10. Platen feed adjustment

Check whether or not the platen feed adjustment is appropriate.
(1) From the "Useful Tools", click "FEEDING PATTERN(1).arx6" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the platen feed adjustment has been set correctly.

- == m] X
Job Name : FEEDING PATTERN(1) 80 il i L A
N A
Date : 14/12/2015 1152 B e
Platen Size : 1416
WS . S—
Resolution : 1200dpi x 1200dpi
Select Ink : Color Ink Only
0
Color Ink Volume : 10
Double Printing : 0

Color Muttiple Pass Prirting :  OFf

Details
20 ;
Color Ink : 0.06cc o =
Dt s 100% i 600 %
Browse... Close

(4) Ifthe adjustment is not good, readjust the print head according to E Making print head adjustments” in the Setup

Manual.
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Creating print data

4-6-11. Check the print position

Alignment of the print position on the white side and color side heads

Check the alignment of the print position on the white side and color side heads.

(1) From the "Useful Tools", click "ALIGN CHK_COLOR.arx6" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the print position on the white side has been aligned with the print position on

the color side correctly.

| - o X
Job Name : ALIGN CHK 20 il
Date : 20/04/2017 08:31 A
Platen Size : 14x16
Resolution - 1200dpi x 1200dpi
Select Ink : Color+White Ink

Highlight : 1

Mask 3 0
Print Time: : x1

Whiteness : 200 %

Use background black color:  Off
Color Muttiple Pass Printing Off

Details ..
80 %
Color Ink : 0.30cc : < >
White Ink : 0.65cc 100% i 600 %
Print : 1 piece
Present Layer 1 WsCMYK ~ []White Data
Background Color _ Change...
Browse... Close

(4) If the adjustment is not good, readjust the print head according to "E Making print head adjustments” in the Setup

Manual.
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Alignment of the print position on the white side and OR/GR side heads
Check the alignment of the print position on the white side and OR/GR side heads.

(1) From the "Useful Tools", click "ALIGN CHK_ORGR.arx6e" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the print position on the white side has been aligned with the print position on

the color side correctly.

Job Name : ALIGN CHK
Date : 20/04/2017 08:31
Platen Size : 14x16
Resolution - 1200dpi x 1200dpi
Select Ink - Color+White Ink
Highlight : 1
Mask 3
Print Time : x1
Whiteness : 200%
Use background black color:  Off
Calor Muttiple Pass Printing Off
Details....
Color Ink : 030cc
White Ink : 065¢cc
Print - 1 piece
Browse... Close

|0

8.0

100 %

70

v

< >

[ | 600 %

Present Layer 1 W-CMYK ~ []White Data

Background Color _ Change...

(4) If the adjustment is not good, readjust the print head according to "E Making print head adjustments” in the Setup

Manual.
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AAWARNING

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a
foreign object inside, it may result in fire or electric shocks or problems with correct operation.

@

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or
problems with correct operation.

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact the
place of purchase or a qualified technician.

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power
cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in
injuries.
Turn off the power when you approach the fan.

> PO PO

A\CAUTION

This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or
vomiting.

When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of
contact with eyes, do not rub but immediately rinse the eyes with water.

Keep the liquids out of the reach of children.

OPpPePpo

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.
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(1) IMPORTANT

hit and damaged.

0 Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
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5-1. Basic printing process flow

What are described below are the basic work flows before the start and after the completion of print process.

Tasks to be
performed before
starting print
operation

Pretreatment for
print medium

Platen
adjustment

Placing print
medium in
position

Sending/Loadin
g Print Data

Removing
printed matter
from platen

Fixation of
ink

Before starting printing, perform check and preparation tasks on the printer.
="5-2. Tasks to be performed before starting print operation >>P.144"

To fixate the white ink onto a T-shirt, apply the pretreatment to it beforehand.
If you are not using white ink, you do not need to pretreat print medium.
="5-3. Pretreating process for print medium >>P.145"

Replace the currently used platen with another one that suits the print medium.
After the platen replacement is completed, adjust the platen's height.
="5-4. Platen adjustment >>P.154"

Put a print medium on the platen.
="5-5. Placing print medium in position >>P.157"

Send or load print data to the printer.
="5-6. Sending/Loading Print Data >>P.160"

Start the print operation.
="5-7. Executing a printing job >>P.169"

Remove the print medium from the platen.
="5-9. Removing printed matter from platen >>P.173"

Fixate the ink onto the print medium.
="5-10. Fixation of ink >>P.174"
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5-2. Tasks to be performed before starting print operation

5-2-1. Confirmation of Water Supply Tank

Before starting the work, check that the water supply tank has water in it.

144



Basic printing procedures

5-3. Pretreating process for print medium

To fixate the white ink onto the surface of fabric of a T-shirt, apply the pretreatment to it beforehand. If you are not using
white ink, you do not need to pretreat print medium.

Workflow of pretreating process

Step ltem Detailed description

Put the pretreatment into a polypropylene container or the like, and dilute it with
1 Dilution of pretreatment P pOYPropy

pure water.
5 Application of diluted By means of a spray, apply the diluted pretreatment onto the print medium.

pretreatment

Fixate the pretreatment by using the heat press to apply heat and pressure onto
3 Fixation of pretreatment X i P i yusing P PPy P !

the print medium.

5-3-1. Provisions for pretreatment

Items to be prepared
o: What you need

With reference to the table below, make what you need available in advance. ) _
A\: Useful items, if any

Items to be prepared

Pretreatment

Pretreatment

Weighing instrument

Spray

Heat press

Peel-off sheet

Silicone foam (of open-cell structure)
Adhesive roller

>I>|D>|ojojo|o|o

e  Pretreatment

It is the white liquid that is needed for pretreating process for printing with white ink. If a print medium is not
coated with this agent, no color development of white ink takes place, and the whiteness becomes insufficient.
Also, no color will be produced from the color inks that are applied onto the white ink. Use a spray to apply the
pretreatment onto a T-shirt and the heat press to fixate it.

<CAUTION>

. Be sure to wear a pair of plastic gloves, a mask and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.

http://sds.brother.cojp/sdsapp/index.html

e  Pretreatment
It refers to distilled water, purified water, etc. which is used to dilute the pretreatment with it.
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Basic printing procedures >

Spray (Commercial product)

This is used to apply the pretreatment onto a T-shirt. Use a spray (preferably of an electrically-operated type)
that can emit fine spray. A spray allows for easy and even coating and reduces non-uniform coating, while it
requires a special space for using it.

In addition to a spray, a pretreatment applicator (commercial product) is available that can apply the
pretreatment onto a T-shirt automatically. As required, make them available for use separately.

<CAUTION>

Fully take care of the air ventilation when you are in operation that generates mist, such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.

http://sds.brother.co jp/sdsapp/index.html

<IMPORTANT>

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Heat press

It must deliver the performance through which the print range of the platen can be covered and 180°C (356°F)
can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be sure to use the heat press, but not
an oven, to smoothen the surface.

Peel-off sheet

When using the heat press, place this sheet on a T-shirt so that neither inks nor pretreatment can be attached to
the press surface of the heat press. As a peel-off sheet, use a silicone-coated paper or a fluororesin sheet.
There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used at the ink
fixation stage. There is a tendency to bring the print result to an almost bright finish if a fluororesin sheet is used
at the ink fixation stage.

Silicone foam (of open-cell structure)
It is the foamed mattress which is made of silicone that resists heat. When fixating the inks or pretreatment by
means of the heat press, use this foam to ventilate steam with ease.

Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.

T-shirt (printing medium)
100%-cotton fabric or polyester blended yarn fabric (cotton 50% or more)

<TIPS>

Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.

Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.
Perform a printing test beforehand. Then, the following phenomena may occur:

- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.

- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.

- Itis likely that a textile may become yellowish in color after the pretreatment is fixated.
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5-3-2. Dilution of pretreatment

Be sure to use the pretreatment after diluting it with pure water.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co,jp/sdsapp/index.html

Dilution ratio

Use within the ratio range of x3 (Pretreatment:Pure water=1:2) (Volume ratio).

Dilution method

<TIPS>

o The figure below is based on the pretreatment (20 kg (44 Ib)). When using the pretreatment (5 kg (11 Ib)), remove the cap and
pour the agent into the container, and dilute it with pure water, referring to step (4) and the subsequent steps. Dilution ratio is the
same.

(1) Unpack the pretreatment container from the shipping carton by cutting off the perforated paper along the perforated

tear-off line to open the carton.

Pretreatment

X0079

(2) Remove the cap, and place the cap in position.

®/ Faucet

KFEE A
Pretreatment = l
\
Cap

147
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Basic printing procedures >

(3) Orient the pour spout of faucet in the position as shown in the figure below.

Faucet

Pretreatment

~~

X0081

(4) Pour the pretreatment with the carton into the container for dilution and dilute the pretreatment with pure water.

<IMPORTANT>
. Dilute the pretreatment three times (pretreatment with pure water at the ratio of 1:2 by volume).

° Close the lid of the container for dilution and stir the content well to make the concentration uniform.

Pure water

Pretreatment

Container for dilution

C

X0082

(5) To provide safekeeping for the pretreatment, close the faucet, place the pretreatment with the faucet part facing

upward, and store the entire carton in a safe place.
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5-3-3. Application of pretreatment

>

In order for the pretreated portions to be printed with inks, apply the pretreatment evenly to a wider area than the print
range.
<CAUTION>

Fully take care of the air ventilation when you are in operation that generates mist, such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

Some T-shirts may leave distinct imprints of the pretreatment after it is fixated. Wash away any imprint of the pretreatment with
water, if any.

Also, some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
When performing the printing for the first time, do that after applying the agent to an unnoticeable area on trial.

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Reference guide for amount of coating of pretreatment

Determine a coating area and amount of coating according to a platen size. When your coating area differs from what
are shown in the table below, calculate the amount of coating based on the area ratio.
<IMPORTANT>

Depending on the type of fabric, the print quality cannot be guaranteed with the amount of coating of pretreatment shown below.
It is therefore necessary to conduct sufficient print tests and adjust the amount of coating.

If the amount of coating of pretreatment is too small, imprints of the pretreatment may become less noticeable after it is fixated,
whereas color reproduction of the white ink and color inks on the white ink will deteriorate.

Meanwhile, if the amount of coating of pretreatment is too large, imprints of the pretreatment may become noticeable, the printed
surface may be cracked or discoloring may occur after washing.

Platen Size Amount of coating of pretreatment
24 x 24 77 g (30z)
18 x 22 53g(202)
16 x 18 399 (102z)
14 x 16 30g(102)
10x 12 16 g (10z)
7x8 89(0.50z)
Letter size/A4-size 15g(10z)
Pocket size (3.9 in. x 3.9in. (10 cm x 10 cm)) 3g(0.50z)
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For coating with a pretreatment applicator (commercial product: preferably of an electrically-operated type)

(1) Fill the pretreatment applicator with the diluted pretreatment.

<TIPS>

° Please use a pretreatment applicator (preferably of an electrically-operated type) that can emit fine spray.

(2) Setthe T-shirt on the pretreatment applicator, and apply the pretreatment evenly onto the print surface.

Pretreatment applicator

Smooth out the wrinkles

X1039
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For coating with a spray (commercial product: preferably of an electrically-operated type)

(1) Fill the spray with the diluted pretreatment.
<TIPS>
° Please use a spray (preferably of an electrically-operated type) that can emit fine spray.

Pretreatment

X0083

(2) Put a T-shirt flatly on a flat surface or lean it back against wall, and apply the pretreatment evenly onto it with a

spray.

<CAUTION>

. Fully take care of the air ventilation when you are in operation that generates mist, such as spray application.

. Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.cojp/sdsapp/index.html

<IMPORTANT>

. If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.

Otherwise, it may cause failure of print heads.

<TIPS>

. Note that pretreatment will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate in the T-shirt.
Remove the intermediate plate from the T-shirt before the pressing stage.

. When you are still unaccustomed to the spray coating, perform it while measuring the amount of coating by means of a

weighing instrument.

Spray

a9y \ T d_

> Tl | o ]l > b ]

N

T-shirt X0084
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5-34. Fixation of pretreatment

<CAUTION>

. As the operation will generate mist, fully take care of the air ventilation.

. Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<TIPS>

. Because the pretreatment will not work best if it is dried through oven-based drying or air drying, be sure to use the heat press.

As the oven does not bind fuzziness, the agent may be applied unevenly on white print.

. When you put a T-shirt on the heat press, set it so as to flatten the T-shirt's surface, place a peel-off sheet on the entire press
area, and apply pressure.

. Note that any area in which the pretreatment is fixated may cause its effect to deteriorate or could cause the agent to be coated
there unevenly if such area gets wet once.

. Do not touch the treated area with your hand after the pretreatment is fixated.

. After the pretreatment is fixated, do not touch or place the T-shirts on top of each other.

. Avoid leaving the pretreatment as it is in any highly humid areas.

. If the agent is left unchecked for a long time, use the heat press to apply pressure to a T-shirt immediately before the printing in
order to dry it well.

Guidelines on fixation conditions of pretreatment

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat

press. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.

<TIPS>

. Prior to and during a fixation process, check the heat press's temperature. If the fixation is performed continuously, the heat
press's temperature will decrease, resulting in improper fixation of the pretreatment. In this case, the whiteness cannot be
reproduced because the white ink soaks into the fabric of a T-shirt.

. Such a pressure is required that is adequate enough to flatten the surface. As the fixation conditions differ by heat press, check
the ink fixation result in advance and adjust the pressure.

. If it is not dry enough after pressing for 35 seconds, extend the time while checking the dried condition of the pretreatment.

. The following values should be regarded as guidelines only, for the optimum fixation conditions depend on the amount of coating
of pretreatment.

Temperature Time
180°C (356°F) 35 seconds
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(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment

properly.
<TIPS>
. Water droplets are generated around the heat press to evaporate water content of the pretreatment by the heat of heat

press. Keep your working space clean so that the surface to be coated with the agent will not get wet.

. A peel-off sheet should be used if needed, depending on the heat press you use.

Heat press

Peel-off sheet

X0096

X0097
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5-4. Platen adjustment

Replace the currently used platen with another one that suits the medium to be printed.

<CAUTION>

. Hold the platen with both hands and be careful not to drop the platen at the time of platen replacement.

<TIPS>

. In cases where such an optionally sized platen as 10X12 platen is used, ascertain that a proper "Platen size" has been selected
in the printer driver's setting menu.
- For print data using white ink, ="4-4-2. Select the platen size >>P.100"
- For print data using color ink and black ink only, ="4-5-2. Select the platen size >>P.119"

5-4-1. Replacing the currently used platen with another one

(1) On the operation panel, press , and move the platen toward the front of the printer.
_

Platen

X1038

(2) Loosen the platen fixing handle by rotating it one to three turns.

Platen fixing handle

154



Basic printing procedures

(3) Remove the platen moving it straight upwards by holding both ends of it.

Platen
Platen
(5) Tighten the platen fixing handle.
<TIPS>
. Place the platen fixing handle sideways so that the platen fixing handle will not come in contact when setting the platen or
T-shirt.

If the platen fixing handle is in portrait orientation, pull the platen fixing handle sideways and turn it in landscape orientation.

Platen fixing handle
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5-4-2. Platen height adjustment

Select a proper position of the platen corresponding to the print medium.
(1) Select [Platen Height Adjustment] from the menu, and select an appropriate position from [Position A] to [Position

H].

<IMPORTANT>

o Do not handle the platen while printing. Injury may result if your hand gets caught between the platen or T-shirt tray and a door or
cover.

. Be careful not to put your hands in the clearance of the cover of the lifting up/down mechanism. Doing so may cause injury.
Otherwise, the operator may get injured.

<TIPS>

. There are custom positions that can be set to any height.
You can set the height from the menu by selecting [Printer Setting] > [Platen Setting] > [Height User Setting]. ="7-10-1. User
settings for height >>P.247"

Printer Setting

Platen Height Adjustment
Head Cleaning

Test Print

Ink Refill

Print Data Load

Platen Height Adjustment Platen Height Adjustment
Position A Position F

Position B Position G

Position C Position H

Position D User setting 1

Position E User setting 2
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>

5-5. Placing print medium in position

In order to provide an optimum printing image quality when a print medium is placed in position, you need to adjust the
platen's height in accordance with the thickness of the T-shirt or other print medium.
<CAUTION>

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen moves forward while
operating and it can strike/damage anything set in its path of movement.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and the covers, it may be
injured.

<IMPORTANT>

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

<TIPS>

™

2

Adjust the height of the platen corresponding to the print medium before using it. As a rough indication, adjust the height so that it
is lowered by one step from the limit height detected by the obstacle sensor, and check that the platen is not detected by the
Sensor.

In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer, which may result in
staining of the printing surface, blurring of the printed image, and malfunction of the sensor and the main unit.

Use Uni-Directional Printing in the case where the platen's height needs to be lowered to avoid a hemmed (edge) and seam.
="7-1. Setting the print direction >>P.242"

If the platen has not been moved forward, press g on the operation panel.

Adjust the platen's height.

<TIPS>

° Set the platen height to [Position A] or in the neighborhood for a T-shirt, and to [Position C] or in the neighborhood for thick
material, such as a sweatshirt.

3 If the platen's height is lowered too much, the printing quality may deteriorate, the main unit may be soiled with ink mist and
SO on.
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Put a T-shirt onto the platen, with its printing side facing upward.
<TIPS>

For the position alignment of white or pale-colored T-shirts, a grid to be printed out on the platen sheet is available from [All
Programs] in the Start menu by selecting "Brother GTX-6 Extra Colors ORGR Tools" > "Useful Tools".
="4-6-4. Print a grid pattern on the platen sheet >>P.131"

Platen

X1040

Smooth down the creases in the T-shirt and remove lint and dust from it.
<TIPS>

Seams on a hemmed (edge), neck portion, armhole, tucks and sleeves or the like are easily detected by the obstacle
sensor.

In particular, both ends of the T-shirt tend to be raised easily during the printing operation if not flattened properly and
detected by the obstacle sensor.

Touching on the fixated pretreated surface should be avoided during the work.

Do not pull the T-shirt with the pretreatment applied. Instead, flatten it in such a way that it will fit onto the platen surface
well.

When the surface of the T-shirt does not remain flattened properly, the obstacle sensor detects it.

In the event that any T-shirt is placed on the platen by pulling it outward forcibly, there are instances in which ejection areas
of the white and color inks are misaligned and the white ink extends off its specified printing area. In particular, be careful
not to stretch a thin T-shirt outward on the platen.

Smooth out the wrinkles _—

T-shirt

X1041

158



Basic printing procedures

(5) The T-shirt should be placed on the T-shirt tray, trying not to draw the excessive parts like sleeves and hems into

the printer.

T-shirt

T-shirt tray

X1042

(6) On the operation panel, press , and move the platen toward the rear of the printer.
-

Try moving the platen, and check on the gap between the T-shirt surface and the obstacle sensor over the entire print area.

<TIPS>

. If this gap is too wide, adjust the platen height.

. Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and check that the
platen is not detected by the sensor.

3 If the platen's height is too high, a print medium will strike against the print head during the printing process, which in turn

results in ink stains or malfunction.

(7) On the operation panel, press , and move the platen toward the front of the printer.
.

<TIPS>
. Repeat the height adjustment until the platen will be positioned at a proper height.
3 After your desired height is determined, start the printing operation. ="5-7. Executing a printing job >>P.169"

T-shirt

T-shirt tray

X1043

159



Basic printing procedures

>

5-6. Sending/Loading Print Data

Print data can be loaded into the printer in the following ways:
Receive the print data from the PC connected with the LAN cable.

Load the print data from the USB flash memory.

For details, please refer to the chapters described later.

5-6-1.

Sending print data from ARX6E/ARXG file preview

™

(2

Open an ARX6E/ARXG file.
<TIPS>

. Double click on the ARX6E/ARXG file, or select [All Programs] in the Start menu > "Brother GTX-6 Extra Colors ORGR
Tools" > "GTX-6 Extra Colors ORGR File Viewer", to select and open the ARX6E/ARXG file. You can also load ARXP and

ARX4 files.

The file's printing conditions and preview window will be displayed.

<TIPS>

. If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, the preview window will be displayed

against a "Black" background or a "Transparent color" background which has been specified in the Advanced settings.

. If you have selected [Color Ink Only] in the Select Ink operation, the preview window will be displayed against a "White"

background.

. When you press the Details button, those items that have been specified in the Advanced setting window of the printer

driver appear.

o  When [Color+White Ink] or [White Ink Only] is selected

s’

Job Name IMG_1404 JPG

Date 24/11/2022 1448

Platen Size 14x16

Resolution 1200dpi x 1200dpi

SelectInk: Color+White Ink

Exira Colors ORGR On

Highlight 5
Mask 3
Print Time x1

400 %
Off
off

Whiteness
Use background black color

Color Multiple Pass Printing

Details...

Color Ink 032¢cc

White Ink 192¢cc

Print 1piece

Sendto Printer |

Browse Close

)

80

< >

100% 1

1 W-CMYKOG | []White Data

Present Layer

Background Color Change.
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When [Color Ink Only] is selected

[Details]

Basic printing procedures

o X
-70 70
Job Name : IMG_1404 JPG 80
: ~
Date 24/11/2022 15:00
Platen Size 14x16
Resolution : 1200dpi x 1200dpi
SelectInk - Color Ink Only
Extra Colors ORGR : On 0
Color Ink Volume 10
Double Printing 1
Color Multiple Pass Printing off
Details...
&0 = 2
ColorInk : 034cc = E
Print 1 piece 100% 1 %
I Send to Printer I
Browse... Close
o 94 Details x
Job Nams { | 1tem  vale A
Job Name : IMG_1404.JPG =
Bt | Date : 24/11/2022 15:00
| Platen Seze : 14x16
Platen Size © | Platen Height : &
. | Mode :
Rasokibon; | Calor: Vibrant
| Resolution : 1200dpi x 1200dpi
Selectink | Select Ink : Color Ink Only
Extra Colors ORGR * | Extra Colors ORGR : On
Color Ink Volume : 10
ColorInk Volume [ Double Printing : 1
| Color Multiple Pass Printing : Off
Double Printing - |
Cotor Mlivls Pass Piiniea - |Saturamn: 5
olor Mutiple Pass Printing : | Brightness : 5
P ! Contrast : 5
e | Cyan balance : 0
I Magenta balance : 0 o
ColorInk : Yelow balance : 0 B
Black balance : 0
| £00 %
Print | Green Balance : 0 .
! Orange Balance : 0
] Send to Printer ! Uni-Directional Printing : off
Browse... Close i Color Ink : 0.34 cc
! Print : 1 piece
Close
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(3) If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, you can change the
background color of the preview window and preview the print image. Select [Change...] > [Define Custom Colors],

and enter RGB value.
<TIPS>

. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.

o - o x
Color X
Job Name MG_1404 JPG " : iy
Date 247112022 1448 Basic colors:
Pratn Sics yaxte HEENNEN N
Resaluon 12000511 ol H EENFNEEN
Selectink ColorW1 b e colors: HEEEEEEREN
Exra Colors ORGR on | -
s > WA EEEEEEEN
S| EEEEEEEN
Print Time x1 el L LR ..--'_.I_
Whitenass wo | DN NN
Use backgroundblack color: ~ OF EEEEEEEN e e
—t ustol Ol
Color Mulbple Pass Prining of !E. EEETE
o — | e
Color Ink. e (T T T T T T C I_l_'_[_l_l_l_'_ SE‘D
P || e Define Custom Colors > ColatSolid  ,m:[0 |
Print 1piace |
T | perecumomCoon>  fly </ [Jwhite pa 0K Cancel Addto Custom Colors
Send 1o Printer |
0K Cancel
Browse... Close - e
"Example: Preview window for printing an image on a brown (R=128, G=64, B=64) T-shirt"
£ = [m] X
70 0 70
Job Name : IMG_1404.JPG £0
Date 24/11/2022 14:48 :
Platen Size 14x16
Resolution 1200dpi x 1200dpi
SelectInk - Color+White Ink
Extra Colors ORGR : On
Highlight : 5
Mask 3 d
Print Time x1
Whiteness 400 %
Use background black color : Off
Color Multiple Pass Printing off
Details..
Color Ink - 032cc 80 —
< >
White Ink. 192cc
Print 1piece o B o0l 2
Present Layer 1 W-CMYKOG  ~| []White Data
Send to Printer
Browse. Close
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(4) For the print data that requires multiple cycles of platen reciprocate movement, print data of each layer can be
verified separately by selecting the desired layer to be displayed. From the [Present Layer], select a layer that you

want to bring into the view.

<TIPS>

. In the layer that is shown as [Total], the preview window of the final print result is displayed.

. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.

= = O et

Job Name IMG_1404 JPG o ? i
Date 24/11/2022 1448 b
Platen Size 14x16
Resolution 1200dpi x 1200dpi
SelectInk: Color+White Ink
Extra Colors ORGR On

Highlight 5

Mask 3 A

Print Time x1

Whiteness 400 %
Use background black color off
Color Multiple Pass Printing off

Details.
Colorink 032cc 80
White Ink 192¢cc
b o 100% 1 600 %
[ Send o Printer |
Background Color Change.
Browse. Close

(5) Check the printing conditions and preview window, and click on [Send to Printer].
Then, the ARXGE/ARXG file is sent to the printer.
<TIPS>
. Make sure that the PC and printer are connected via a LAN cable.
. If two or more GTX-6 Extra Colors ORGR printer drivers have been installed on your PC, select one of them as the data
transmission destination and click [OK].

w - o X
7.0 0 70
Job Name IMG_1404 JPG 80
Date 24/11/2022 14:48 )
Platen Size 14x16
Resolution 1200dpi x 1200dpi
SelectInk - Color+White Ink
Extra Colors ORGR On
Highlight 5
Mask 3 0
Print Time x1
Whiteness 400 %
Use background black color off
Color Multiple Pass Printing off
Details...
Colornk - 032cc 80
< >
White Ink 192¢cc i
o o
Print 1piece 100 o
Present Layer 1 W+CMYKOG | []White Data
[ Send to Printer I
w—— |
Browse Close
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5-6-2. Sending print data from applications

Basic printing procedures >

CorelDRAW

(1) Inthe menu bar, select [File] > [Print].

(2) Open the [General] tab and select "Brother GTX-6 Extra Colors ORGR" from [Printer].

<TIPS>

o The print data will be sent to the printer if the specified [Printer] is set to "Brother GTX-6 Extra Colors ORGR".
If the specified [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an

ARXBE/ARXG file.

(3) Open the [Color] tab, and make the following settings:

e  Place a checkmark in the [Document color] checkbox.
e  [Color conversions]: "Brother GTX-6 Extra Colors ORGR" or "Brother GTX-6 Extra Colors ORGR FileOutput"
e  [Color Profile]: [sSRGB IEC61966-2.1]

e [Rendering intent]: [Relative colorimetric]

Print

General Color

Color:

Settings:

Color conversions:

Color profile:

Rendering intent:

? Print Preview

Composite Layout Prepress 1 Issue

® Composite
Separations

® Document color
Color proof

Brother GTX-6 Extra Colors ORGR FileOutput

(Document) sRGB IEC61966-2.1

« Preserve pure black

Relative colorimetric

4

Print

The color settings and preview available in this dialog box are set for the Windows Graphic
device printer that you selected on the General tab.

Cancel

Apply

(4) On [Preferences], set up the printer driver and send the print data by clicking [OK] in the [Print] dialog box.

<TIPS>
. How to set the printer driver

- For print data using white ink, ="4-4-1. Setting up the printer driver >> P.98"

- For print data using color ink and black ink only, ="4-5-1. Setting up the printer driver >> P.117"

. Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start

the printing operation.
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Adobe Photoshop

™

)

(3)

(4)

In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-6 Extra Colors ORGR" or

"Brother GTX-6 Extra Colors ORGR FileOutput", the layout is set to the platen size.

Make the settings as follows:
e  [Color Handling]: [Printer Manages Colors]
o  [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings

Printer Setup
Printer:  Brother GTX-6 Extra Colors ORGR FileO...

Print Settings...

Copies: 1

Layout: [y Bl

Color Management

Remember to enable the printer’s color
management in the print settings dialog box.

Nacument Profile: <RGR TFCA1066- 1
Color Handling:  Printer Manages Colors
pninter Profile:

Normal Printina

Rendering Intent:  Relative Colorimetric

From [Printer], select "Brother GTX-6 Extra Colors ORGR".

<TIPS>

. If [Printer] is set to "Brother GTX-6 Extra Colors ORGR", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an ARX6E/ARXG file.

In the [Print Settings], set up the printer driver, and send the print data by clicking [Print].

<TIPS>
. How to set the printer driver

- For print data using white ink, ="4-4-1. Setting up the printer driver >> P.98"
- For print data using color ink and black ink only, =="4-5-1. Setting up the printer driver >> P.117"
. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to

start the printing operation.

165



Basic printing procedures

Adobe lllustrator

(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
e  [Document Profile]: [sSRGB IEC61966-2.1]
e  [Color Handling]: [Let lllustrator determine colors]
o  [Printer Profile]: [sRGB IEC61966-2.1]
¢  [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX-6 Extra Colors ORGR FileOutput

General Color Management

Marks and Bleed Print Method
Rl Document Profile: U.S. Web Coated (SWOP) v2
Graphics

Color Handling: Let Illustrator determine colors

Color Management

Printer Profile: sRGB IEC61966-2.1

Rendering Intent: Relative Colorimetric

Description

Document: 14 in x 16 in
Media: 14 in x 16 in

(3) From [Printer], select "Brother GTX-6 Extra Colors ORGR".
<TIPS>
. If [Printer] is set to "Brother GTX-6 Extra Colors ORGR", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-6 Extra Colors ORGR FileOutput", the print data will be saved as an ARXGE/ARXG file.

(4) Inthe [Advanced], set up the printer driver, and send the print data by clicking [Print].
<TIPS>
. How to set the printer driver
- For print data using white ink, ="4-4-1. Setting up the printer driver >> P.98"
- For print data using color ink and black ink only, ="4-5-1. Setting up the printer driver >> P.117"
. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to
start the printing operation.
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5-6-3. Loading print data (ARX6E/ARXG6 file) from USB flash memory

(1) Inserta USB flash memory into the insertion slot in front of the operation panel of the printer.

<IMPORTANT>

. Do not apply undue force to the USB flash memory when you insert it into the slot. Otherwise, it could be damaged.

<TIPS>

. Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You cannot use a
USB flash memory with security functions such as password lock function or beyond 32 GB.

° Note that the data which can be loaded from the USB flash memory is only the data in ARX6E, ARX6, ARXP, or ARX4
format.

USB flash memory
insertion slot

(2) From the menu, select [Print Data Load], and press @ .

<TIPS>
. The information on file is shown on the liquid crystal panel.

Menu

Platen Height Adjustment
Head Cleaning

Test Print

Ink Refill

Print Data Load

(3) Select a filename to be printed out, and press @ .
<TIPS>

. Selecting I:I will display the file stored in I:I

. Folders in the USB flash memory are shown down to the 3rd layer. Folders created in the 4th layer or below are not

displayed.
o< Select data file o< Select data file
O Sample Foldert <4 Sample Folder1
; O Sample Folder2 9 (O Sample Folder2
— » Sample Datal.arx6 — Sample Datal.arx6
3 Sample Data2.arx6 2 Sample Data2.arx6
Sample Data3.arx6 Sample Data3.arx6
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(4) Check the printimage displayed in the preview window, and press @ .

<IMPORTANT>

. Never touch the USB flash memory when the print button is blinking. Otherwise, any already-saved data may be corrupted.
<TIPS>

3 Depending on data size, it may take several minutes before the loading process is completed.

. If any files of USB flash memory cannot be read out. =="8-1. Troubleshooting instructions>> P.264"

. If a folder contains more than one print data item, use the AV buttons to switch the preview window.

Sample Data

# 14 x 16 inch
® 545 cc

Data Load OK

The print data loading will be completed when the print button stops blinking and remains lit, while the electric chime sounds.
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5-7. Executing a printing job

5-7-1. Executing a print job once for a single print medium

Basic printing procedures >

™

)

@)

Receiving a print data file.

The print button blinks during reception of data. When the data reception is completed, an audible alarm is activated and the print
button illuminates.

As there are two types of audible alarms, make sure the mounted platen matches the platen size of the print data.

<TIPS>

. When data of the same platen size as the previous one was received: A notice sound of "ping-pong" is output.

. When data of a different platen size from the previous one was received: A notice sound of "ping-pong pan-pong" is output.

Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the

two print buttons at the same time to start printing.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.
<TIPS>
. If the print buttons are pressed when the platen has not moved toward the front, no print job will be started.

. Pressing @ causes the printing to be canceled.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed. ="7-11. Print Operation Settings Under Low Temperature
>>P.249"

. High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope. ="10-1. Apparatus >>P.308"
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5-7-2. Executing a print job several times for multiple print media

You can keep the identical print data and execute a print job several times for multiple print media.
<TIPS>

™

(2

@)

When the power is turned off, the retained print data is erased.
Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the

two print buttons at the same time to start printing.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.
<TIPS>
. If the print buttons are pressed when the platen has not moved toward the front, no print job will be started.

. Pressing @ causes the printing to be canceled.

. The number of print media of which printing is completed is shown on the liquid crystal panel.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed. ="7-11. Print Operation Settings Under Low Temperature
>>P.249"

. High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope. ="10-1. Apparatus >>P.308"

Replace the platen's printed medium (T-shirt) with the next one and repeat the procedure until the desired number

of print jobs are completed.
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5-7-3. Performing the printing from receiving history

You can print out such print data that you have received before.
<TIPS>

™

@)

@)

The print data that can be retained are max. 100 pieces of them and 800 MB in total capacity, wherein each print data will be
erased in the order from the oldest to the latest.

When the power is turned off, the retained print data is erased.

From the menu, select a print data you want to print out in the [Receiving History].
<TIPS>
. Each of the pieces of print data is displayed in the order in which they are received from the newest to the oldest ones.

Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the

two print buttons at the same time to start printing.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.
<TIPS>
. If the print buttons are pressed when the platen has not moved toward the front, no print job will be started.

. Pressing @ causes the printing to be canceled.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed. ="7-11. Print Operation Settings Under Low Temperature
>>P.249"

3 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope. ="10-1. Apparatus >>P.308"
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5-8. Scheduling a print

Even if the printer is not in the standby state, this function allows you to schedule printing by pressing the Print button in
advance so that the printer will start printing as soon as it becomes available.

5-8-1. When you can schedule printing

You can schedule printing by pressing the Print button in advance while the print data is being received and during the
post-print processing.

This is useful if the printer performs the post processing for the previous print job after you remove the printed T-shirt and
set a new T-shirt to the platen.

<TIPS>

. Be sure to remove the printed T-shirt from the platen and set the next T-shirt to the platen before you press the Print button.

. You cannot press the Print button in advance if the printer is being operated from the menu or an error has occurred.

When you can schedule printing Description
The printer is receiving print data While the printer is receiving print data sent via the LAN cable
When a print job finishes and the platen is unloaded and while the printer is
wiping, capping, cleaning the wiper, or performing an auto purge after a print
job

The printer is post-processing after a
print

5-8-2. When a scheduled print begins

A scheduled print begins when each of the following conditions is true.

When you schedule printing When the print begins
The printer is receiving print data When the printer has completely received print data
The printer is post-processing after a | When the printer has finished all the processes such as wiping, capping,
print cleaning the wiper, or an auto purge after a print job
<TIPS>

. The Print button flashes fast during the period between when you schedule printing and when the printing begins.

5-8-3. When printing does not begin

A scheduled printing does not begin when each of the following conditions is true.
e Ifan error occurs when printing should begin. (For example, this is true if the ink is depleted in the previous print
job.)
e [fthe data to print is missing from the printer when printing should begin.

5-8-4. Canceling scheduled printing

You can cancel scheduled printing by pressing the Cancel button during the period between when you schedule printing
and when printing begins.
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5-9. Removing printed matter from platen

(1) Hold the shoulder portions of print medium with your hand, and pull it out slowly in the forward direction indicated.
<IMPORTANT>
. Because the printed surface is still wet with ink, avoid touching it.
. If any ink is attached to your hands, wash your hands with soap and water.
. Those inks that are attached to fabrics cannot be cleaned up, please handle the inks with utmost care.

<TIPS>
. The printed ink is not fixated at this point - therefore, handle the T-shirt with care to avoid the printed surface touching with

other objects.

T-shirt

X1044
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5-10. Fixation of ink

For fixation of ink, use the heat press or oven.
e  Heatpress
It is useful because you can control its temperature and operating time with ease.

e Oven
e Ifthe number of articles to be printed is high, it will improve the operational efficiency.
<CAUTION>

. Please use the heat press and oven in a well-ventilated area. If your working area is not well ventilated, wear a protective mask.

<TIPS>

. If the inks are fixated insufficiently, discoloring may occur due to washing and friction.

° Keep the fixation surface of heat press and peel-off sheet clean.
Otherwise, the printing surface may be soiled with stains from the peel-off sheet.

. If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer may occur.
When a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer may occur in the
same fashion.
When a color transfer takes place, wipe the color-transferred area and clean off dirt with a soft and clean cloth or a toothbrush
that is moistened with a small amount of mild detergent for home use and/or alcohol.

. Component of pretreatment remains on the T-shirt on which the ink was fixated after applying pretreatment. For this reason, it is
advisable to wash such T-shirts with water before wearing them.

Guidelines on fixation conditions of ink

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat
press or oven. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.
<TIPS>
. Because optimum conditions vary depending on the type of your heat press or oven, use the fixation conditions as a reference
guide. Be sure to adjust the conditions while checking on the temperature and ink fixation results beforehand.
. Because some print media easily get scorched, please carefully check and see how the surface actually looks like.
In particular, the print media onto which the pretreatment has been applied will easily get scorched.
. When using the heat press, adjust the pressure while checking the ink fixation result.
. If it is not dry enough after processing for the period of the guideline, extend the time while checking the dried condition of the ink.

Device Temperature Time
Heat press 180°C (356°F) 35 seconds
Oven Surface temperature: 160°C (320°F)™ 3 min. and 30 sec. to 5 min.

": Because a T-shirt may be discolored if this temperature increases too high, great care should be taken to exercise
temperature control.
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Ink fixation by means of heat press

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the ink properly.

<TIPS>
. For the guidelines on fixation conditions of ink, ="5-10. Fixation of ink >>P.174"

3 For details, refer to the instruction manual of your heat press.
. There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used as a peel-off sheet or
to an almost bright finish if a fluororesin sheet is used as the same at the ink fixation stage. Selectively use either of them

according to your desired finish.

Z008p))

I

-‘

G

Heat press
0)

Peel-off sheet

Silicone foam \/

T-shirt
X0115
Ink fixation by means of conveyor-type oven
(4) Fixate inks onto a T-shirt by means of the conveyor-type oven.
<TIPS>
. For the guidelines on fixation conditions of ink, ="5-10. Fixation of ink >>P.174"
3 For the conveyor-type oven, identify the oven's internal temperature, and check up on actual ink fixation resuilt.
3 For details, refer to the instruction manual of your conveyor-type oven.
T-shirt Conv?r-type oven
l
C I
@-------------------------@
out in
X0116
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H Precautions to keep good printing quality/use printer over the long term

A DANGER

A Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.

A.CAUTION

é Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your
fingers.

® Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or
vomiting.
When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of
contact with eyes, do not rub but immediately rinse the eyes with water.
Keep the liquids out of the reach of children.

0 Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.
It can cause inflammation.
Do not drink or eat the grease. It may cause diarrhea or vomiting.
Keep the liquids out of the reach of children.

0 When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

0 When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(1)IMPORTANT

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.

e
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6-1. Tasks to be performed regularly

6-1-1. Refilling color ink

If l is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.
o Take care not to lose the IC stick that comes standard with the ink bottle.

o Once you have refilled ink, you cannot print until you insert the IC stick.

& Error
Ink refill: Yellow

(1) From the menu, select [Ink refill] and press @ .
(2) From [Black], [Yellow], [Cyan], [Magenta], [Green], and [Orange], select the color with no ink and press @ .

(3) Insert the IC stick of the same color as the refilled ink and press @ .

<TIPS>
. An error appears if you insert an IC stick of a different color from the depleted ink.

IC stick insertion slot
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Precautions to keep good printing quality/use printer over the long term >
(4) Open the ink bottle and attach the supplied faucet.

<IMPORTANT>
. Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out.
. Do not use a non-standard funnel. Use the provided faucet. Otherwise, ink may be contaminated or deteriorated, possibly

damaging the printer.

Faucet

Lid

4;:\5'8/

TN

=

Ink bottle

X1036
(5) Open the ink tank lid and refill ink up to above graduation mark 4.
<IMPORTANT>
e  Take care not to exceed the graduation mark in 6.
-

Ink tank |

(6) Press @ on the operation panel. Close the ink tank lid and press @ again.

<IMPORTANT>
. Be sure to close the ink tank lid once you have refilled the ink.

(7) Remove the IC stick following the instructions on screen and press @ .

<NOTE>
. Store the IC stick by attaching it to the handle of the ink bottle.
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
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6-1-2. Refilling white ink

If l is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink.

Agitate the white ink sufficiently to remove sediments before refilling it. Agitate the ink beforehand because it takes time.

<IMPORTANT>

. Do not use ink not agitated sufficiently because doing so may deteriorate the durability of the printed matter or cause the head
not to eject ink-jet droplets. In cases where the printer malfunctions due to the use of ink not agitated sufficiently, you may be
liable for the cost of repairs even during the guarantee period.

. Agitate ink by shaking the ink bottle.

. Do not insert a bar or propeller into the ink bottle when agitating the ink because doing so causes foreign matter inclusion,
possibly resulting in printer failure.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.
o Take care not to lose the IC stick that comes standard with the ink bottle.

o Once you have refilled ink, you cannot print until you insert the IC stick.

Agitating white ink with an agitator

<IMPORTANT>
. Be sure to install an agitator.
To choose from many types of agitators available, consult your dealer.
<TIPS>
. When agitating the white ink, remove the IC stick from the refill ink bottle to prevent it from falling off.

(1) Set the ink bottle to the agitator.
<IMPORTANT>
. Securely fasten the ink bottle by means of a jig to prevent it from falling during agitation.

(2) Perform agitation with reference to the manual of your agitator.
<TIPS>
. The recommended agitation time differs depending on the ink stationary period and agitator performance.
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Precautions to keep good printing quality/use printer over the long term >

(3) Hold the ink bottle upside down and apply lighting to its side face to visually check sediments.

A dark shadow is seen on the bottom if sediments are remaining, so repeat steps (1) and (2) until such a dark

shadow disappears.
<TIPS>

. Use bright lighting and darken the surrounding area to make the sediments more visible.

White ink \ [ ﬁ‘=‘

N\
e/

Sediments

N\

Upside
down

g Apply lighting
sideways
N
: J White ink
~ k X1037

Agitated state
With sediments Without sediments
| 3 i
» =9
Sediments Bubbles X1045
<TIPS>

. The shadows of bubbles may be confusing with sediments after the white ink agitation, so leave the bottle until bubbles

disappear before checking for sediments.

To distinguish between bubbles and sediments, lightly shake the ink bottle. The shadows of bubbles move, but the shadows of

sediments do not move.
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How to refill white ink

& Error
Ink refill: White

(1) From the menu, select [Ink refill] and press @ .

(2) Select [White] and press @

(3) Insert the white IC stick and press @ .

<TIPS>
. An error appears if you insert an IC stick of a different color from the depleted ink.

IC stick insertion slot
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Precautions to keep good printing quality/use printer over the long term >
(4) Open the ink bottle and attach the supplied faucet.

<IMPORTANT>
. Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out.
. Do not use a non-standard funnel. Use the provided faucet. Otherwise, ink may be contaminated or deteriorated, possibly

damaging the printer.

Faucet

Lid

42\@8/

TN

=

Ink bottle

X1036
(5) Open the ink tank lid and refill ink up to above graduation mark 6.
<IMPORTANT>
e  Take care not to exceed the graduation mark in 6.
N
6
5
4
3
2
1
J
X1106

(6) Press @ on the operation panel. Close the ink tank lid and press @ again.

<IMPORTANT>
. Be sure to close the ink tank lid once you have refilled the ink.

(7) Remove the IC stick following the instructions on screen and press @ .

<NOTE>
. Store the IC stick by attaching it to the handle of the ink bottle.
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
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Precautions to keep good printing quality/use printer over the long term >

6-1-3. Refilling the cleaning solution

If l is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink.

<CAUTION>
. Be sure to wear a pair of plastic gloves and protective glasses while working.

<TIPS>
. Also check to see if the cleaning solution is kept at a proper liquid level in the cleaning solution tank and refill the tank with the

solution if its amount is insufficient.

€ Error

Refilling the cleaning solution

(1) From the menu, select [Refill Ink] and press @ .
(2) Select [Cleaning solution] and press @ .

(3) Open the cleaning solution bottle and attach the supplied faucet.

<IMPORTANT>
. Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out.
. Do not use a non-standard funnel. Use the provided faucet. Otherwise, the cleaning solution may be contaminated or

deteriorated, possibly damaging the printer.

Faucet

Lid

4;:\@@/

S

&=

Cleaning solution bottle

X1036
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Precautions to keep good printing quality/use printer over the long term

(4) Open the cleaning solution tank lid and fill the tank with the cleaning solution up to above graduation mark 6.
<IMPORTANT>
e  Take care not to exceed graduation mark 6.

Cleaning solution tank

(5) Press @ on the operation panel. Close the cleaning solution tank lid and press @ again.

<IMPORTANT>
e  Afterfilling the cleaning solution, be sure to close the cleaning solution tank lid.
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6-1-4. Correcting the remaining ink level

When a warning message appears in the warning message window, correct the remaining ink level.

@ WARNING

Tank correction timing

(6) From the menu, select [Maintenance] > [Correct tank volume sensor], and press @ .

(7) Press A /¥ .Enterthe scale for the ink level and press @ .

Correct tank volume sensor
oBlack

4

Enter the liquid level
Then press OK

<TIPS>

Check and correct the color scale displayed on the panel.
If the level is between the scales, make a correction based on the lower value.

<CAUTION>

If you enter an incorrect value, the remaining level may not be correctly recognized and the printer may be damaged.
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Precautions to keep good printing quality/use printer over the long term

6-1-5. Replacement of maintenance parts

When a warning message appears on the operation panel screen, replace each maintenance part.

O WARNING

Replace wiper
Replace cap foam
Replace flushing foam
Replace carriage foam

<TIPS>
. For the way to perform replacement, refer to the respective maintenance parts section.
=7"6-1-6. Replacing the wiper >>P.187"
="6-1-7. Replacing the cap chip and cap foam >>P.189"
=7"6-1-8. Replacing the flushing foam >>P.192"
="6-1-9. Replacing the carriage foam >>P.195"
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Precautions to keep good printing quality/use printer over the long term >

6-1-6. Replacing the wiper

When a warning message appears on the operation panel screen, conduct replacement work.
<TIPS>

™
)

()

Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the
wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence.

Have the supplied gloves and wiper ready.
From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and

press @ :

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

. Please complete the task within 25 minutes, in order to prevent the print heads from drying up.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Unlock the upper left-hand-side cover and top cover and open them.
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Precautions to keep good printing quality/use printer over the long term >

(5)

(6)

Hold the latch of the new wiper on the left-hand side and insert the new wiper into the maintenance unit from the

right-hand side.

<IMPORTANT>

. Replace the wipers of the six locations at the same time.

. Make sure that each wiper is installed in the correct direction.

. Push the wiper in and make sure that the left and right protrusions are firmly fitted.

‘ Firmly fit them.

Close the upper left-hand-side cover and top cover.

<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.

° Do not reuse the replaced wipers.
<TIPS>
3 Then, the head cleaning will be performed to prevent any ink from drying up.
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Precautions to keep good printing quality/use printer over the long term >

6-1-7. Replacing the cap chip and cap foam

When a warning message appears on the operation panel screen, conduct replacement work.
<TIPS>

™
2

@)

Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the
wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence.

When you replace the cap chip and cap foam, check the staining state inside the printer. If parts inside the printer are stained,
perform cleaning. ="6-2-2. Cleaning and replacing maintenance parts >>P.233"

Prepare the gloves, cap chip, and cap foam.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and

press @ :

<IMPORTANT>

3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

. Please complete the task within 25 minutes, in order to prevent the print heads from drying up.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Unlock the upper left-hand-side cover and top cover and open them.

- Ke_yhole_l ‘

189



Precautions to keep good printing quality/use printer over the long term

(4) Remove the cap chip and cap foam from the maintenance unit.
<CAUTION>
. Do not use sharp objects, such as tweezers, and be sure to remove the cap chip and cap foam by hand.

(5) Wipe the gloves with a waste cloth.

Waste cloth

N

Gloves

X0436

(6) Seta new cap chip and cap foam.
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Precautions to keep good printing quality/use printer over the long term

<CAUTION>

. Set the cap foam by aligning the cap foam hole with the protrusion on the backside of the cap rubber.
. Be careful not to reverse the orientation of the cap foam.

. The cap chip has two sides. Be careful not to turn it upside down.

. Be careful not to turn the cap chip upside down when the cap chip and cap foam are assembled.

Cap foam hole

Cap foam

(7) Close the upper left-hand-side cover and top cover.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
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Precautions to keep good printing quality/use printer over the long term

6-1-8. Replacing the flushing foam

When a warning message appears on the operation panel screen or in the warning message window, replace the
specified flushing foam with a new one.
<TIPS>

™
)

@)

Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the
wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence.
When you replace the flushing foam, check the staining state inside the printer. If parts inside the printer are stained, perform
cleaning. ="6-2-2. Cleaning and replacing maintenance parts >>P.233"

Prepare the gloves and flushing foam (consumable supplies).

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and

press @ :

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

. Please complete the task within 25 minutes, in order to prevent the print heads from drying up.

. Then, the head cleaning will be performed to prevent any ink from drying up.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Unlock the upper left-hand-side cover and top cover and open them.

\ ‘_ Ke"yholem ‘

[
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Precautions to keep good printing quality/use printer over the long term >
(4) Remove the flushing foam from the maintenance unit.

<IMPORTANT>
. Ink droplets will drop off from the hole in flushing foam. After removal, apply a waste cloth to the bottom face.

<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

(5) Wipe the gloves with a waste cloth.

Waste cloth

N

Gloves

X0436
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Precautions to keep good printing quality/use printer over the long term >
(6) Set the flushing foam in the maintenance unit.
<IMPORTANT>
. After this assembly process is completed, make sure that no flushing foam extends off the outboard end portions of the
maintenance unit. If it sticks out of the end portions, it may interfere with any nozzles and may result in non-ejection of

ink-jet droplets.

On the color side

(7) Close the upper left-hand-side cover and top cover.

<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.

<TIPS>
. The head cleaning will be performed to prevent ink from drying up.
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Precautions to keep good printing quality/use printer over the long term >

6-1-9. Replacing the carriage foam

When a warning message appears in the warning message window, replace the specified carriage foam with a new

one.
<TIPS>
. Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the
wiper, flushing foam, and carriage foam in sequence.
(1) Prepare the gloves and carriage foam, which come standard with the printer.
(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and
press @ .
(3) Select [Replace carriage foam] and press @ .
<IMPORTANT>
. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then replace the carriage foam.
. Please complete the task within 25 minutes, in order to prevent the print heads from drying up.
e  There is a risk of damaging the nozzle surface of the head. Be careful not to damage the nozzle surface of the head.
(4) Unlock and open the right-hand-side cover.
- Keyhole T T
|
| ———-
(5) Hold the end of the carriage foam and rotate the carriage foam downward to remove the carriage foam from the

carriage magnet. Rotate the carriage foam until the carriage foam comes in contact with the sliding surface of the

foam guide.

<IMPORTANT>

. Be careful not to let the carriage foam come into contact with the nozzle surface of the head.
3 Be careful when removing the carriage foam, which may come off suddenly.

foam guide
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Precautions to keep good printing quality/use printer over the long term

(6) Pull and remove the carriage foam toward you along the sliding surface of the foam guide after making sure that

the carriage foam is in contact with the surface of the foam guide.

(7) Put a proper amount of cleaning solution into the cleaning cup.

(8) Moisten a new clean stick R with the cleaning solution.
<IMPORTANT>
. Use a new clean stick R when you start cleaning.
3 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the nozzle surface, it may
malfunction the printer.
. Do not use other fluids (water, etc.), because they may damage the print heads.
. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
. Do not shed cleaning solution in the maintenance unit.
<NOTE>
° For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

Cleaning solution
X1000

Do not drain waste ink.
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(9) Clean the side of the print heads.
<TIPS>
e  The use of a flashlight is recommended to make it easier to see when cleaning.
. It is not easy to see the rearward side of the nozzle guard. It is recommended to clean it while checking the cleaning
condition with a mirror.
Nozzle guard side cleaning

)

Rearward Frontward
side side

\':_=_:’
——
(]

Nozzle guard

X1014

After nozzle guard side cleaning
Head frontward side
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Head frontward and rearward cleaning

X1049

(10) Remove ink clots, if any, protruding from the nozzle surface on the underside of the carriage.

Nozzle surface
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Precautions to keep good printing quality/use printer over the long term

Ink clot example
<CAUTION>
3 When removing ink clots, do not use hard objects like iron tweezers. The nozzle may be damaged, resulting in non-ejection
if the objects touch the nozzle or other parts.
Use gloves and remove ink clots by pinching them with a clean stick or your fingers.

(11) Clean the top of the steel plate next to the flushing foam.

Cleaning location
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Precautions to keep good printing quality/use printer over the long term

<CAUTION>

. Be sure to use a clean waste cloth. Using a waste cloth with pretreatment may lead to non-ejection.

3 Do not rub the parts strongly. Doing so may damage the parts.
. Wipe in the direction of the arrow to prevent the peeled ink waste from entering the flushing foam and the wiper cleaning

solution tank.
<TIPS>

. If it is difficult to remove the ink built up, clean it with the cleaning solution for GTX-6 (GCX-6WQ09L).

When doing so, do not apply the cleaning solution directly to the top surface of the steel plate, but rather use a waste cloth

soaked with the cleaning solution.

>

Pre-cleaning state

Post-cleaning state

On the
color side

On the
white side

OR/GR
side
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(12) Place the tip of the new carriage foam on the sliding surface of the foam guide.
(13) Move the foam along the sliding surface of the guide in the direction of the arrow, and move the carriage foam until

it touches the two foam pads.

Foam pad
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Precautions to keep good printing quality/use printer over the long term

(14) Rotate and assemble the foam to the magnet on the carriage.

Make sure that the carriage foam does not ride on the four foam pads.
<IMPORTANT>
. Be careful not to let the carriage foam come into contact with the nozzle surface of the head.

oam pad

Nozzle surface

(15) Close and lock the right-hand-side cover.
(16) From the menu, select [Exit], and press @ .
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Precautions to keep good printing quality/use printer over the long term >

6-1-10. Replacing the mist fan filter

When a warning message appears in the warning message window, replace the mist fan filter with a new one.
The inside of the main unit may become dirty with mist, which may cause a malfunction if you continue using the mist
fan filter without replacement.

™
@)

@)

(4)

O WARNING
Replace mist fan filter

Prepare gloves and a new mist fan filter.
From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and

press @ .

Select [Replace mist fan filter], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.
Push in and open the mist fan door.

<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.
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Precautions to keep good printing quality/use printer over the long term >

(5) Hold the grip and remove the mist fan filter.

Mist fan filter

(6) Insert a new mist fan filter and push in and close the mist fan door.

<CAUTION>
. Insert the mist fan filter completely, on the side with the grip facing upward.

Mist fan filter

(7) Replace the other one in the same way.

(8) Press @ by following the on-screen instructions to finish the work.

<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
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Precautions to keep good printing quality/use printer over the long term

6-1-11. Replacing the platen sheet

When the platen sheet gets soiled, replace it with a new one.
(1) Remove the platen from the main unit of the printer. ="5-4-1. Replacing the currently used platen with another one
>>P. 154"

(2) Peel the platen sheet off the platen.
<TIPS>
. When it is hard to peel the platen sheet off, warm it using a hair dryer or the like and peel it off.

Platen sheet

Platen
X1027

(3) Wipe the surface of the platen with a clean cloth moistened with a mild detergent which is diluted with water, then
wipe the platen clean with a dry and soft clean cloth.

(4) Mount the platen in the main unit of the printer. ="5-4-1. Replacing the currently used platen with another one
>>P.154"

(5) Peel the release paper (small in size) off a new platen sheet.

Platen sheet

Release paper (small)

X1028
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Precautions to keep good printing quality/use printer over the long term >

(6) Position the platen sheet to match the platen surface, and onto the platen, stick the portion of the platen sheet

where the release paper (small) was removed.

Positioning Platen sheet

Platen

X1029

(7) Peel off the rest of the release paper, and paste the whole platen sheet onto the entire platen.
<TIPS>
3 Straighten the platen sheet, and stick it properly while pressing it with hands outward from the center to avoid making
wrinkles.

Platen sheet

{

Release paper

Platen

X1030

(8) As required, print a grid pattern onto the new platen sheet. ="4-6-4. Print a grid pattern on the platen sheet

>>P131"
<TIPS>
. After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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Precautions to keep good printing quality/use printer over the long term >

6-1-12. Replacement of print head

If a problem of non-ejection of ink-jet droplets is not cleared even after cleaning the head nozzle, replace a The print
head with a new one.
Check the head position of the corresponding print head with the non-ejection of ink-jet droplets in the nozzle check
pattern, and replace the print head by following the procedure. ="6-1-17. Print out the nozzle check pattern (checking
on the print heads) >>P.220"
<TIPS>
. Do not confuse the color/ORGR side print heads with the white side print heads.
Check the case color (red for the color/ORGR side heads and white for the white side head) and replace the case.
. Color, OR/GR and white side print heads have side A and side B. Be sure to set them correctly.
o Ink needs to be re-installed after replacing the print head. If the ink level is low, refill ink.
<NOTE>
. For a proper work operation, be sure to wear the supplied gloves.

(1) From the menu, select [Maintenance] > [Head Replacement] > [Corresponding print head], and press @ .

(2) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

(3) Unlock the upper left-hand-side cover and top cover and open them.

. Keﬁyhole_l ‘

[
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(4)
(5)

(6)

Precautions to keep good printing quality/use printer over the long term >

Remove the upper case of a new print head.

Remove the caps from the new print head.
<TIPS>
. Remove all the four caps when replacing a color or white side print head.
When replacing an OR/GR side print head, remove the two caps 1-5 and 2:6 on top of the head cover.

Head A side 1 2 3 4
Head B side 5 6 7 8
( 7\
Color/White side OR/GR side
1c) 203945) 1c) 2039 45(3)
56 56

J
X1125

Remove each tube from the print head to be replaced with a new one. Then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.
<IMPORTANT>

. Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.
<TIPS>

¢  Two tubes are connected to an OR/GR head.

<NOTE>

3 For a proper work operation, be sure to wear the printer-provided gloves.

( Cap Tube
P
HH-» 5=
EH-» =
- {E—

X1005

(7) Remove the latch on the carriage board cover and open the cover.
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(8) Remove the head board of the corresponding print head.
<CAUTION>
o Be sure not to touch other boards.

Head board .

B | icad board

*V
l" Head board

Ay Ak Y w& %

(9) Remove the hook and clamp and disconnect the flat cable.
R iy B

]
i |
i
g

(10) Unlock the print head, and remove the print head.

<IMPORTANT>
. When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping
ink.

Print head

Carriage plate

(11) Release the lock by pulling part (a) on the case to the left and take out the new print head from its case.
<IMPORTANT>
. When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.
<TIPS>
. Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both

hands to remove it.

Print head
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(12) Mount the new print head onto the carriage and push in the lock bar of the print head to lock the print head.
<IMPORTANT>
. Be careful not to pinch the flat cable between the metal plate of the print head and the carriage.
. Be careful not to let the metal plate of the print head ride on the positioning part.
3 Be careful not to touch the lock of the other head and release the lock.

Print head

(13) Connect the head board aligned with the positioning pins on the carriage board.
<IMPORTANT>
. After connecting, check that the head board is not tilted.

Positioning pin =
2L Y [ 58

> Head board

(14) Place the flat cable in the hook and clamp on the carriage.
<CAUTION>
. Ensure that the flat cable for head A does not overlap with that for head B.
. Extend the flat cable on the print head side toward the carriage board so that the flat cable will not bend.
. Fold the flat cable on the print head side.

) Flat cable

Clamp

Fold the flat cable
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(15) Close the carriage board cover.
<IMPORTANT>
. Make sure that the latch is securely closed.
3 Ensure that the flat cables do not extend past the edge of the cover.
<CAUTION>
. Ensure that the flat cable for head A does not overlap with that for head B.

(16) Remove the cap you connected in step (6) from the tube, and connect the tubes to the print head.
<IMPORTANT>
. Check the stamp on the print head and the tube number, and make sure that they are connected in the correct position.
Incorrectly connecting them may cause the ink to leak during the circulation.
<CAUTION>
3 Ensure that the flat cables do not extend past the edge of the cover.

(17) Tighten the nut firmly until it stops so that each tube is fixed to the print head.

Head A side 1 2 3 4
Head B side 5 6 7 8
<CAUTION>

. For the OR/GR side print heads, connect the two tubes corresponding to 1-5 and 2-6 on top of the head cover.
Neither 3-7 nor 4-8 is used. Keep the caps that are originally attached.

4 N\ 4 N
@ @ @ @ *Remove the ink clot.
/
3040
1 o 20 7 8
56 \ y,
. J

X1108

(18) Close the upper left-hand-side cover and top cover and turn on the power.
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Precautions to keep good printing quality/use printer over the long term

(19) From the menu, select the corresponding head under [Maintenance] > [Install Ink after Replacing Head] and press

Perform the work operation by following the on-screen instructions.
<TIPS>
. After the procedures are completed, the current screen will go back to the standby mode screen.

. Replace other print heads in the same way.

(20) Print the nozzle check patterns. ="6-1-17. Print out the nozzle check pattern (checking on the print heads)
>>p.220"

(21) Perform the initial settings after head replacement configuration. ="3-6-1. Initial settings after head replacement
>>P.61"

(22) In the case of color or OR/GR head replacement, make two-head color adjustments for the replaced head.
="3-6-2. Color adjustments between colorfORGR heads >> P.62"

(23) Adjust the ejection timing of the print head. ="3-6-3. Firing adjustment >>P.63"

(24) Make position adjustments for the 2 heads of the same color. ="3-6-4. 2 same color heads position adjustment
>>P.64"

(25) Perform the platen feed adjustment. ="3-6-5. Platen-rolling adjustment >>P.65"

(26) Make white and color/ORGR position adjustments. ="3-6-6. White and Color/ORGR Alignment >>P.66"
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6-1-13. Cover adjustments

Adjust each cover if they do not close smoothly.

-

Upper left side cover

Lower left side cover

Upper right side cover

Tilt adjustments

(1) Turn the adjustment screw on the front side clockwise or counterclockwise to make adjustments if a cover is tilted.

Turn the adjustment screw clockwise to lower the cover and counterclockwise to raise the cover.

III‘-—T’uk-,S

s

i

Adjustment screw
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Left/right adjustments

(1) Turn the adjustment screw on the front side clockwise or counterclockwise to make adjustments if the cover
interferes with the adjacent cover. Turn the adjustment screw clockwise to reduce the clearance and
counterclockwise to increase the clearance.

A\

4—»'.}

| Adjustment screw
Up/Down adjustments

(1) Turn the adjustment screw in the center clockwise or counterclockwise to make up and down adjustments.

Turn the adjustment screw clockwise to raise the cover and counterclockwise to lower the cover.

)
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Back/Forth adjustments

(1) Turn the adjustment screw On the inside clockwise to make back and forth adjustments.

R

Adjustment screw
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6-1-14. Tube air bleed

If air is mixed in the print head or tube and ink non-ejection is not improved, bleed the air in the tube.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.
(2) Press A / V¥ ,select [Maintenance] > [Tube air bleed], and press @ .

(3) Select the item you want to bleed air from and press @ .

Tube air bleed Tube air bleed
White head A OR/GR head B
White head B
Color head A
Color head B
OR/GR head A

(4) Select the color you want to bleed air from and press @ .
<TIPS>
. Select the number for the white head. ="6-1-12. Replacement of print head>>P.207"

Tube air bleed (CL_A)
Black

Yellow

Cyan

Magenta

(5) Follow the message displayed on screen, press @ on the operation panel.

Air bleeding in the tube is executed.
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6-1-15. Head cleaning

This printer has been designed to perform the Auto Cleaning every time 72 print jobs are printed after the previous Auto
Cleaning, or before starting the printing using the white ink when one hour or more elapses after the previous printing
that used the white ink.

<TIPS>

° The frequency and start timing of Auto Cleaning can be changed. ="7-13. Auto Cleaning Setting >>P.251"

In the event that there is any faintly printed or missing portion on a printed material, head cleaning sometimes provides a
solution.

Selecting a type of head cleaning from the menu to perform the head cleaning

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.

(2) From the menu, select [Head Cleaning], and press @ .

Menu

Platen Height Adjustment
Head Cleaning

Test Print

Ink Refill

Print Data Load

(3) By pressing A .~ V¥, select one of the options: [Normal Cleaning], [Powerful Cleaning] or [Super Cleaning], and

press @ .

<TIPS>
. For selecting a desired cleaning option, follow the instructions in the respective steps. ="8-2-1. Recovery action to be
taken for such a nozzle that is unable to eject ink-jet droplets >>P.274"

Head Cleaning
Normal Cleaning
Powerful Cleaning
Super Cleaning
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Precautions to keep good printing quality/use printer over the long term >

(4) Bypressing A . V¥, select [All Colors], [All OR/GR], [All Whites], or [All Print Heads], and press @ .

<TIPS>
. Under the condition that the nozzle which has been confirmed not ejecting ink-jet droplets, determine the color for which the
head cleaning should be performed. ="6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.220"

Normal Cleaning
All Colors

All OR/GR

All Whites

All Print Heads

(5) Then, the head cleaning will be performed for the specified print heads.
<TIPS>
. The cleaning operation cannot be canceled halfway.
. After the procedures are completed, the current screen will go back to the standby mode screen.
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Precautions to keep good printing quality/use printer over the long term

6-1-16. White ink circulation

>

When whiteness is not enough, it may be solved by performing white ink circulation.

™
)

While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.

From the menu, select [Maintenance] > [White Ink Circulation], and press @ .

<IMPORTANT>

. Do not turn off the power because if you do so, the printer may fail because necessary maintenance operations are not
performed.

<TIPS>

. Completing the white ink circulation varies depending on the ambient temperature. Usually, it takes about 8-9 minutes and
up to 15 minutes. White ink is circulated automatically every four hours, and white ink three times as much as normal is
circulated every 24 hours.

. If you are activating the printer after having had its power off for a long period, it will take up to 4 hours depending on how
long the power was off.

White Ink Circulation
All Whites
[ 1] min. [30] sec.
p—
Please Wait
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Precautions to keep good printing quality/use printer over the long term

6-1-17. Print out the nozzle check pattern (checking on the print heads)

By printing out a nozzle check pattern, you can check on the printing quality.
It is recommended to always perform this procedure to verify the output.
<TIPS>
. The serial number, firmware version, print date (day/month/year), time, temperature, humidity, and the number of copies
printed are printed at the bottom of the nozzle check pattern.
The date and time will be printed in Coordinated Universal Time with "(UTC)" printed at the end if time adjustment as a
maintenance tool has not been made. You can print the date and time according to your environment by making time
adjustment. ="3-6-7. Setting of the time displayed on the nozzle check pattern >>P.67"

(1) Putthe platen 14x16 in place, and position its level at "A".
="5-4-1. Replacing the currently used platen with another one >>P.154" and "5-4-2. Platen height adjustment
>>P.156"

(2) As illustrated below, put the A4-size or letter-size white paper on the platen in alignment with the right-hand corner

of the platen at its front edge.

When the paper is loosely fitted, fix its edge with a tape or the like.

AT-shirt can also be used instead.

<TIPS>

. When printing out a nozzle check pattern on the white side, print it on a pretreated black or dark color textile or black paper,
or a transparent sheet (such as OHP sheet).

Paper

Platen \

X1022

(3) From the menu, select [Test Print] > [Nozzle Check CMYK], and press and hold the two print buttons

simultaneously.

Then, printing will begin.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.

(4) After printing on the color side is completed, remove the printed paper and replace it with a paper for printing on the

white side.
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(5)

(6)

(7)

Precautions to keep good printing quality/use printer over the long term >

From the menu, select [Test Print] > [Nozzle Check White], and press and hold the two print buttons

simultaneously.

Then, printing will begin.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.

After printing on the white side is completed, remove the printed paper and replace it with white paper for the
OR/GR side.
From the menu, select [Test Printf] > [Nozzle check OR/GR], and press and hold the two print buttons

simultaneously.
Then, printing will begin.
<TIPS>
. You will hear a sound each time you press the print buttons and after a certain period has lapsed.
Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled.
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Precautions to keep good printing quality/use printer over the long term

(8) Check to see if the printed results of all nozzles are acceptable, and if no ink-jet droplets have been ejected,

perform a head cleaning for print heads. ="6-1-15. Head cleaning >>P.217"

<IMPORTANT>

. If the print result shows an intermittent line, non-ejection has occurred. A head cleaning should be performed on the print
head that has a poor nozzle check result.

. Even if the lines of the white-side printed result are light, since white ink is fired from more than one nozzle on the same
place, the quality is not affected.

<TIPS>

. The following items are printed at the bottom of the nozzle check pattern:
+ Serial number * Temperature
* Firmware version * Humidity
* Print date (day/month/year) » Number of prints
* Time

3 The name of the corresponding head (head A or B) is printed next to each nozzle check pattern.

On the color side OR/GR side On the white side
Non-ejection occurred at the Non-ejection occurred at the Non-ejection occurred at the
arrowed area. arrowed area. arrowed area.

Example: Non-gjection at color Example: Non-ejection of green at Example: Non-ejection at white
head B black OR/GR head A head A

J
X1096 X1097 X109

White head B OR/GR head B Color head B

T

White head A OR/GR head A Color head A
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Precautions to keep good printing quality/use printer over the long term >

6-2. Cleaning

6-2-1. Cleaning the nozzle guard and suction cap

When a warning message appears in the warning message window, perform the cleaning.
In the event that maintenance has been performed inadequately, a printed material may be soiled with waste ink during
a print session or a printed surface quality may deteriorate.

™

@)

@)

(4)

O WARNING

Clean cap
Please Clean Nozzle Guards

Make the clean stick R, clean stick T, cleaning cup, gloves and cleaning solution, which come standard with the

printer, available for use.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and

press @ .

Select @ in response to the instructions on the screen.

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and start working.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.
3 Then, the head cleaning can be performed to prevent any ink from drying up.
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(5) Unlock the upper left-hand-side cover and top cover and clean the suction cap.
Unlock and open the right-hand-side cover and clean the nozzle guard.
Two types of clean sticks are provided. Use either the clean stick T or R depending on what you want to clean.
<TIPS>
. For the cleaning method, refer to the description mentioned below.

Locations to be
cleaned with clean Suction cap
stick T

On the white side

(.

Locations to be
cleaned with clean
stick R

The nozzle guard
surface and between the
nozzle guard and nozzle

J/

X1109

(6) After the cleaning is completed, close all the covers.

<NOTE>

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>

e  Then, the head cleaning will be performed to prevent any ink from drying up.

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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The nozzle guard and suction cap should be cleaned separately for the white side and color side.
For the way to perform cleaning, refer to the respective items.

1

Perform cleaning of the white side.

Prepare a new clean stick R and the cleaning solution.

Perform cleaning of the nozzle guard part on the white side.
: ="Cleaning the nozzle guard (Use clean stick R) >>P.226"
Cleaning After cleaning the nozzle guard part, remove ink clots, if any, protruding from the nozzle surface.

Nozzle guard

Prepare a new clean stick T and the cleaning solution.

Perform cleaning of the suction cap part on the white side.

Cleaning suction - _ :
="Cleaning suction cap (Use clean stick T) >>P.229"

cap

pl Perform cleaning of the color side.

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution.

Perform cleaning of the nozzle guard part on the color side.
Nozzle quard ="Cleaning the nozzle guard (Use clean stick R) >>P.226"
Cleaning After cleaning the nozzle guard part, remove ink clots, if any, protruding from the nozzle surface.

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution.

Cleaning suction Perform cleaning of the suction cap part on the color side.

cap ="Cleaning suction cap (Use clean stick T) >>P.229"

k§ Perform cleaning on the OR/GR side.

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution.

N | d Perform cleaning of the nozzle guard part on the OR/GR side.
LrA g_uar ="Cleaning the nozzle guard (Use clean stick R) >>P.226"
Cleaning After cleaning the nozzle guard part, remove ink clots, if any, protruding from the nozzle surface.

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution.

Perform cleaning of the suction cap part on the OR/GR side.

Cleaning suction
9 ="Cleaning suction cap (Use clean stick T) >>P.229"

cap

V.8 Clean the backside of the carriage.

X1110
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Precautions to keep good printing quality/use printer over the long term >

Cleaning the nozzle guard (Use clean stick R)

™
2

Put a proper amount of cleaning solution into the cleaning cup.

Moisten a new clean stick R with the cleaning solution.
<IMPORTANT>

Use a new clean stick R when you start cleaning.

Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

Do not use other fluids (water, etc.), because they may damage the print heads.

Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

Do not shed cleaning solution in the maintenance unit.

<NOTE>

For a proper work operation, be sure to wear the printer-provided gloves.

) Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution
X1000

Do not drain waste ink.
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(3) Wipe the area between the print head's nozzle surface and nozzle guard.

<IMPORTANT>

o Be sure not to touch the red-frame zone of the nozzle surface.

. For cleaning, be sure not to use any tool other than clean stick R.

3 Do not rub the nozzle strongly.

Clean this part

N

Nozzle guard

Cleaning conditions

Cleaning location
Between the nozzle surface and nozzle guard

Nozzle guard frontward

Nozzle guard rearward Nozzle surface

X111

Pre-cleaning state

Post-cleaning state

Cleaning location
Nozzle guard frontward

Cleaning location
Between the nozzle surface
and nozzle guard

Cleaning location
Nozzle guard
rearward

X1046

<IMPORTANT>

o Be sure to use the clean stick R separately for white ink and color ink.
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Precautions to keep good printing quality/use printer over the long term

(4) Remove ink clots, if any, protruding from the nozzle surface on the underside of the carriage.

Nozzle surface

Ink clot example
<CAUTION>
e  When removing ink clots, do not use hard objects like iron tweezers. The nozzle may be damaged, resulting in non-ejection
if the objects touch the nozzle or other parts.
Use gloves and remove ink clots by pinching them with a clean stick or your fingers.
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Cleaning suction cap (Use clean stick T)

(1) Wipe the lip of the suction cap in parallel with the side surface of the tip of clean stick T, and then wipe the outer

frame in the same way.

<IMPORTANT>

° Clean the lip of the suction cap with clean stick T. The print head dries and causes an ejection failure if solidified ink
remains.

3 Do not touch the sponge of the suction cap. The sponge may come off.

. Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

3 If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the suction cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets.

. Be sure not to pinch the rubber seal. If it is damaged, its sealing property will be degraded, which in turn may lead to
non-ejection of ink-jet droplets from the print heads.

Outer frame
Sectional view ]
Lips
(Cl‘, (Q‘,
Outer frame

X1112

(2) Replace clean stick T with clean stick R, rinse the cleaning cup, and clean the nozzle guard on the color side head.
<IMPORTANT>
. Be sure to use the clean stick T separately for white ink and color ink.
. The used clean stick T should be disposed of, and should not be reused.
e  After cleaning the nozzle guard of the color side head, rinse the cleaning cup with pure water, let it dry sufficiently, and store
it so that dust does not get inside.
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Cleaning conditions

Post-cleaning state
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Precautions to keep good printing quality/use printer over the long term >

Cleaning the backside of the carriage

(1) Clean the area shown below on the backside of the carriage.

\
Cleaning location

(2) Use the clean stick R or waste cloth to clean the area.

Absorb ink droplets with the clean stick R Wipe off the adhered mist ink with a
waste cloth

<CAUTION>

e  When cleaning the backside of the carriage with a waste cloth, make sure that the waste cloth will not touch the nozzle
surface. The nozzle may be damaged, resulting in non-ejection if the objects touch the nozzle or other parts.

<TIPS>

. Clean the white side in the same way.
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Cleaning ink droplets

Pre-cleaning state

Post-cleaning state

Mist-state ink

Pre-cleaning state

Post-cleaning state
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Precautions to keep good printing quality/use printer over the long term >

6-2-2. Cleaning and replacing maintenance parts

Clean the maintenance area, if it is dirty, when replacing the flushing foam.

(1) Prepare a waste cloth.
<IMPORTANT>

Please complete the task within 25 minutes, in order to prevent the print heads from drying up.
Then, the head cleaning will be performed to prevent any ink from drying up.

(2) Unlock the upper left-hand-side cover and top cover and open them.

\ \ Ke_yholg ‘
| g

(3) Wipe the red frame part with waste cloth.
<IMPORTANT>

Please complete the task within 25 minutes in order to prevent the print heads from drying up.

Be sure to use a clean waste cloth. Using a cloth with pretreatment may lead to non-ejection.

Do not touch other parts such as springs and caps when wiping part (a), as shown in the photo. If you touch the spring, in
particular, it may come off.

Do not rub the parts strongly. Doing so may cause the parts to bend.

Do not put the wiped ink waste in the wiper cleaning tank.

the cleaning solution tank.

(4) Close the upper left-hand-side cover and top cover.
<NOTE>

Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
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6-2-3. Cleaning the surrounding area of nozzle surface

(1) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

3 Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and

press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

. Please complete the task within 25 minutes, in order to prevent the print heads from drying up.

3 Then, the head cleaning will be performed to prevent any ink from drying up.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(3) Unlock and open the right-hand-side cover.

~ Keyhole ~
;/——1“,\\

L ligh
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Precautions to keep good printing quality/use printer over the long term

(4) Puta proper amount of cleaning solution into the cleaning cup.

(5) Moisten a clean stick R with the cleaning solution.
<IMPORTANT>
. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.
. Do not use other fluids (water, etc.), because they may damage the print heads.
3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
. Do not shed cleaning solution in the maintenance unit.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution
X1000

Do not drain waste ink.
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(6) With a clean stick R, clean the surrounding area of nozzle surface of print head.
<IMPORTANT>
. Be sure not to bring the clean stick R into contact with the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.
3 Do not rub the parts strongly, which may scrape the water repellent film.

Cleaning area °

Cleaning
prohibited

Surrounding area of
nozzle surface

&

X1113

(7) Close the right-side cover and press @ in response to the instructions on the screen.

<NOTE>

3 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.

<TIPS>

. Then, the head cleaning will be performed to prevent any ink from drying up.

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
Cleaning conditions

Pre-cleaning state Post-cleaning state
X1114
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Precautions to keep good printing quality/use printer over the long term

6-24. Disposal of waste ink and waste water

If a warning message appears on the operation panel screen or in the warning message window, dispose of the waste

ink and the waste water in the tanks.

<IMPORTANT>

o It takes about two years for the waste water tank to be filled up with water.
When the waste ink tank accumulates, and an error occurs, treat the water in the waste water tank at the same time.

<TIPS>

o Warning messages will be displayed for the respective tanks when the waste ink and the water in the waste water tank are about
half full. However, these messages are not due to a malfunction of the detector.

O WARNING

Waste ink tank full
Humidifier drain tank full

(1) From the menu, select [Maintenance] > [Empty/replace waste ink tank], and press @ .

Follow the menu to complete the process.

(2) Open the lower left-hand-side cover.
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(3) Pull out the tube toward you from each tank and dispose of the waste ink and waste water in the tanks.
Place a receiving tray or the like under the other end of the tube (when removed) from the waste ink tank so that the waste ink
spilled from the tube will not be discharged onto the floor, etc.
<IMPORTANT>
3 Waste ink tank and waste water tank can weigh as much as 10 kg (22 Ib).
Be careful when pulling them out.
<NOTE>
. Dispose of the waste ink properly as water-based waste fluid in accordance with applicable laws and ordinances.

Waste ink tank

(4) Check the direction of the tank holes and install each tank as shown on the label.

Insert each tube into the tanks after installation.

<IMPORTANT>

. Be sure to push the tanks into the end.

. Install the tanks so that the hole of each tank is directly below the tube.
The tanks may not be detected if the orientation is wrong.

. Make sure that the tubes are inside the respective tanks.

3 Be careful not to bend the tubes excessively.
Otherwise the waste ink may have difficulty flowing through the tube.

Waste water tank

Waste ink tank

(5) Close the lower left-hand-side cover.
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Precautions to keep good printing quality/use printer over the long term

6-3. When Not Using for a Long Period of Time

When the printer will not be used for a prolonged period of time, take appropriate procedures before storing the printer

depending on storage period or condition.

<IMPORTANT>

. Do not turn the printer off. Otherwise, the printer may be damaged.

. If the power source to the printer cannot be sustained, please contact your dealer in advance.

<NOTE>

. If any error message is displayed on the screen, follow the instructions.

. When storing the printer for more than two weeks, clean the nozzle guard and suction cap. ="6-2-1. Cleaning the nozzle guard
and suction cap >>P.223"

6-3-1. When Not Using for a Long Period of Time: within 2 weeks

The printer can be used through normal procedure after the storage period, by performing the following maintenance
tasks.

(1) If the warning message window for the waste ink tank and waste water tank is displayed, dispose of the waste ink
and the waste water in the tanks.
="6-2-4. Disposal of waste ink and waste water >>P.237"

(2) Check the amount of cleaning solution in the cleaning solution tank, and refill the tank when its amount is below the
proper level.
="6-1-3. Refilling the cleaning solution >>P.183"

(3) Asrequired, print out a nozzle check pattern.

="6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.220"

6-3-2. When Not Using for a Long Period of Time: more than 2 weeks

Perform the following maintenance every two weeks.

(1) If the warning message window for the waste ink tank and waste water tank is displayed, dispose of the waste ink
and the waste water in the tanks.
="6-2-4. Disposal of waste ink and waste water >>P.237"

(2) Check the amount of cleaning solution in the cleaning solution tank, and refill the tank when its amount is below the
proper level.
="6-1-3. Refilling the cleaning solution >>P.183"

(3) Print out a nozzle check pattern and verify the result.
="6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.220"

(4) If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result
again.

="6-1-15. Head cleaning >>P.217"
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What to do when needed

As required, make settings and adjustments as mentioned below.

About menu layer on the setting screen

Menu

Setting screen

Description

[Printer Setting]

[Print Direction]

[Auto]

[Always Bi-Directional]

[Always Uni-Directional]

[Back Light]

[Light High]

[Light Medium]

[Light Low]

[Auto Screen Erase Time]

[No Auto Screen Erase]

[5 min]

[10 min]

[15 min]

[30 min]

[Menu TimeOut Setting]

[1min]

[3min]

[5 min]

[Speaker Volume]

Oto7

[Temperature]

[Fahrenheit]

[Centigrade]

[Preview display settings]

[Display it upward]

[Display it downward]

[File name display setting]

[Priority to file name display]

[Priority to job name display]

[Standby Display Icon Settings]

[Auto Cleaning Icon]

[Platen Height Icon]

[Print Information Icon]

[Circulation Schedule Icon]

[Platen Setting]

[Height settings by user]

[Obstcl sensr settng during print]

[Platen too low sensor]

[Low Temperature Mode]

[Enable(Normal)]

[Disable]

[Low Humidity Mode]

[Printing at Low Humidity]

[No Printing at Low Humidity]

[Select Everyday]

[Post-circulation Auto Cleaning]

[Before Next Printing]

[Soon after if within 30 min.]

[Soon after if within 1 hr.]

[Soon after if within 90 min.]

[Auto Cleaning Setting] 1t072
[Auto Cleaning Start Timing] [Conduct before I.3r|.nt|ng]
[Conduct after Printing]
[Always ON]
[White Ink 6 cc or More]
[Auto Multiple Pass Setting] [White Ink 16 cc or More (Standard)]

[White Ink 26 cc or More]

[Always OFF]
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Setting screen

Description

[Flushing Interval Setting]

[normal 42 lines]

[every 22 lines]

[every 6 lines]

[Flushing Volume Setting] [More]
[Standard]
[OFF]
[Auto Job Delete]
[ON]
[Printer Setting] [Network filtering] [El,qable]
[Disable]
[IP Address Sef [Automatic a'cquisition]
[Manual setting]
[Normal Cleaning]
[Auto cleaning]
[Shortcut button setting] [Print Data Load]
[White Ink Circulation]
[Platen Height Adjustment]
[Total Print]
[Temperature/Humidity Info]
[IP Address]
[Subnet Mask]
[Confirm network setting] [Default Gateway]
[Host name]
[MAC address]
[Check circulation schedule]
[Check humidification schedule]
[English]
[Espaniol]
[Francais]
[Deutsch]
(Language] [Italiano]
[Tarkge]
[Pyccknin]
[&ro1]
(7]
[BAEE
[Prepare Power OFF]
[Firm Version]
Version] [Data Info]
[Serial No.]

[Head information]
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7-1. Setting the print direction

(1) From the menu, select [Printer Setting] > [Print Direction], and press @ .

(2) Select your desired print direction of the print heads, and press @ .

<TIPS>

. The print direction is displayed here in the form of either bi-directional or the uni-directional icon

—>
-

. Note that the setting of the print direction gives priority to the printer's setting over the setting of the printer driver.

. The setting content will be kept intact until it is changed for the next printing job.

Print Direction

Auto OK
Always Bi-Directional

Always Uni-Directional

7-2. Screen back light adjustment

(1) From the menu, select [Printer Setting] > [Back Light], and press @ .

(2) Select your desired brightness of Liquid crystal panel, and press @ .

<TIPS>
. During this menu selection process, the screen is displayed with the selected brightness.

Back Light

Light High OK
Light Medium

Light Low
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7-3. Setup of Auto Screen Erase Time

(1) From the menu, select [Printer Setting] > [Auto Screen Erase Time], and press @ .

(2) Select your desired time until the liquid crystal panel and print button become unlit, and press @ .

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

Auto Screen Erase Time

No Auto Screen Erase OK
5 min

10 min

15 min

30 min

7-4. Setting the menu timeout period

(1) From the menu, select [Printer Setting] > [Menu TimeOut Setting], and press @ .

(2) Select the time before the display screen returns to the standby mode screen, and press @ .

<TIPS>
. During this menu selection process, the currently selected set value is displayed.

Menu TimeOut Setting

1 min OK
3 min

5 min
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7-5. Speaker volume setting

(1) From the menu, select [Printer Setting] > [Speaker Volume], and press @ .

(2) Adjust the speaker volume in an eight-step scale from 0 to 7, and press @ .

<TIPS>
. You can adjust the volume while checking it.

Speaker Volume

)

Set to OK to Confirm

7-6. Setup of temperature indication

(1) From the menu, select [Printer Setting] > [Temperature], and press @ .

(2) Select your desired unit of ambient temperature to be shown on the liquid crystal panel, and press @ .

Temperature

Fahrenheit
Centigrade

OK
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7-7. Preview display settings

Set the display direction of the preview image.

(1) From the menu, select [Printer Setting] > [Preview display settings], and press @ .
(2) Select the display direction and press @ .

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

Preview display settings
Normal OK
Inverted

7-8. Standby Display Icon Settings

Make standby display icon settings.
(1) From the menu, select [Printer Setting] > [Standby Display Icon Settings], and press @ .

(2) Select the icon you want to display on the standby screen and press @ .

Standby Display Icon Settings

Auto Cleaning Icon OK
Platen Height Icon

Print Information Icon

Circulation Schedule Icon
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With [Auto Cleaning Icon] set With [Platen Height Icon] set
— —
Standby Standby
ool 2]
1 2 3 4
With [Print Information Icon] set With [Circulation Schedule Icon] set
— —
Standby Standby
[2)[12000pi & 12:30
5 6 7
No. Function
1 Auto cleaning will start at the next printing if the icon and frame are yellow.
2 Number of sheets printed since the last cleaning.
3 Number of sheets set for auto cleaning.
4 The current platen height is displayed.
5 The print direction is displayed.
6 The printing resolution is displayed.
7 The time of the next white ink circulation is displayed.
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7-9. File name display setting

Make file name display settings of print data.

The display name you set is reflected in the selection screen of standby mode or receiving history or the USB flash
memory loading screen.

(1) From the menu, select [Printer Setting] > [File name display setting], and press @ .

(2) Select the display method and press @ .

<TIPS>

. The job name is set automatically by the image editing application.

File name display setting
Priority to file name display OK
Priority to job name display

7-10. Platen Setting

7-10-1. User settings for height

There are custom positions that can be set to any height.

(1) From the menu, select [Printer Setting] > [Platen settings] > [Height settings by user], and press @ .

(2) Setthe desired position.

Height settings by user
User settings 1
User settings 2
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What to do when needed >

7-10-2. Configuring the obstacle sensor to work during the printing process

Specify the detection mode of the obstacle sensor by selecting either [Check when platen is loading] or [Check during
printing as well].
(3) From the menu, select [Printer Setting] > [Platen Setting] > [Obstcl sensr settng during print], and press @ .

(4) Select the obstacle sensor setting and press @ :

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

. The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from
contacting wrinkles or foreign matter or minimize the time during which the contact continues.

. If the print head comes into contact with wrinkles or foreign object, a failure to eject ink-jet droplets or a mechanical failure may
occur.

. If the obstacle sensor detects a foreign object, the printing process and the platen operation are immediately stopped.

o If you select [Check when platen is loading], the obstacle sensor works only while the platen is moving from the front to the rear.

. If you select [Check during printing as well], the obstacle sensor works during the period from when you press the print button to
when the printing process completes.

Obstcl sensr settng during print
Check when platen is loading OK
Check during printing as well

7-10-3. Platen too low sensor setting

The sensor is activated if it detects that the print medium is far because the platen is too low.
Enable or disable this function when using the printer.

(1) From the menu, select [Printer Setting] > [Platen Setting] > [Platen too low sensor], and press @ .

(2) Select the "Platen too low" sensor function and press @ .

<TIPS>
. The "Platen too low" sensor checks if the platen is too low when it is completely inserted.
. If the "Platen too low" sensor is activated, the printing process and the platen operation are stopped.

Platen too low sensor
Enable OK
Disable
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7-11. Print Operation Settings Under Low Temperature

Configure the printer with automatic switching to low temperature operation mode for ensuring print quality when [Temp
Low] is displayed on the liquid crystal panel. It is set to [Enable(Normal)], by default.

If the low temperature operation mode is enabled, the printer will automatically be switched to the low temperature
operation. Although it can assure print quality, it may take longer time for printing.

If the low temperature operation mode is disabled, print speed will not slow down; however, poor ejection may occur.

(1) From the menu, select [Printer Setting] > [Low Temperature Mode], and press @ .

(2) Select the print mode under low temperature and press @ .

<TIPS>
. When [Disable] is selected, white ink injection may become unstable when trying to print a wide area.

Low Temperature Mode
Enable (Normal) OK
Disable
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7-12. Print Operation Settings Under Low Humidity

(1) From the menu, select [Printer Setting] > [Low Humidity Mode], and press @ .

(2) Select the setup items and press @ .

Low Humidity Mode

Printing at Low Humidity OK
No Printing at Low

Humidity

Select Everyday

<TIPS>

You can print even in a low humidity environment if you select [Printing at Low Humidity].

However, the frequency of auto-cleaning and the amount of waste liquid will increase if you print in a low humidity
environment.

You cannot print in a low humidity environment if you select [No Printing at Low Humidity].

The following confirmation screen will be displayed once a day at the first timing when you try to print in a low humidity
environment if you select [Select Everyday].

Low Humidity Mode

Printing at Low Humidity OK
No Printing at Low

Humidity
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7-13. Auto Cleaning Setting

Post-circulation Auto Cleaning
Specify your desired auto cleaning start timing after circulation.

(1) From the menu, select [Printer Setting] > [Post-circulation Auto Cleaning], and press @ i

(2) Select your desired post-circulation auto cleaning start timing, and press @ .

Post-circulation Auto Cleaning
Before next print OK
Soon after if within 30 min.

Soon after if within 1 hr.

Soon after if within 90 min.

Setting the Number of Printed Sheets for Auto Cleaning

Specify the number of printed sheets as the frequency of Auto Cleaning; where head cleaning is automatically
performed every time a predetermined number of sheets are printed in order to protect the printer and provide stable
printing quality. If the printing quality deteriorates in continuous printing, decrease the number of printed sheets for Auto
Cleaning. The default value is 72.

(1) From the menu, select [Printer Setting] > [Auto Cleaning Setting], and press @ i

(2) Press A ./ 'W¥ tosetupthe number of sheets to be printed in the range between 1 and 72, and press @ .

<TIPS>

o The printing quality tends to deteriorate if the humidity is low.

. If the auto cleaning is performed more frequently, the Wiper cleaner and flushing foam will need to be replaced with a new one
earlier.

Auto Cleaning Setting

1272

Set to OK to Confirm
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Auto Cleaning Start Timing
Specify your desired auto cleaning start timing.
(1) From the menu, select [Printer Setting] > [Auto Cleaning Start Timing], and press @ .

(2) Select your desired auto cleaning start timing, and press @ .

<TIPS>

o Even when [Conduct after Printing] is selected, Auto Cleaning may be performed before printing, depending on the state of use.

Auto Cleaning Start Timing
Conduct before Printing OK
Conduct after Printing

7-14. Setting Automatic Multiple Pass Settings

Perform this if the white printing quality deteriorates while printing.

(1) From the menu, select [Printer Setting] > [Auto Multiple Pass Setting], and press @ .

(2) Select the amount of white ink used for multiple pass printing and press @ .

<TIPS>
. The printing quality tends to deteriorate while printing if the temperature is low.
. Although automatic multiple pass printing can assure print quality, it may take a longer time for printing.

Auto Multiple Pass Setting

Always ON OK
White Ink 6 cc or More

White Ink 16 cc or More (Standard)
White Ink 26 cc or More

Always OFF
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7-15. Flushing Interval Setting

Perform this if the printing quality deteriorates during printing operations.
(1) From the menu, select [Printer Setting] > [Flushing Interval Setting], and press @ .

(2) Select the desired number of scanning operations until the flushing starts, and press @ .

<TIPS>

. The printing quality tends to deteriorate during the printing operation if the humidity is low.

. Setting shorter flushing intervals improves the printing quality, however, increases the ink consumption and increases the time
required for printing.

Flushing Interval Setting

Normal 42 lines OK
Every 22 lines

Every 6 lines

7-16. Flushing Volume Setting

Perform this if the printing quality deteriorates at the startup of the printing operation.
(1) From the menu, select [Printer Setting] > [Flushing Volume Setting], and press @ .

(2) Select your desired volume of ink to be ejected from the print heads during the flushing operation before the
printing operation starts, and press @ .
<TIPS>

. The printing quality tends to deteriorate at the startup of the printing operation if the humidity is low.
. Setting larger flushing volume improves the printing quality, however, increases the ink consumption.

Flushing Volume Setting
More OK
Standard
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7-17. Automatic deletion of print data
(1) From the menu, select [Printer Setting] > [Auto Job Delete], and press @ .

(2) Select the desired function of Auto Job Delete, and press @ .

Auto Job Delete
OFF OK
ON

7-18. Network filtering settings

This function will enhance LAN security. Enable or disable this function when using the printer. Setting this function to
[Enable] will allow only specific PC access. It is set to [Disable], by default.

(1) From the menu, select [Network filtering setting], and press @ )
(2) Select either [Enable] or [Disable], and press @ .

Network filtering
Enable OK
Disable
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7-19. Static IP address setting

In the [IP Address Set] window, select the automatic acquisition or manual setting, and set up the [IP Address], [Subnet
Mask] and [Default Gateway] when you select the manual setting.

(1) From the menu, select [Printer Setting] > [IP Address Set], and press @ .

(2) Select either [Automatic acquisition] or [Manual setting] and press @

<TIPS>
3 If you select [Automatic acquisition], the screen will go back to the standby mode screen after the settings are automatically
acquired.

IP Address Set
Automatic acquisition
Manual setting

(3) To make manual settings, press < ./ P to move to and select your desired position.
(4) To make manual settings, press A /¥ to specify your desired numeric value.

(5) When the @ button is pressed, the selected value is accepted, and the display screen goes to the [IP

Address], [Subnet Mask] and [Default Gateway] in sequence.

<TIPS>
. The display screen shown here has been taken as an example.

IP Address Set IP Address Set IP Address Set

IP Address Subnet Mask Default Gateway
A A A

41 92.168.000.001 > 42 55.255.255.000 4 <0 00.000.000.000 >
v v v

OK to Subnet Mask Screen OK to Gateway Screen Set OK
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What to do when needed

7-20. Shortcut button setting

You can set the operation that takes place when the shortcut button on the operation panel is pressed.

(1) From the menu, select [Printer Setting] > [Shortcut button setting], and press @ .

(2) Select the function and press @

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

o If you select [Normal Cleaning], you will be presented with the Normal Cleaning Head Selection menu.
. If you select [Auto cleaning], Auto cleaning begins.

. If you select [Print Data Load)], you will be presented with the screen to select the print data to load.

. If you select [White Ink Circulation], the white ink circulation begins.

Shortcut button setting

Normal cleaning OK
Auto cleaning

Print Data Load

White Ink Circulation

Platen Height Adjustment

7-21. Display of total printed sheets

On this display screen, the total number of printed sheets is shown.
(1) From the menu, select [Total Print], and press @ .

(1) Then, the total number of printed sheets is displayed.
<TIPS>
. Only the number of printed sheets of which printing has succeeded is counted, in which the canceled number of sheets is
not included.
e  All the printed sheets involved in printing operation, including test print, are counted.
. The display screen shown here has been taken as an example.
. The count of total number of printed sheets cannot be reset.

Total Print

530

Press OK to Return
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7-22. Display of Temperature/Humidity Info

Then, the ambient temperature and humidity are displayed.

(1) From the menu, select [Temperature/Humidity Info], and press @

(2) Then, the ambient temperature and humidity are displayed.

<TIPS>

. Make the setting of temperature indication unit in the Temperature window.
. The display screen shown here has been taken as an example.

Temperature/Humidity Info

Outer side [24°C  (75°F)]
Right side [42%]

Left side [22°C  (72°F)]
Press OK to Return
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7-23. Confirm network setting

In the [Confirm network setting] window, display the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and

[MAC address].
(1) From the menu, select [Confirm network setting], and press @ .

(2) Select one out of the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and [MAC address], and press

S

Confirm network setting

IP Address
Subnet Mask
Default Gateway
Host name

MAC Address

(3) Display [IP Address], [Subnet Mask], [Default Gateway], [Host name], or [MAC address].

<TIPS>
The display screen shown here has been taken as an example.

IP Address

Subnet Mask

192.168.000.001

Press OK to Return

255.255.255.000

Press OK to Return

Default Gateway Host name
000.000.000.000 GTXB6-XXXXXX
Press OK to Return Press OK to Return
MAC Address

00:1B:A9:FD:BC:27

Press OK to Return
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7-24. Check circulation schedule

White ink circulation can be performed at a specified time.

(1) From the menu, select [Check circulation schedule], and press @ .

(2) Display the circulation schedule.
<TIPS>

. If the scheduled time of white ink circulation is not set with the maintenance tool, the circulation schedule will not be displayed.

Check circulation schedule

Currenttime 17:44
00:30 (Long)
07:00
18:30

03:00
12:30
23:00

7-25. Check humidification schedule

(1) From the menu, select [Check humidification schedule] and press @ .

(2) The day of the week, start time, and end time for humidification will be displayed.

<TIPS>

. If the scheduled time of humidification is not set with the maintenance tool, the humidification schedule will not be displayed.

Check humidification schedule
Sun. 09:00 ~ 18:00
Mon. 09:00 ~ 18:00
Tue. 09:00 ~ 18:00
Wed. 09:00 ~ 18:00
Thu. 09:00 ~ 18:00
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7-26. Language setting

Select your desired language to be shown on the liquid crystal panel.

(1) From the menu, select [Language], and press @

(2) Select your desired language in the [Language] window, and finalize your setting by pressing @ .

(3) Follow the on-screen message, and turn off the power and on again.

Language

English OK
Espanol

Francais

Deutsch

Italiano
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7-27. Display of version

On this display screen, the firmware's version information, [Firm Version], as well as [Data Info], [Serial No.], and [Head
information] are shown.

(1) From the menu, select [Version], and press @
(2) Select [Firm Version], [Data Info], [Serial No.], or [Head information] and press @

Version information
Firm Version

Data Info

Serial No.

Head information

(3) Then, [Firm Version], [Data Info], [Serial No.], or [Head information] will appear.
<TIPS>

. Pressing the < button causes the currently displayed window to go back to the [Version] window.
. The display screen shown here has been taken as an example.

Firm Version Data Info

Main 1.80.0003 Message 0.19.0000
ACT 1.00.0000 Font 1.00.0000
LCD 1.30.0001 Test Print  0.00.0007

Head CL:1.20.0002 W: 1.20.0002
ORGR: 1.20.0002

Serial No. Head information
W_A No:6WA1234 V.Rating:12
Serial No. ABCDEFG1 W_B No:6WA1235 V.Rating:12
C_A No:6CA1234 V.Rating:15
Hardware ID 1.0 C_B No:6CA1235 V.Rating:12

Head information
OR/GR_A No0:6CA1390 V.Rating:11
OR/GR_B N0:6CA1391 V.Rating:14
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What to do when needed >

7-27-1. Updating of firmware

When a new firmware is released, please update the firmware.
<TIPS>
. To check any release information of a new firmware, please visit the website of Brother Industries, Ltd.

(1) Download the firmware's updated data from the website of Brother Industries, Ltd.

(2) From [All Programs] in the Start menu on the PC, select "GTX-6 Extra Colors ORGR Firmware Update" under
"Brother GTX-6 Extra Colors ORGR Tools".

(3) Specify the firmware's updated data (.bwf).

N’ GTX-6 Extra Colors ORGR Firmware Update *

Selectthe Firmware Update Data (*.bwf).

(4) Connect the PC to the printer via a LAN cable and update your firmware by performing the on-screen procedures.
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n Troubleshooting

A\.CAUTION

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may
be injured.

Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or
vomiting.

When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of
contact with eyes, do not rub but immediately rinse the eyes with water.

Keep the liquids out of the reach of children.

QoPPop

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(IDIMPORTANT

® Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

263



8-1.

Troubleshooting instructions

With reference to the descriptions below, troubleshoot your problem.

No print data can be sent from PC

Troubleshooting

Probable Cause

Remedy

Reference

Have you selected an incorrect
printer or not?

From the menu for printing, check your printer
name.

Has a LAN cable been
connected properly?

Check the connection of the LAN cable
(Category 5e or higher).

Are you using such PC or OS
that is outside the specification?

Check your PC's operating environment.

"10-2. Software >>P.309"

Has any noise been produced
between the printer and your
PC?

Disconnect the LAN cable first and connect it
again in five seconds. If the problem continues,
power off the printer first, then reactivate it in five
seconds.

Does your PC function
properly?

Restart the PC.

Has any other USB device been
connected to your PC?

Remove the other USB device, restart the PC,
and check to see if the printer functions properly.

Has the LAN cable been
damaged?

Use a different LAN cable.

No printing job gets started even after pressing the print button

Probable Cause

Remedy

Reference

Are you pressing the print
buttons properly?

Press and hold two print buttons at the same
time.

Check if the print is scheduled
(the button is flashing fast).

The print begins as soon as the printer becomes
available. Wait for a while.

Is any error message
displayed?

Eliminate the cause of the error, and perform
printing once more.

"9. Error message >>P.282"

Does the menu screen still
appear on the screen, or are
you performing the maintenance
operation from the menu?

Please exit the menu. Alternatively, please wait
until the maintenance operation will come to an
end.

Is the automatic head cleaning
operation underway?

Please wait until the ongoing head cleaning
operation is completed.

Is the printer in the white ink
circulation stage?

Please wait until the ongoing white ink circulation
is completed.

Is the room temperature suited
to the usage conditions?

Check for your printer's operating environment
and adjust the room temperature.

"10-1. Apparatus >>P.308"

Does the printer receive no print
data, oris it in the state to
receive such data (the print
button is not illuminating)?

Send the print data to the printer. Alternatively,
please wait until the reception of print data is
completed.
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Troubleshooting

>

Probable Cause

Remedy

Reference

Do you find that the temperature
of print heads is becoming high,
and the [Color Head Getting
Warm], [W Head Temp Rising],
or [OR/GR Head Temp Rising]
message appears?

There may be the possibility that the flat cables
of print heads have not been put in place and
the temperature of print heads has become high.
Turn off the power, make sure that the flat cable
is in place, and wait until the temperature
decreases.

Is the printer cover open?

Close the printer cover and try printing again.

Is the mist fan door open?

Close the mist fan door and try printing again.

"6-1-10. Replacing the mist fan
filter >>P.203"

Is the mist fan filter set correctly?

Set the mist fan filter correctly and close the mist
fan door. Then try printing.

"6-1-10. Replacing the mist fan
filter >>P.203"

The power cannot be turned on

Probable Cause Remedy Reference
Is the power cord connected to Make sure that the power cord is connected to
the printer? the printer.
An error occurs immediately after activating the printer

Probable Cause Remedy Reference

Is any error message
displayed?

Check the content of the error, and restart the
printer. If the error is still not eliminated, please
contact your dealer or Brother.

"9. Error message >>P.282"

No print data can be loaded from USB flash memory

Probable Cause Remedy Reference
Is the applicable file ARP or This printer cannot print out the print data of
ARS file? GT-541/GT-782/GT-3. Recreate the print data.
Neither uni-directional printing nor bi-directional printing can be performed

Probable Cause Remedy Reference

Do the settings of printer driver
and printer agree with each
other?

Note that the setting of the printer's setting has
priority over the setting of printer driver. The
printer driver's setup value takes effect only if the
printer's setting is [Auto].

"7-1. Setting the print direction
>>P.242"

The depletion of ink in an ink tank cannot be detected

Probable Cause

Remedy

Reference

Check if the remaining ink level
correction was skipped or an
incorrect value was entered for
the correction.

Perform the remaining ink level correction again.

"6-1-4. Correcting the remaining
ink level >>P.185"
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"x" is displayed for the remaining ink level after refilling ink.

Troubleshooting

>

Probable Cause Remedy Reference
Is ink of a wrong color refilled? Refill the right ink. If ink colors are mixed in the
ink tank as the result of refilling ink of a wrong -
color, contact your dealer.
The remaining volume indication of the ink tank does not reflect the actual status
Probable Cause Remedy Reference

Check if the remaining ink level
correction was skipped or an
incorrect value was entered for
the correction.

Perform the remaining ink level correction
again.

"6-1-4. Correcting the remaining
ink level >>P.185"

Ink is leaking from the lower right side of the printer

Probable Cause Remedy Reference
Is the degassing module not out | For help, please contact your dealer.
of order?
Water supply error

Probable Cause Remedy Reference

Is a humidifier water supply error
displayed?

If a water supply error occurs, the humidifier will
stop working. Perform [Humidification start] from
the menu.

Start humidification from the menu after
confirming the following two points. If the
problem persists, contact your dealer.

(PMake sure the water tank is filled with water.
(@Make sure that the main faucet of the water
supply section (pure water equipment and

tank) is open.

Is a water supply shortage error
or a water supply failure error
displayed?

If you are using a tap water supply, make sure
that the main tap and water supply pressure are
sufficient.

If you are using a water tank, make sure the
water tank is filled with water.

Ascertain the water supply tube is not broken or
crushed.

Check if the installation height of the water
supply tank is appropriate.

"1-5. About the humidifier
>>pP 33"
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Initial humidifier operation failed.

Troubleshooting

>

Probable Cause

Remedy

Reference

Initial humidifier operation failed?

Perform initial humidifier operation from the

menu after confirming the following two points. If

the problem persists, contact your dealer.

(PMake sure that the amount of water in the
tank and the installation height of the tank are
appropriate.

(2Check if there are any problems with the
piping from the water supply section (pure
water equipment and tank), such as
disconnected tubing or forgetting to open the
main faucet. If you supply water from a tank,
make sure it is a new tube.
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>

8-2. Solutions to print quality problems

With reference to the descriptions below, troubleshoot your problem.

Print is too light

Probable Cause

Remedy

Reference

Is the setting of an image editing
software application made
improperly, or is an image
placed in CMYK mode?

Edit the image.

"4-3. Using other applications
>>pP.80"

Have the printing conditions
been applied improperly, or
does your image data have
insufficient color saturation?

Using [Color Processing], adjust saturation or
contrast as appropriate.

"4-4-11. Set up the image quality
>>P113"

"4-5-7. Set up the image quality
>>p.125"

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the
referenced instructions.

"8-2-1. Recovery action to be
taken for such a nozzle that is
unable to eject ink-jet droplets
>>p.274"

Is initial settings after head
replacement configured?

Perform the initial settings after head
replacement configuration.

"3-6-1. Initial settings after head
replacement >>P.61"

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"7-11. Print Operation Settings
Under Low Temperature
>>P.249"

Horizontal stripe (banding) is found on printed material

Probable Cause

Remedy

Reference

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the
referenced instructions.

"8-2-1. Recovery action to be
taken for such a nozzle that is
unable to eject ink-jet droplets
>>p.274"

Do you print ink dots on a highly
water-absorbing print medium?

Set the print head's print direction to [Always
Uni-Directional].

Also, combine the color multiple pass printing
with the printing.

"7-1. Setting the print direction
>>P.242"

Is the platen positioned at a level
that is too low?

Adjust the height of the platen corresponding to
the print medium before using it.

You can use the platen height adjustment lever
from the menu to adjust the height of platen.

As a rough indication, adjust the height so that it
is lowered by one step from the limit height
detected by the obstacle sensor, and check that
the platen is not detected by the sensor.

"5-5. Placing print medium in
position >>P.157"

Is the ejection timing correct?

Adjust the ejection timing again. It is likely that
the setup value is incorrectly set after replacing a
print head or the platen with a new one, or after
adjusting the platen height.

"3-6-3. Firing adjustment >>P.63"

Check if the temperature is low.

Change the auto multiple pass settings.

"7-14. Setting Automatic Multiple
Pass Settings >>P.252"

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"7-11. Print Operation Settings
Under Low Temperature >>P.249"
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Blurring is observed (when printed with [Color Ink Only])

Probable Cause

Remedy

Reference

Isn't the amount of ink excessive
against the print media?

Print the ink volume and check the blurring, and
select appropriate set value for [Ink Volume:].

"4-6-5. Adjust the ink volume
>>p.132"

"4-5-6. Set up the color ink
>>P.123"

Blurring is observed (when printed with [Color+White Ink])

Probable Cause

Remedy

Reference

Is the [Highlight:] of [White Ink
Settings:] too high?

Print the highlight check pattern to check the
blurring, and select appropriate set value for
[Highlight:].

"4-6-6. Print out of highlight
check pattern/mask check
pattern >>P.133"

"4-4-7. Set up the white ink
>>P.105"

By turning ON the [White/Color Pause] or [Color
Multiple Pass Printing] checkbox, extend time
before the color ink settles onto the white ink, to
prevent blurring. Try this method to eliminate
blurring without weakening the highlight.

"4-4-7. Set up the white ink
>>P.105"

Ink sticks to such an area where no print data exists (ink stain, horizontal stripe, etc.)

Probable Cause

Remedy

Reference

Is the area around the print
heads soiled with waste ink
spilled from the head cap?

Clean the head section and suction cap.

"6-2-1. Cleaning the nozzle
guard and suction cap >>P.223"

Is any lint attached to the nozzle
surface?

Clean the nozzle guard.

"6-2-1. Cleaning the nozzle
guard and suction cap >>P.223"

Is the carriage foam
contaminated?

Replace the carriage foam with a new one.

"6-1-9. Replacing the carriage
foam >>P.195"

Do the print heads rub against a
T-shirt?

Flatten the surface of T-shirt, and adjust the
platen's height as required.

"5-5. Placing print medium in
position >>P.157"

Has the flushing foam become

dirty?

Replace the flushing foam with a new one.

"6-1-8. Replacing the flushing
foam >>P.192"

Has the platen sheet become

dirty?

Replace the platen sheet with a new one.

"6-1-11. Replacing the platen
sheet >>P.205"

Has any ink attached to the
carriage that secures the print
heads in place or is it dripping
off?

Replace the carriage foam with a new one.

"6-1-9. Replacing the carriage
foam >>P.195"
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The edges of the image are blurred, characters and straight lines are doubly printed and printed

result appears too granular

>

Probable Cause

Remedy

Reference

Is the platen positioned at a level
that is too low?

Adjust the height of the platen corresponding to
the print medium before using it.

You can use the platen height adjustment lever
from the menu to adjust the height of platen.

As a rough indication, adjust the height so that it
is lowered by one step from the limit height
detected by the obstacle sensor, and check that
the platen is not detected by the sensor.

"5-5. Placing print medium in
position >>P.157"

Is the ejection timing correct?

Adjust the ejection timing again. It is likely that
the setup value is incorrectly set after replacing a
print head or the platen with a new one, or after
adjusting the platen height.

"3-6-3. Firing adjustment >>P.63"

Is the image enlarged on the
printer setting screen?

When a low resolution image is enlarged on the
printer setting screen, it may blur or angle the
image. Pattern data should be enlarged on an
image editing application, and its roughness
should be checked.

Thin color cannot be printed out well gradually

Probable Cause

Remedy

Reference

Is the ambient atmosphere at a
high temperature and very dry,
which in turn tends to cause the
nozzle surface to dry up?

Perform the flushing more frequently. In addition,
increase the flushing volume.

"7-15. Flushing Interval Setting
>>pP.253"
"7-16. Flushing Volume Setting
>>pP.253"

White ink is not printed out evenly

Probable Cause

Remedy

Reference

Has the pretreatment been
applied unevenly?

Apply the recommended amount of
pretreatment evenly to the target area.

"5-3-3. Application of
pretreatment >>P.149"

Has the pretreatment caused
any change in hardness or
deformation of the pretreatment
roller? (This applies to the case
where the pretreatment roller is
used.)

After the pretreatment roller is used, putitin a
plastic bag or the like hermetically to prevent it
from drying up, and keep it in a flat place in an
upright position.

Also, when it remains unused for two weeks or
longer, wash it well with running water, and let it
dry in a shaded area.

Is any water content attached to
the pretreatment roller after the
pretreatment is fixated?

Prevent water content from being attached to
the roller after the pretreatment is fixated.

"5-3-4. Fixation of pretreatment
>>p.152"

Is there any lint, yarn waste,
dust, etc. that are attached to
the surface of pretreatment
roller? (This applies to the case
where the pretreatment roller is
used.)

Clean the surface of the pretreatment roller.

"5-3-3. Application of
pretreatment >>P.149"
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>

Probable Cause

Remedy

Reference

Did you shake the pretreatment
after its dilution?

Shake the pretreatment sufficiently.

"5-3-2. Dilution of pretreatment
>>P.147"

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"7-11. Print Operation Settings
Under Low Temperature
>>pP.249"

Has the pretreatment been
fixated insufficiently?

Check on an actual temperature of the heat
press and its pressure during the fixation stage.
Always keeping the lower iron (where media is
placed) of the heat press at heated temperature
with a heating source may solve this problem.

"5-3-4. Fixation of pretreatment
>>p.152"

Whiteness of print result is insufficient

Probable Cause

Remedy

Reference

Has the pretreatment been
applied insufficiently?

Apply a proper amount of pretreatment.

"5-3-3. Application of
pretreatment >>P.149"

Has the pretreatment been
fixated insufficiently?

Check on an actual temperature of the heat
press and its pressure during the fixation stage.

"5-3-4. Fixation of pretreatment
>>P.152"

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the
referenced instructions.

"8-2-1. Recovery action to be
taken for such a nozzle that is
unable to eject ink-jet droplets
>>p.274"

Is the white ink circulated
insufficiently?

From the menu, select [Maintenance] > [White
Ink Circulation] to circulate the white ink

properly.

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"7-11. Print Operation Settings
Under Low Temperature
>>P.249"

Is the dilution rate of the
pretreatment correct?

Dilute the pretreatment appropriately.

"5-3-2. Dilution of pretreatment
>>P.147"

Is the [Highlight:] of [White Ink
Settings:] too low?

Print the highlight check pattern to check the
blurring, and select appropriate set value for
[Highlight:].

"4-6-6. Print out of highlight
check pattern/mask check
pattern >>P.133"

"4-4-7. Set up the white ink
>>pP.105"

Too much luster

Probable Cause Remedy Reference
Are you using Teflon-treated Use a silicon coated peel off sheet when curing
peel-off sheet for fixation? the ink to reduce the gloss.
Too fuzzy

Probable Cause Remedy Reference

Did you touch the print media
(T-shirt) just before printing?

Excessively touching the media (T-shirt) on the
platen by trying to flatten the media before
printing could cause fuzziness. Make sure not to
touch the media surface too much after the
pretreatment is fixated.
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>

Probable Cause Remedy Reference
Does it take a long time before Leaving the print media (T-shirt) after fixing the
printing, after the pretreatment pretreatment may cause fuzziness, because the
fixation? media would absorb water. Print the i
pretreatment fixated media as soon as possible.
Is the upper iron on the heat If the upper iron is contaminated, it could
press contaminated during the roughen the print media (T-shirt) surface by a
pretreatment fixation process? heat press process, to cause fuzziness. Clean
the upper iron of the heat press with a cloth. -
If the condition persists, try using a peel-off
sheet during the pretreatment fixation process,
to probably improve the condition.
Unevenly dried during the It may be solved by inserting a silicone foam
fixation process? between the heat press lower iron and a print -
media (T-shirt) during ink fixation.
Background white ink spreads out when printed with [Color+White Ink]
Probable Cause Remedy Reference

[White/Color Alignment]
misaligned?

Misalignment of white and color inks can occur
when the media thickness or the platen height is
changed. Adjust the platen height first for the
actual media to be printed, and align the white
and color inks positions.

"3-6-6. White and Color/ORGR
Alignment >>P.66"

Is the media easy to stretch
when wet?

Print misalignment may occur between white
and color inks when the media stretches when
wet with white ink. Increasing [Choke Width:]
can prohibit spreading of the background white
ink.

"4-4-7. Set up the white ink
>>P. 105"

Printed surface cracks after fixation

Probable Cause Remedy Reference
Isn't the print surface folded Try not to touch the print surface until the
before fixation is completed? fixation process is completed.
The lower left side area of the printer's main unit is soiled with ink

Probable Cause Remedy Reference

Is the waste ink tube dismounted
from the maintenance unit?

For help, please contact your dealer.

Is the waste ink tube clogged
causing the waste ink to flow
reversely?

Straighten the waste ink tube to remove the
clog.
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The cleaning solution is leaked from the cleaning solution tank

Troubleshooting

>

Probable Cause

Remedy

Reference

Is the main body of printer put
aslant?

Place the printer horizontally.
If the problem is still not remedied, please
contact your dealer.

"3-1. Installation of printer
>>P.40"

Takes longer print time than before

Probable Cause

Remedy

Reference

Is the ambient temperature
under 18°C (64.4°F)?

Adjust the room temperature to 18°C (64.4°F) or
more.

If it is difficult to adjust the room temperature, set
the operational configuration under low
temperature to [Disable].

"7-11. Print Operation Settings
Under Low Temperature
>>pP.249"

Is your printing under a low
humidity environment?

Wait for the humidity inside the printer to reach
50% or higher.
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Troubleshooting >

Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets

Please verify the followings when any nozzle is not ejecting ink droplets.

Items to be checked Description Remedy Document
If the lip of the suction cap is dirty, the "6-2-1. Cleaning the nozzle
Is the lip of the suction cap ) P P . Clean the g
dirty? suction cap may not be able to adhere to the suction cap guard and suction cap
' print head, and ink may not be sucked. >>p.223"
The suction cap may not be in close contact )
"6-2-1. Cleaning the nozzle
Is ink accumulated in the | with the print head and ink may not be Nozzle guard g
) , guard and suction cap
nozzle guard? sucked if the space between the nozzle Cleaning ~>P 293"
guard and the nozzle is contaminated. '
When the surrounding area of nozzle
surface is contaminated, it could lead to
Is there any deposit of ink | ejection failure since the wiper cannot clean | Cleaning the "6-2-3. Cleaning the

around the nozzle
surface?

the nozzle surface properly. Or, it could
reduce the adhesion between the nozzle
and suction cap, thereby causing ink suction
failure.

surrounding area
of nozzle surface

surrounding area of nozzle
surface >>P.234"

Is the wiper contaminated?

The wiper may become dirty, and the nozzle
surface may not be wiped cleanly if the
wiper cleaning solution is not sufficiently

Introduction of
wiper cleaning

From the menu, select
[Maintenance] -> [Operate
wiper cleaning tank] ->

solution
filled in the wiper cleaning tank. [Add cleaning solution].
From the menu, select
, , The wiper may not be sufficiently cleaned Replacement of ,
Is the wiper cleaning i ) ) [Maintenance] -> [Operate
, . and the nozzle surface may not be wiped wiper cleaning ) ,
solution contaminated? , ) , L ) wiper cleaning tank] ->
cleanly if the wiper cleaning solution is dirty. |solution ) )
[Change cleaning solution].
Is there any indication of
y , If the wiper has any scar or deformation, the | Replace the "6-1-6. Replacing the wiper
scar or deformation on the | . ,
) wiper cannot clean the nozzle surface. wiper >>pP187"
wiper?
If the flushing foam is not placed
Is the flushing foam appropriately with no rise, it may touch the | Mount the "6-1-8. Replacing the

installed correctly?

nozzle surface to stop ejection from the
nozzle.

flushing foam

flushing foam >>P.192"

Is the ink accumulated on
the flushing foam?

If an ink accumulates on the flushing foam,
the ink may touch the nozzle surface to
prevent ink from ejecting.

Replace the
flushing foam

"6-1-8. Replacing the
flushing foam >>P.192"

Is the tube correctly
connected to the head?

If they are loosely mated, it may allow air to
enter into the head section during the head
cleaning operation, to cause non-ejection
condition of the nozzle.

Verify connection
between the
head and the
tube

"6-1-12. Replacement of
print head >>P.207"

Is the tube filled with ink?

If a large amount of air exists in the tube,
that air will go into the head to cause
non-ejection condition of the nozzle.

Bleed ink air in
the tube

From the menu, select
[Maintenance] > [Tube air
bleed] and select the
corresponding head and
color.

After carrying out appropriate remedial measures listed above, make sure the non-firing nozzle has been recovered. If it
has not, perform the steps 1 to 5 to recover the non-firing nozzle.
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Step 1: Print out a nozzle check pattern

(1) Print out a nozzle check pattern (1st time). ="6-1-17. Print out the nozzle check pattern (checking on the print
heads) >>P.220"
(2) Check the result of the printed nozzle check pattern (1st time), and carry out the following procedures. ="6-1-17.

Print out the nozzle check pattern (checking on the print heads) >>P.220"

<TIPS>

. Even if the white print result is weak, since the white ink is ejected on one same spot through multiple nozzles, a relatively
large amount of ink volume will be used, and the firing problem of a single nozzle will not affect the print quality so much.
Even in a condition with weak lines, the print is performed without a problem.

>

Existence or nonexistence of a Recovery action
nozzle that does not eject any
ink-jet droplets

Such a nozzle does not exist that | Contact your dealer if there is no non-ejection when printing the nozzle
does not eject any ink-jet droplets | check pattern, but a large amount of non-ejection occurs during printing.

Such a nozzle exists that does not | Proceed to Step 2.
eject any ink-jet droplets

Step 2: Perform the head cleaning
(1) Perform a normal cleaning. ="6-1-15. Head cleaning >>P.217"
(2) Print out a nozzle check pattern (2nd time).

(3) Check the result of the printed nozzle check pattern (2nd time), and carry out the following procedures.

Existence or nonexistence of a Recovery action
nozzle that does not eject any
ink-jet droplets

Such a nozzle does not exist that Exit
does not eject any ink-jet droplets

Ten-or-less nozzles exist that do Perform the normal cleaning once again. Subsequently, proceed to (4).
not eject any ink-jet droplets

Ten-or-more nozzles existthatdo | Perform the powerful cleaning. Subsequently, proceed to (4).
not eject any ink-jet droplets

More than half of the nozzles do Perform air bleeding in the tube. From the menu, select [Maintenance] >
not eject any ink-jet droplets [Tube air bleed] and select the corresponding head and color.

(4) Print out a nozzle check pattern (3rd time).

(5) Check the result of the printed nozzle check pattern (3rd time), and carry out the following procedures.

Existence or nonexistence of a Recovery action
nozzle that does not eject any
ink-jet droplets

Such a nozzle does not exist that Exit
does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 3.
eject any ink-jet droplets
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Step 3: Check that no ink-jet droplets are ejected from the applicable nozzle

™

@)

Check locations of the non-ejecting nozzles on the result of the printed nozzle check pattern (1st to 3rd time), and

carry out the following procedures.

Comparison of non-ejection nozzle Recovery action

positions
The same nozzle always does not | Perform the super cleaning -> print out of nozzle check pattern for the third
eject ink-jet droplets time in a row.
A different nozzle does not eject Leave the printer as it is for about 30 minutes, and perform the normal
ink-jet droplets cleaning -> print out of nozzle check pattern for the third time in a row.

Check a result of the resultant nozzle check patterns, and carry out the following procedures.

Existence or nonexistence of a Recovery action
nozzle that does not eject any
ink-jet droplets

Such a nozzle does not exist that Exit
does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 4.

eject any ink-jet droplets

Step 4: Clean the nozzle surface

™
2

@)

(4)

Clean the nozzle surface of the print heads.

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

. Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and

press @ :

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. Then, the head cleaning will be performed to prevent any ink from drying up.

Unlock and open the right-hand-side cover.

~ Keyhole :\v;g (T

b
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(5) Put a proper amount of cleaning solution into the cleaning cup.

(6) Moisten a clean stick R with the cleaning solution.
<IMPORTANT>
. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.
. Do not use other fluids (water, etc.), because they may damage the print heads.
3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
. Do not shed cleaning solution in the maintenance unit.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution
X1000

Do not drain waste ink.
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(7) With a clean stick R, clean the nozzle surface of print head.
<IMPORTANT>
. Be sure not to bring corner edges of the clean stick R into contact with the nozzle surface.
e Avoid roughly rubbing the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.

(8) Close the right-side cover and press @ in response to the instructions on the screen.

<NOTE>

3 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.

(9) Print out a nozzle check pattern.

(10) Check a result of the resultant nozzle check patterns, and carry out the following procedures.
Existence or nonexistence of a Recovery action

nozzle that does not eject any
ink-jet droplets

Such a nozzle does not exist that Exit

does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 5.

eject any ink-jet droplets

<IMPORTANT>

. Even if the nozzles on the white side have a bit of problem concerning firing, since the white ink is ejected on one same
spot through multiple nozzles, relatively large amount of ink volume will be used, and firing problem of a single nozzle will
not affect the print quality so much. Even in a condition with a problem concerning firing as shown in (a), print is performed
without a problem as shown in (b).

(@) (b)
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Step 5: Head Replacement

(1) Replace the print head with a new one. ="6-1-12. Replacement of print head >>P.207"

(2) Ifthe non-ejection state persists after replacing the head, contact your dealer.
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8-3. Acquisition of log file

In cases where the printer malfunctions, you may be required by our service personnel to obtain your printer's log file.
For this reason, please save your printer's log file to a file.

<TIPS>

To the resultant file, such filename (.log) that automatically identifies your printer will be given.

Fetch a log file from USB flash memory

(1) Insert a USB flash memory into the insertion slot of the printer.

(2) Press @ on the operation panel located on the left side of printer to go to the menu.

(3) Press A /¥, select [Maintenance] > [Log copy to USB], and press @ .

Log copy to USB

Set USB flash drive

Press OK to Start

(4) Then, the print button stops blinking, and the log file writing operation will be completed when you hear the sound of

pong.

<IMPORTANT>

. Never remove the USB flash memory from the printer when the print button is blinking. Otherwise, the USB flash memory
may be damaged, rendering its internal data to be unreadable.

(5) Obtain the log file saved to the USB flash memory, and send such file to our service personnel.
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Fetch a log file via LAN connection

(1) From [All Programs] in the Start menu on the PC, select "GTX-6 Extra Colors ORGR Maintenance" under "Brother
GTX-6 Extra Colors ORGR Tools".

(2) After the window shown below appears, select the [Log Data Retrieval] and click [Next].

& Brother GTX-6 Extra Colors ORGR Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX-6 Extra Colors ORGR i Search

Select an item from the menu below and click "Next".
AQJUSE This Setting when YWhen small characters are biurred, or arter a Print Head Is replaced. 05

() Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other items such as proper temperature and humidity have already been verified.
() white and Color/Extra Color Alignment
Adjust if white and color/extra color images are misaligned.

O Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulation.

() Set the scheduled time for white ink circulation
Configure this setting to set or cancel the scheduled time for white ink circulation.

() Humidification Schedule Settings
Set the humidification start time and end time.

Set an IP Adrress

og Data Retrieva

a reguest after troubleshooting service.

I e

(3) Perform the required operation by following the on-screen instructions in the dialog box.
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n Error message

Error message

What is shown below is the error message list of the GTX-6 printer. Any error message is displayed on the liquid crystal

panel.
Error code Error message Description Remedy
No communication is
established between the
) ! Check and see if any source produces a loud
e main board and panel board . )
[l failed in initialization. ) noise near the printer.
0001 when the power is turned on. ) o
Turn off and on] (Displayed in English If the problem persists even after reactivating
pay 9 the printer, please contact your dealer.
regardless of the selected
language.)
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0011 [Machine Error] main board and color head P L L
k If the problem persists even after reactivating
board A when the power is ,
the printer, please contact your dealer.
turned on.
No communication is
) unication | Check and see if any source produces a loud
established between the noise near the printer
0012 | [Machine Error] main board and color head P o L
i If the problem persists even after reactivating
board B when the power is ,
the printer, please contact your dealer.
turned on.
No communication is
, vnication | Check and see if any source produces a loud
established between the . .
. . ) noise near the printer.
0013 | [Machine Error] main board and white head ) L
, If the problem persists even after reactivating
board A when the power is ,
the printer, please contact your dealer.
turned on.
No communication is
established between the :(:::knzr:: tize i:ii?e); source produces a loud
0014 | [Machine Error] main board and white head P o L
i If the problem persists even after reactivating
board B when the power is )
the printer, please contact your dealer.
turned on.
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0015 | [Machine Error] main circuit board and If the problem persist.s even after reactivatin
OR/GR head circuit board A p P g
) the printer, please contact your dealer.
when the power is turned on.
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0016 | [Machine Error] main circuit board and If the problem persist.s even after reactivatin
OR/GR head circuit board B p P g
, the printer, please contact your dealer.
when the power is turned on.
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0021 [Machine Error] main board and actuator P o L
) If the problem persists even after reactivating
board 1 when the power is ,
the printer, please contact your dealer.
turned on.
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No communication is
, vnication | Check and see if any source produces a loud
established between the noise near the printer
0022 | [Machine Error] main board and actuator P o L
, If the problem persists even after reactivating
board 2 when the power is ,
the printer, please contact your dealer.
turned on.
No communication is
Check and see if any source produces a loud
established between the noise hear the rinteyr P
0023 | [Machine Error] main board and actuator P o L
, If the problem persists even after reactivating
board 3 when the power is ,
the printer, please contact your dealer.
turned on.
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0042 | [Machine Error] main board and platen P L L
If the problem persists even after reactivating
servomotor when the power )
. the printer, please contact your dealer.
is turned on.
No communication is
) Check and see if any source produces a loud
established between the noise near the printer
0043 | [Machine Error] main board and carriage P o L
If the problem persists even after reactivating
servomotor when the power )
, the printer, please contact your dealer.
is turned on.
No communication is
, Check and see if any source produces a loud
established between the noise near the printer
0044 | [Machine Error] main board and white P o L
, , , If the problem persists even after reactivating
circulation solenoid board ,
) the printer, please contact your dealer.
when the power is turned on.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0111 [Machine Error] board and color head board A P o L
) i . If the problem persists even after reactivating
while the printer is in )
) the printer, please contact your dealer.
operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0112 | [Machine Error] board and color head board P o L
, ) . If the problem persists even after reactivating
B while the printer is in )
, the printer, please contact your dealer.
operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0113 | [Machine Error] board and white head board P L L
, ) L If the problem persists even after reactivating
A while the printer is in )
, the printer, please contact your dealer.
operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0114 | [Machine Error] board and white head board P o L
i ) . If the problem persists even after reactivating
B while the printer is in )
, the printer, please contact your dealer.
operation.
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A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0115 | [Machine Error] circuit board and the OR/GR P o L
L , If the problem persists even after reactivating
head circuit board A while the ,
i . : the printer, please contact your dealer.
printer is in operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the brinter
0116 | [Machine Error] circuit board and the OR/GR Prinet: o
. , If the problem persists even after reactivating
head circuit board B while the ,
i . , the printer, please contact your dealer.
printer is in operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0121 | [Machine Error] board and actuator board 1 P . —
, i . If the problem persists even after reactivating
while the printer is in )
. the printer, please contact your dealer.
operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0122 | [Machine Error] board and actuator board 2 P o L
i ) . If the problem persists even after reactivating
while the printer is in )
) the printer, please contact your dealer.
operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer
0123 | [Machine Error] board and actuator board 3 P o L
i . . If the problem persists even after reactivating
while the printer is in ,
) the printer, please contact your dealer.
operation.
A communication error has Check and see if any source produces a loud
occurred in the hardware on | noise near the printer.

0131 [Machine Error] . P . L
actuator board 1 while the If the problem persists even after reactivating
printer is in operation. the printer, please contact your dealer.

A communication error has Check and see if any source produces a loud
occurred in the hardware on | noise near the printer.

0132 | [Machine Error] . P . -
actuator board 2 while the If the problem persists even after reactivating
printer is in operation. the printer, please contact your dealer.

A communication error has Check and see if any source produces a loud
occurred in the hardware on | noise near the printer.

0133 | [Machine Error] . P . _—
actuator board 3 while the If the problem persists even after reactivating
printer is in operation. the printer, please contact your dealer.

A communication error has Check and see if any source produces a loud
occurred between the main noise near the printer.

0141 [Machine Error] . P . N
board and panel board while | If the problem persists even after reactivating
the printer is in operation. the printer, please contact your dealer.

A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the printer

0142 | [Machine Error] board and platen servomotor P o o

, i . If the problem persists even after reactivating
while the printer is in )
) the printer, please contact your dealer.
operation.
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A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the brinter
0143 | [Machine Error] board and carriage P o L
) , If the problem persists even after reactivating
servomotor while the printer )
. ) the printer, please contact your dealer.
is in operation.
A communication error has
, Check and see if any source produces a loud
occurred between the main noise near the brinter
0144 | [Machine Error] board and white circulation P o L
i ) If the problem persists even after reactivating
solenoid board while the ,
) . , the printer, please contact your dealer.
printer is in operation.
The main tank remaining Select [Correct tank volume sensor] menu item
1010 | [Tank correction timing] volume sensor needs to be and correct the ink tank remaining volume
corrected. Sensor.
he tank need The ink tank ini
[The a.n neeas © Inicfanic remaining Correct the ink tank remaining volume sensor
1011 corrections volume sensor needs to be , ) )
, following the instructions on the screen.
Execute correction] corrected.
) Please wait until the temperature decreases.
[Color Head A Getting The temperature of color ,
1031 R If the problem persists, please contact your
Warm] head Ais rising.
dealer.
Please wait until the temperature decreases.
[Color Head B Getting The temperature of color . P
1032 N If the problem persists, please contact your
Warm] head B is rising.
dealer.
) Please wait until the temperature decreases.
. The temperature of white .
1033 | [W Head A Temp Rising] R If the problem persists, please contact your
head Ais rising.
dealer.
The termperature of white Please wait until the temperature decreases.
1034 | [W Head B Temp Rising] .p . If the problem persists, please contact your
head B is rising.
dealer.
Please wait until the temperature decreases.
[OR/GR Head ATemp | The temperature of OR/GR ° emp
1035 . o If the problem persists, please contact your
Rising] head A is rising.
dealer.
Please wait until the temperature decreases.
[OR/GR Head BTemp | The temperature of OR/GR ° emp
1036 . N If the problem persists, please contact your
Rising] head B is rising.
dealer.
The ambient temperature is
lower than the scope covered
1060 | [Temp Low] i P Raise your room temperature.
by its warranty for the best
print result.
The ambient temperature is
higher than the scope
1061 [Temp High] g ) P Lower your room temperature.
covered by its warranty for
the best print result.
The humidity is lower than
the scope covered by its Turn on the humidification function and wait for
1064 | [Humidity too Low] P yit _
warranty for the best print a while.
result.
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The humidity is higher than
the scope covered by its
1065 | [Humidity too High] pe covered by It Lower your room humidity.
warranty for the best print
result.
1070 [Battery Needs to Be It is time to replace the Note the error code and error message, and
Replaced] battery on the main board. notify your dealer.
The built-in clock has not Note the error code and error message, and
1080 | [Please Adjust RTC] it _ 9
been set up. notify your dealer.
The built-in clock has not Note the error code and error message, and
1085 | [Please Adjust RTC] . 9
been set up. notify your dealer.
1090 [Clean nozzle guard and | The cap needs to be Select the [Clean nozzle guard and cap] menu
cap] cleaned. item to perform cleaning.
1091 [Clean nozzle guard and | The cap needs to be Select the [Clean nozzle guard and cap] menu
cap] cleaned. item to perform cleaning.
1210 | [Exhaust Fan Stop] The mist coIIectifm fan (right Not.e the error code and error message, and
side) is not working. notify your dealer.
The mist collection fan (left Note the error code and error message, and
1211 [Exhaust Fan Stop] i . ( . 9
side) is not working. notify your dealer.
The cap foam needs to be Select the [Replace maintenance unit parts
1300 | [Replace cap foam] P , [Rep ! unit parts]
replaced. menu item and replace the cap foam.
The cap foam needs to be Select the [Replace maintenance unit parts
1301 [Replace cap foam] P . [Rep parts]
replaced. menu item and replace the cap foam.
The carriage foam needs to | Select the [Replace maintenance unit parts
1320 | [Replace carriage foam)] 9 ) [Rep ] parts]
be replaced. menu item and replace the carriage foam.
The carriage foam needs to Select the [Replace maintenance unit parts
1321 [Replace carriage foam] g ) [Rep I ) unit parts]
be replaced. menu item and replace the carriage foam.
The wiper needs to be Select the [Replace maintenance unit parts
1340 | [Replace wiper] P ) [Rep . parts]
replaced. menu item and replace the wiper.
The wiper needs to be Select the [Replace maintenance unit parts
1341 [Replace wiper] P , [Rep , parts]
replaced. menu item and replace the wiper.
The mist fan filter needs to be | Select the [Replace mist fan filter] menu item
1500 | [Replace mist fan filter] I I [Rep i ! ter] u!
replaced. and replace the mist fan filter.
1501 [Replace mist fan fiter] The mist fan filter needs to be | Select the [Replac.e mist fan filter] menu item
replaced. and replace the mist fan filter.
The flushing foam needs to Select the [Replace maintenance unit parts
1600 | [Replace flushing foam] g , [Rep ) parts]
be replaced. menu item and replace the flushing foam.
The flushing foam needs to Select the [Replace maintenance unit parts
1601 [Replace flushing foam] ushing , [Rep I ) unit parts]
be replaced. menu item and replace the flushing foam.
Because color head A has
been replaced, the Install Ink ,
P ) Select the [Install Ink after Replacing Head]
1801 [None after head change] | after Replacing Head , , .
) ) menu item to install the ink for color head A.
function needs to be put into
execution.
Because color head B has
been replaced, the Install Ink ,
P , Select the [Install Ink after Replacing Head)]
1802 | [None after head change] | after Replacing Head ) , .
, , menu item to install the ink for color head B.
function needs to be put into
execution.
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Because white head A has
been replaced, the Install Ink .
P ) Select the [Install Ink after Replacing Head]
1803 | [None after head change] | after Replacing Head ) , ) )
, ) menu item to install the ink for white head A.
function needs to be put into
execution.
Because white head B has
been replaced, the Install Ink .
1804 | [None after head change] | after Rep lacing Head Select the {Install Ink after Replacing Head]
9 repacing | menu item to install the ink for white head B.
function needs to be put into
execution.
Because OR/GR head A has
been replaced, the Install Ink ,
1805 | [None after head change] | after Rep lacing Head Select Install Ink after Replacing Head] menu
9 , P g , item to install the ink for OR/GR head A.
function needs to be put into
execution.
Because OR/GR head B has
been replaced, the Install Ink )
1806 | [None after head change] | after Rep lacing Head Select Install Ink after Replacing Head] menu
g ) P g ) item to install the ink for OR/GR head B.
function needs to be put into
execution.
1901 [Perform Initial Ink Initial ink installation has not | Select the [Initial Ink Installation] menu item to
Installation] been performed yet. implement initial ink installation.
Initial ink installation for the Install color ink using the [Initial Ink Installation]
1902 | [Install initial ink (KYCM)] | color heads has not been , 9
menu item and complete the process.
performed yet.
Initial ink installation for the
Install white ink using the [Initial Ink Installation
1903 | [Install initial ink (W)] white head has not been , g ! ]
menu item and complete the process.
performed yet.
i i ) Refer to the Setup Manual and use the
[Attach maintenance Maintenance unit parts are , , ,
1910 , [Replace maintenance unit parts] menu item to
parts] not installed. . . . .
install wipers, flushing foam, carriage foam, etc.
[Time for technical o ,
) Periodical maintenance and
1922 | maintenance ) ) For help, please contact your dealer.
i ) inspection are needed now.
Contact service engineer]
[Time for technical o ,
) Periodical maintenance and
1924 | maintenance ) ) For help, please contact your dealer.
i ) inspection are needed now.
Contact service engineer]
[Time for technical o ,
) Periodical maintenance and
1925 | maintenance ) ) For help, please contact your dealer.
i ) inspection are needed now.
Contact service engineer]
[Time for technical o ,
) Periodical maintenance and
1926 | maintenance , ) For help, please contact your dealer.
i , inspection are needed now.
Contact service engineer]
The remaining black ink
2010 | [Ink refill: Black] volume is below the specified | Refill the black ink.
amount.
The remaining magenta ink
2011 [Ink refill: Magenta] volume is below the specified | Refill the magenta ink.
amount.
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The remaining cyan ink
2012 | [Ink refill: Cyan] volume is below the specified | Refill the cyan ink.
amount.
The remaining yellow ink
2013 | [Ink refill: Yellow] volume is below the specified | Refill the yellow ink.
amount.
The remaining white ink
2014 | [Ink refill: White] volume is below the specified | Refill the white ink.
amount.
The remaining cleanin
[Cleaning Solution Out - . g . g : :
2015 solution volume is below the | Reéfill cleaning solution.
Add More] .
specified amount.
The remaining green ink
2016 | [Ink refill: Green] volume is below the specified | Refill the green ink.
amount.
The remaining orange ink
2017 | [Ink refill: Orange] volume is below the specified | Refill the orange ink.
amount.
The ambient temperature
decreases below the
2050 | [Temp Low] i Raise your room temperature.
operation assurance range
for the best print resuilt.
The ambient temperature
rises above the operation
2051 [Temp High] P Lower your room temperature.
assurance range for the best
print result.
The humidity is | th
. e humi .|ty 'S fowerthan Turn on the humidification function and wait for
2055 | [Humidity too Low] the operation assurance a while
range for the best print result. '
The humidity is higher than
2056 | [Humidity too High] the operation assurance Lower your room humidity.
range for the best print result.
The obstacle sensor has Remove such obstacle from the platen, flatten
[Obstacle Sensed on the )
2070 Platen] detected some obstacle on its surface, and press the OK button to clear the
the platen or print medium. error.
Remove such obstacle from the platen, flatten
its surface, and press the OK button to clear the
The obstacle sensor has orror P
Obstacle detected during | detected some obstacle on '
2071 ! ) g , ) Perform test printing and check the ejection
print] the platen or print medium ..
N from the head for any abnormalities.
while printing. C . .
If the ejection is abnormal, immediately perform
head cleaning to rectify the abnormality.
i The platen has been The gap between the medium's print surface
[Platen is too low ) )
2072 Adjust the position] detected to be too low when | and the print head is too large. Make
) P attempting to start printing. adjustments by raising the platen.
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Use the supplied USB hub.
Insert a USB flash memory into the slot, wait for
) No USB flash memory has 34 )
[USB flash drive Not ) L a couple of seconds, and perform the operation.
2100 been inserted into its i )
Ready] insertion slot Insert a USB flash memory into the slot again.
' If the problem persists, check on the format and
type of the USB flash memory.
Writing is not possible Use your PC to check free space on the USB
because there is not enough | flash memory.
2101 | [Not Enough Area] , 9 i
free space in the USB flash Insert the USB flash memory that has enough
memory. free space into the slot.
The USB flash drive cannot If the problem persists even after reactivatin
2102 | — (Log only) _ P P 9
be recognized. the printer, please contact your dealer.
Connect the USB flash memory to your PC for
checking the information stored in it.
, No target file exists in a USB | If you have a saved file (ARXG6E file, ARX6 file,
2105 No Files Detected
[No Files Detected] flash memory. ARXP file, or ARX4 file) in the USB flash
memory, check the contents of the USB flash
memory with a file viewer.
[Receiving History W/O There has been no receiving
2110 Error] g i history since the power was | Press the OK button to clear the error.
turned on.
B the Print Data Aut
, ) ecause the Fn _a anuo Press the OK button to clear the error.
[Activate Print Data Auto | Delete Enable function . ) )
2120 . , - When you use the receiving history, disable the
Delete] remains active, no receiving ) )
] ) ) Print Data Auto Delete option.
history menu is available.
Refill the ink following the on-screen
2930 [Detected refilling of ink Black ink was refilled to the instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
Refill the ink following the on-screen
, , Magenta ink was refilled to ) ! , ! wing
2931 [Detected refilling of ink the main tank in an incorrect instructions.
tank] wa To refill the ink, be sure to select the [Ink refill]
Yy menu item.
Refill the ink following the on-screen
2932 [Detected refilling of ink Cyan ink was refilled to the instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
Refill the ink following the on-screen
2933 [Detected refilling of ink Yellow ink was refilled to the | instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
Refill the ink following the on-screen
2934 [Detected refilling of ink White ink was refilled to the instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
, i Refill the ink following the on-screen
, ) Cleaning solution was refilled | ,
2935 [Detected refilling of ink o the main tank in an instructions.
tank] ) To refill the ink, be sure to select the [Ink refill]
incorrect way. )
menu item.
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Refill the ink following the on-screen
2936 [Detected refilling of ink Green ink was refilled to the | instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
Refill the ink following the on-screen
2937 [Detected refilling of ink Orange ink was refilled to the | instructions.
tank] main tank in an incorrect way. | To refill the ink, be sure to select the [Ink refill]
menu item.
Under the operation by the If the problem persists even after reactivatin
2300 | [Special work mode] erineop y P P 9
service engineer the printer, please contact your dealer.
[Power was off for long The power has been turned Follow the on-screen instructions and click the
2330 time off for a long time and a OK button to execute the recovery sequence.
Executing recovery recovery operation is The recovery sequence depends on the length
operation] required. of time the printer is left turned off.
A state in which no recovery | Follow the on-screen instructions and click the
2335 [Long Power—OFF operation has been executed | OK button to execute the recovery sequence.
Detection] since the power was turned The recovery sequence depends on the length
off for a long time. of time the printer is left turned off.
2340 | [Waste ink tank full] The waste ink tank is full. Empty the waste ink tank.
The waste ink tank will be full
2341 [Waste ink tank full] soonw ! W ! Empty the waste ink tank.
aste ink tank not in The waste ink tank is not
2342 W o ! I , W ! I Install the waste ink tank.
position] installed.
2345 | [Right door open] The right door is open. Close the right door.
2346 | [Left door open] The left door is open. Close the left door.
2347 | [Upper door open] The upper door is open. Close the upper door.
The mist fan door on the right
2350 | [Right mist fan dooropen] | .. . g Close the mist fan door on the right side.
side is open.
The mist fan door on the left
2351 [Left mist fan door open] o I Close the mist fan door on the left side.
side is open.
Door opening while printing Follow the on-screen instructions after closing
2355 | [Door opened)] has caused an emergency all doors and restart when the heads are
stop of the printer. capped.
Make sure that your PC is connected to the
printer, and resend the print data. If you have
trouble, restart your PC and the printer.
[PC Communication Data reception from the PC , ) y P ,
3000 This error will also occur "when the cable is
Error] has been suspended. . o
removed during data reception" or "when the
ongoing operation is canceled on the PC during
data reception".
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3001

[PC Communication
Error]

Data transmission to the PC
has been suspended.

Make sure that your PC is connected to the
printer, and start operating the PC tool over from
the beginning. If you have trouble, restart your
PC and the printer.

This error may also occur "when the cable is
removed during data transmission" or "when the
PC tool is caused to stop running on the PC
during data transmission".

3002

[PC Data Error]

Abnormal data has been
received from the PC.

Make sure that your PC is connected to the
printer, and resend the print data. If you have
trouble, restart your PC and the printer.

3003

[PC Data Error]

Unsupported data has been
received from the PC.

Update both the printer driver installed on the
PC and the firmware of the printer to the latest
version.

3004

[PC Data Error]

A communication error
between the PC and printer.

Ascertain whether the updated data of firmware
you try to send is correct or not.

Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again. If the problem is
still not remedied, restart your PC and the
printer.

If the problem persists, please contact your
dealer.

3005

[PC Data Error]

A communication error
between the PC and printer.

Ascertain whether the updated data of firmware
you try to send is correct or not.

Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again. If the problem is
still not remedied, restart your PC and the
printer.

If the problem persists, please contact your
dealer.

3010

[PC Data Error]

A communication error
between the PC and printer.

Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again. If the problem is
still not remedied, restart your PC and the
printer.

If the problem persists, please contact your
dealer.

3013

[PC Data Error]

A communication error
between the PC and printer.

Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again. If the problem is
still not remedied, restart your PC and the
printer.

If the problem persists, please contact your
dealer.
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3014

[PC Data Error]

A communication error
between the PC and printer.

Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again. If the problem is
still not remedied, restart your PC and the
printer.

If the problem persists, please contact your
dealer.

3015

[Can no longer receive
data]

Too much print data has
been sent from the PC during
the print operation.

Number of the print data sent from the PC
during any print operation should be up to 99.

3400

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARXG6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Create the print data once again.

If the problem persists, please contact your
dealer.

3401

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARXG6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Create the print data once again.

If the problem persists, please contact your
dealer.

3402

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARXG6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Create the print data once again.

If the problem persists, please contact your
dealer.

3407

[No Data in Print File]

Print data with no images
contained has been received
from the PC.

Check on the ARXGE file or ARX6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".

For example, please confirm the print range and
paper size for your software application through
the Print Preview function, etc. of Photoshop.

3408

[PC Data Error (too large)]

Abnormal data has been
received from the PC.

Note the error code and error message, and
notify your dealer.

3410

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARXG6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again.

Restart your PC and the printer.

If the problem persists, please contact your
dealer.

3411

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARXG6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again.

Restart your PC and the printer.

If the problem persists, please contact your
dealer.

292




Error message

>

Error code

Error message

Description

Remedy

3412

[PC Data Error]

Abnormal data has been
received from the PC.

Check on the ARXGE file or ARX6 file by means
of "GTX-6 Extra Colors ORGR File Viewer".
Make sure that your PC is connected to the
printer, and start communication between your
PC and the printer once again.

Restart your PC and the printer.

If the problem persists, please contact your
dealer.

4100

[USB flash drive Access
Error]

The file in the USB flash
memory is not accessible.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4101

[USB flash drive Access
Error]

File creation is not possible in

USB flash memory.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4103

[USB flash drive Access
Error]

The file in the USB flash
memory is not accessible.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4104

[USB flash drive Access
Error]

The file in the USB flash
memory is not readable.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4105

[USB flash drive Access
Error]

The file in the USB flash
memory is not writable.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4106

[llegal Format]

The file in the USB flash
memory is not accessible.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4108

[USB flash drive Access
Error]

The file in the USB flash
memory is not readable.

Check on the content of USB flash memory.
Insert a USB flash memory into the slot again,
and perform the required operation once more.
If the problem is still not remedied, restart the
printer and try to operate it once again.

4200

[Machine Error]

An error has been detected
in the display data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.
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4201

[Machine Error]

An error has been detected
in the display data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.

4202

[Machine Error]

An error has been detected
in the display data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.

4400

[Test print data Error]

An error has been detected
in the built-in test print data.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.

4401

[Test print data Error]

An error has been detected
in the built-in test print data.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.

4402

[Test print data Error]

An error has been detected
in the built-in test print data.

In the event that this error is displayed after
suspending the updating of firmware, please
start the updating operation over from the
beginning.

If the problem persists, please contact your
dealer.

4500

[Machine Error]

Network-related settings
have been failed.

Press the OK button to clear the error.
Contact your network setup manager and
network administrator.

If the problem persists, please contact your
dealer.

4501

[IP Address Setting Error]

Network-related settings
have been failed.

Press the OK button to clear the error.

Use the maintenance tool to set up a correct
static IP address and subnet mask value once
again.

4502

[Machine Error]

Network-related settings
have been failed.

Press the OK button to clear the error.
Contact your network setup manager and
network administrator.

If the problem persists, please contact your
dealer.

4503

[Machine Error]

Network-related settings
have been failed.

Press the OK button to clear the error.
Use the maintenance tool to set up a correct

static IP address of default gateway once again.
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Press the OK button to clear the error.
Network-related settings Use the maintenance tool to set up a correct
4504 | [IP Address Setting Error] _ g _ P
have been failed. static IP address and subnet mask value once
again.
Network-related settings
4505 | [Machine Error] ) G Press the OK button to clear the error.
have been failed.
Press the OK button to clear the error.
Network-related settings Make sure that the network settings are correct.
4510 | [Machine Error] . 9 . J .
have been failed. Restart the printer and redo the network filtering
settings if the settings are correct.
An error has been detected Press the OK button to clear the error.
5010 | [PC Data Error] in the current print data being | Create the print data again on the PC to load it
run. to the printer, and try the print operation again.
5020 | [Machine Error] An .error hars been detected If the Problem persists even after reactivating
during carriage control. the printer, please contact your dealer.
An error has been detected If the problem persists even after reactivatin
5021 [Machine Error] during the operation of the p P g
the printer, please contact your dealer.
heads.
An error has been detected If the problem persists even after reactivatin
5022 | [Machine Error] during the operation of the p P g
the printer, please contact your dealer.
heads.
An error has been detected . I
) : ) , If the problem persists even after reactivating
5080 | [Machine Error] during maintenance unit )
the printer, please contact your dealer.
control.
An error has been detected . I
) : ) , If the problem persists even after reactivating
5081 [Machine Error] during maintenance unit )
the printer, please contact your dealer.
control.
An error has been detected If the problem persists even after reactivatin
5094 | [Machine Error] ) ) p pers! v vating
during platen loading. the printer, please contact your dealer.
An error has been detected If the problem persists even after reactivatin
5095 | [Machine Error] _ _ P Persis’s ev vating
during platen unloading. the printer, please contact your dealer.
An error has been detected If the problem persists even after reactivatin
5096 | [Machine Error] while the platen is in p P g
i ) L the printer, please contact your dealer.
operation during printing.
Check and see if any source produces a loud
An error has been detected noise near the rintei P
5200 | [Machine Error] when the color A wiper was P o L
operated If the problem persists even after reactivating
P ' the printer, please contact your dealer.
Check and if d loud
An error has been detected noi: nzr;r ;Ze Iri:’zayr Source produices a fou
5201 [Machine Error] when the color B wiper was P o L
operated If the problem persists even after reactivating
P ' the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the rinte}:' P
5202 | [Machine Error] when the white A wiper was P o L
operated If the problem persists even after reactivating
P ' the printer, please contact your dealer.
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Check and if d loud
An error has been detected noizz nzr;r tieee Iri:tneyr SI?:hr;e ‘r)(:(tjleur::esefsi(s)rs
5203 | [Machine Error] when the white B wiper was p - p P
even after reactivating the printer, please
operated.
contact your dealer.
Check and see if any source produces a loud
An error was detected when noise near the rinte}:' If the Fr)oblem ersists
5204 | [Machine Error] the OR/GR A wiper was prirver. 1 e P
even after reactivating the printer, please
operated.
contact your dealer.
Check and see if any source produces a loud
An error was detected when noise near the rinteyr If the foblem ersists
5205 | [Machine Error] the OR/GR B wiper was p O p P
even after reactivating the printer, please
operated.
contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the printer.
5210 | [Machine Error] P . -
when the cap was operated. | If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the printer.

5211 | [Machine Error] prin -

when the cap was operated. | If the problem persists even after reactivating
the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud

when the color A suction noise near the printer.

5221 [Machine Error] . P . L
pump of the maintenance If the problem persists even after reactivating
unit was operated. the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud
when the color B suction noise near the printer.

5222 | [Machine Error] . P . N
pump of the maintenance If the problem persists even after reactivating
unit was operated. the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud
hen the white A suction noise near the printer.

5223 | [Machine Error] W ! i uet ! Pl , L
pump of the maintenance If the problem persists even after reactivating
unit was operated. the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud

5224 | [Machine Error] when the white B suction noise near the prin’Fer. o
pump of the maintenance If the problem persists even after reactivating
unit was operated. the printer, please contact your dealer.

An error was detected when | Check and see if any source produces a loud
the OR/GR A suction pum noise near the printer.

5225 | [Machine Error] T Asuction pump ! prin’ -
of the maintenance unit was | If the problem persists even after reactivating
operated. the printer, please contact your dealer.

An error was detected when | Check and see if any source produces a loud

5226 | [Machine Error] the OR/G.R B suction Pump noise near the prin’Fer. o
of the maintenance unit was | If the problem persists even after reactivating
operated. the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud
hile checking the operation | noise near the printer.

5229 | [Machine Error] wh *ing the operat ! prin .
of the suction pump of the If the problem persists even after reactivating
maintenance unit. the printer, please contact your dealer.
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Check that the IC stick is inserted tly.
) An error has been detected eck thatihe S KIS InSerte corr(?c y
5600 | [Machine Error] . . If the problem persists even after reactivating
during IC stick control. ,
the printer, please contact your dealer.
Check that the IC stick is inserted tly.
) An error has been detected eck thatihe S KIS InSerte corre.c y
5601 [Machine Error] . , If the problem persists even after reactivating
during IC stick control. ,
the printer, please contact your dealer.
Check that the IC stick is inserted tly.
) An error has been detected eck thatihe S KIS InSerte corre.c y

5602 | [Machine Error] . , If the problem persists even after reactivating

during IC stick control. ,
the printer, please contact your dealer.
Check and see if any source produces a loud
5951 [Machine Error] An error was detected in the | noise near the prin’Fer. o
platen motor. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the | noise near the printer.
5952 | [Machine Error] W ! ! Pr . L
platen motor. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the | noise near the printer.
5953 | [Machine Error] W ! ! Pr . L
platen motor. If the problem persists even after reactivating
the printer, please contact your dealer.
, Check to see if the obstacle sensor is covered
An error in the platen with somethin
6004 | [Machine Error] obstacle sensor has been 9 . L
detected If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
noise near the printer.
The platen motor stopped Restart the printer, and from the menu, select

6006 | [Machine Error] P PP . p .
abnormally. [Printer Setting] > [Platen settings] > [Platen

Break-in Run]. If the problem persists after three

platen break-in runs, please contact your dealer.
An error has been detected Check and see if any source produces a loud
while checking the noise near the printer.

6007 | [Machine Error] . 9 . P . L
mechanism for loading and If the problem persists even after reactivating
unloading the platen. the printer, please contact your dealer.

An error has been detected Check and see if any source produces a loud
while checking the noise near the printer.

6008 | [Machine Error] . g .. P . .
mechanism for raising and If the problem persists even after reactivating
lowering the platen. the printer, please contact your dealer.

Check and see if any source produces a loud
An error has been detected noise near the rinteyr P
6010 | [Machine Error] when writing to the EEPROM P o L
, If the problem persists even after reactivating
on the main board. ,
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the Irinteyr uree produ .
6011 [Machine Error] when writing to the flash P o L
) If the problem persists even after reactivating
ROM on the main board. ,
the printer, please contact your dealer.
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An error has been detected Check and tiee iflatny source produces a loud
noise near the printer.
6012 | [Machine Error] when writing to the flash P ) L
) If the problem persists even after reactivating
ROM on the main board. ,
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected , ,
[Do Not Allow Restore ) noise near the printer.
6016 when reading from the flash , L
Data] If the problem persists even after reactivating
ROM on the panel board. ,
the printer, please contact your dealer.
The battery on the main
6021 No Battery Detected For help, please contact your dealer.
[ & ] board is dead. P.P 4
An error has been detected MakeI sure that ng buttons on the operation
anel are pressed.
6031 [Machine Error] in the platen button at the P P ,
If the problem persists, please contact your
startup.
dealer.
Make sure that no buttons on the operation
An error has been detected anel a:Je ressed ! perat
6033 | [Machine Error] in the Cancel button at the P P N
If the problem persists, please contact your
startup.
dealer.
Mak h h i
An error has been detected ;:I ::;e :eztszz buttons on the operation
6034 | [Machine Error] in the Left-arrow button at the | © pressed.
If the problem persists, please contact your
startup.
dealer.
An error has been detected M;k; ::J;e :Zts 22 buttons on the operation
6035 | [Machine Error] in the Right-arrow button at P P N
If the problem persists, please contact your
the startup.
dealer.
An error has been detected MakeI sure that nz buttons on the operation
anel are pressed.
6036 | [Machine Error] in the Down-arrow button at P P ,
If the problem persists, please contact your
the startup.
dealer.
An error has been detected M;k; :tl;e ’;Zzts 23 buttons on the operation
6037 | [Machine Error] in the Up-arrow button at the P P N
If the problem persists, please contact your
startup.
dealer.
An error has been detected MakeI sure that nz buttons on the operation
anel are pressed.
6038 | [Machine Error] in the head cleaning button at P P )
If the problem persists, please contact your
the startup.
dealer.
An error has been detected MakeI sure that ng buttons on the operation
anel are pressed.
6039 | [Machine Error] in the MENU/OK button at | - P ,
If the problem persists, please contact your
the startup.
dealer.
Make sure that the corresponding button is not
An error has been detected ressed P 9
6040 | [Machine Error] in the print button on the right P ' i
) If the problem persists, please contact your
side at the startup. dealer
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Mak that th ding button is not
An error has been detected rzsz esdure at the corresponding button is no
6041 [Machine Error] in the print button on the left P ' )
) If the problem persists, please contact your
side at the startup.
dealer.
An error has been detected I\/zl:: esdure that the corresponding button is not
6042 | [Machine Error] in the platen stop button on P ' ,
) , If the problem persists, please contact your
the right side at the startup.
dealer.
Make sure that the corresponding button is not
An error has been detected ressed P 9
6043 | [Machine Error] in the platen stop button on Irl)‘the ro.blem ersists. please contact vour
the left side at the startup. P P P y
dealer.
Restart the printer and update the firmware
again. Check if the firmware update file is for the
) A panel board for a different 9 ) P
6045 | [Machine Error] . model of your printer.
model is installed. ,
If the problem persists, please contact your
dealer.
Restart the printer and update the firmware
The main board firmware and | again. Check if the firmware update file is for the
6046 | [Machine Error] panel board firmware are not | model of your printer.
compatible. If the problem persists, please contact your
dealer.
An error has been detected Check and see if any source produces a loud
in the connector connection noise near the printer.
6070 | [Machine Error] ! ! ! prin’ -
of the platen stop button on If the problem persists even after reactivating
the right side. the printer, please contact your dealer.
An error has been detected Check and see if any source produces a loud
in the connector connection noise near the printer.
6071 [Machine Error] P . -
of the platen stop button on If the problem persists even after reactivating
the left side. the printer, please contact your dealer.
Check to see if something gets caught in the
carriage or any foreign object exists inside the
, Carriage initialization has ) g Y |g _J , X , ns!
6105 | [Machine Error] been failed printer. Also, clean the printer interior.
' If the problem persists, please contact your
dealer.
Check and see if any source produces a loud
noise near the printer.
6109 | [Machine Error] Printing stopped abnormally. P , o
If the problem persists even after reactivating
the printer, please contact your dealer.
, Abnormal decrease in the Clean the carriage.
[Machine Error ) .
6130 ) carriage speed has been If the problem persists, please contact your
Adjust CR]
detected. dealer.
) Abnormal decrease in the Clean the carriage.
[Machine Error ) .
6131 ) carriage speed has been If the problem persists, please contact your
Adjust CR]
detected. dealer.
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Make sure you are powering the printer from a
stable power source.
6151 [Machine Error] An (?rror was detected in the Check and see if.any source produces a loud
carriage motor. noise near the printer.
If the problem persists even after reactivating
the printer, please contact your dealer.
Make sure you are powering the printer from a
stable power source.
An error was detected in the | Check and see if any source produces a loud
6152 | [Machine Error] , W ! . I . Y Souree produ !
carriage motor. noise near the printer.
If the problem persists even after reactivating
the printer, please contact your dealer.
Make sure you are powering the printer from a
stable power source.
An error was detected in the | Check and see if any source produces a loud
6153 | [Machine Error] , , any P
carriage motor. noise near the printer.
If the problem persists even after reactivating
the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6221 [Machine Error] in the temperature of color C L
head A If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected i< disconnected
6222 | [Machine Error] in the temperature of color o L
head B If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6223 | [Machine Error] in the temperature of white C L
head A If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected i< disconnected
6224 | [Machine Error] in the temperature of white o L
head B If the problem persists even after reactivating
' the printer, please contact your dealer.
) Ascertain whether or not the cable for the heads
An error was detected in the is disconnected
6225 | [Machine Error] temperature of OR/GR head o L
A If the problem persists even after reactivating
' the printer, please contact your dealer.
, Ascertain whether or not the cable for the heads
An error was detected in the i< disconnected
6226 | [Machine Error] temperature of OR/GR head o L
B If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected.
6231 [Machine Error] . o . L
in the voltage of color head A. | If the problem persists even after reactivating
the printer, please contact your dealer.
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Ascertain whether or not the cable for the heads
An error has been detected is disconnected.
6232 | [Machine Error] . o . L
in the voltage of color head B. | If the problem persists even after reactivating
the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6233 | [Machine Error] in the voltage of white head C L
A If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected i< disconnected
6234 | [Machine Error] in the voltage of white head T L
B If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error was detected in the | is disconnected.
6235 Machine Error’
[ ] voltage of OR/GR head A. If the problem persists even after reactivating
the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error was detected in the | is disconnected.
6236 Machine Error
[ ] voltage of OR/GR head B. If the problem persists even after reactivating
the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6241 [Machine Error] in the FFC connection of o L
color head A If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6242 | [Machine Error] in the FFC connection of C L
color head B If the problem persists even after reactivating
' the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected i< disconnected
6243 | [Machine Error] in the FFC connection of o L
) If the problem persists even after reactivating
white head A. .
the printer, please contact your dealer.
Ascertain whether or not the cable for the heads
An error has been detected is disconnected
6244 | [Machine Error] in the FFC connection of C —
white head B If the problem persists even after reactivating
' the printer, please contact your dealer.
) Ascertain whether or not the cable for the heads
An error was detected in the i< disconnected
6245 | [Machine Error] FFC connection of OR/GR o L
head A If the problem persists even after reactivating
' the printer, please contact your dealer.
) Ascertain whether or not the cable for the heads
An error was detected in the is disconnected
6246 | [Machine Error] FFC connection of OR/GR o e
head B If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the printer.
6251 | [Machine Error] / ! prin .
in the fan of color head A. If the problem persists even after reactivating
the printer, please contact your dealer.
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Check and see if any source produces a loud
An error has been detected noise near the printer.
6252 | [Machine Error] . ! Pr . L
in the fan of color head B. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the printer.
6253 Machine Error’
[ ] in the fan of white head A. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the printer.
6254 | [Machine Error] . . ! Pr . o
in the fan of white head B. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the | noise near the printer.
6255 Machine Error’
[ ! ] fan of OR/GR head A. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the | noise near the printer.
6256 Machine E
[Machine Error] fan of OR/GR head B. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
The software detected an noise near the printer.
7000 | [Machine Error] ) P ) o
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
7012 | [Machine Error] The software detected an noise near the prin’Fer. o
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
The software detected an noise near the printer.
7013 | [Machine Error] . ! Pr . L
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
The software detected an noise near the printer.
7015 | [Machine Error] , P . I
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
The software detected an noise near the printer.
7020 | [Machine Error] , P . _—
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
The software detected an noise near the printer.
7021 [Machine Error] . P . I
internal error. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the rinte}:' P
8040 | [Machine Error] in the sensor of the black sub P o L
tank If the problem persists even after reactivating
' the printer, please contact your dealer.
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Check and see if any source produces a loud
An error has been detected noise near the Irinteyr Hree procu !
8041 [Machine Error] in the sensor of the yellow P o L
sub tank If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the rinte}:' If the Fr)oblem ersists
8042 | [Machine Error] in the sensor of the cyan sub p o p P
tank even after reactivating the printer, please
' contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the rinteyr P
8043 | [Machine Error] in the sensor of the magenta P o L
sub tank If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the Irinteyr uree produ !
8044 | [Machine Error] in the sensor of white A sub P L L
tank If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
An error has been detected noise near the rintei P
8045 | [Machine Error] in the sensor of white B sub P o L
tank If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the | noise near the printer.
8046 | [Machine Error] P ) o
sensor of the green sub tank. | If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
An error was detected in the noise near the rinteyr P
8047 | [Machine Error] sensor of the orange sub P o L
tank If the problem persists even after reactivating
' the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the black sub noise near the printer.
8060 | [Machine Error] ! ) _I ! ! Pl , L
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
8061 [Machine Error] Failed .to ﬂll the yellow sub noise near the prin’Fer. o
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the cyan sub tank | noise near the printer.
8062 | [Machine Error] ared fo il the cyan su ! prin’ -
with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the magenta sub | noise near the printer.
8063 | [Machine Error] . g P . -
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the white A sub noise near the printer.
8064 | [Machine Error] o P . —
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
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Check and see if any source produces a loud
Failed to fill the white B sub noise near the printer.
8065 | [Machine Error] ! ) _I i ! ! Pl , L
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the green sub noise near the printer.
8066 | [Machine Error] o g P . —
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the orange sub noise near the printer.
8067 | [Machine Error] ned fol gesu ! prin’ o
tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to fill the cleanin noise near the printer.
8069 | [Machine Error] _ ning b -
solution sub tank with ink. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to discharge ink from noise near the printer.
8070 | [Machine Error] ' seharge | ! prin’ -
the black sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to discharge ink from | noise near the printer.
8071 [Machine Error] 9 P . S
the yellow sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
8072 | [Machine Error] Failed to discharge ink from | noise near the prin’Fer. o
the cyan sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to discharge ink from | noise near the printer.
8073 | [Machine Error] I ! ge! ! Pl , L
the magenta sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
8074 | [Machine Error] Failed .to discharge ink from | noise near the prin’Fer. o
the white A sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to discharge ink from noise near the printer.
8075 | [Machine Error] ned o discharge | ! prin’ -
the white B sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
8076 | [Machine Error] Failed to discharge ink from | noise near the prin’Fer. o
the green sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
Check and see if any source produces a loud
Failed to discharge ink from noise near the printer.
8077 | [Machine Error] ' seharge | ! prin .
the orange sub tank. If the problem persists even after reactivating
the printer, please contact your dealer.
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Error message

>

Error code

Error message

Description

Remedy

8080

[Machine Error]

An error has been detected
in the remaining volume
sensor of the black main
tank.

8081

[Machine Error]

An error has been detected
in the remaining volume
sensor of the yellow main
tank.

8082

[Machine Error]

An error has been detected
in the remaining volume

sensor of the cyan main tank.

8083

[Machine Error]

An error has been detected
in the remaining volume
sensor of the magenta main
tank.

8084

[Machine Error]

An error has been detected
in the remaining volume
sensor of the white main
tank.

8086

[Machine Error]

An error was detected in the
remaining volume sensor of
the green main tank.

8087

[Machine Error]

An error was detected in the
remaining volume sensor of
the orange main tank.

8089

[Machine Error]

An error has been detected
in the remaining volume
sensor of the cleaning
solution main tank.

Check and see if any source produces a loud
noise near the printer.

If the problem persists even after reactivating
the printer, please contact your dealer.

8094

[Machine Error]

Unable to agitate the white
main tank.

Check and see if any source produces a loud
noise near the printer.

If the problem persists even after reactivating
the printer, please contact your dealer.

8100

[Machine Error]

Failed to fill the black head
with ink.

8101

[Machine Error]

Failed to fill the yellow head
with ink.

8102

[Machine Error]

Failed to fill the cyan head
with ink.

8103

[Machine Error]

Failed to fill the magenta
head with ink.

8104

[Machine Error]

Failed to fill the white A head
with ink.

8105

[Machine Error]

Failed to fill the white B head
with ink.

8106

[Machine Error]

Failed to fill the green head
with ink.

8107

[Machine Error]

Failed to fill the orange head
with ink.

Check and see if any source produces a loud
noise near the printer.

If the problem persists even after reactivating
the printer, please contact your dealer.
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Error message

>

Error code Error message Description Remedy
[During humidifier water An error has been detected Make sure the humidifier is supplied with water.
8200 | supply when water was supplied to | Check and see if the water supply tube is
an error was detected] the humidifier unit. disconnected, torn, broken, or contaminated
[During humidifier water An error has been detected with air.
8201 | supply when water was supplied to | If the problem persists, please contact your
an error was detected] the humidifier unit. dealer.
Make sure that the water supply pressure to the
[During humidifier water An error has been detected e , PPy P
, humidifier is not too high.
8202 | supply when water was supplied to i
o ) If the problem persists, please contact your
an error was detected] the humidifier unit.
dealer.
Check and see if any source produces a loud
An error has been detected noise near the rinteyr P
8203 | [Humidifier drainage error] | when draining from the P o o
. ) If the problem persists even after reactivating
humidifier unit. ,
the printer, please contact your dealer.
Make sure that the humidifier drain tank is
8210 [Humi. drain tank not in The humidifier drain tank is installed.
position] not installed. If the problem persists even after reactivating
the printer, please contact your dealer.
The humidifier drain tank is
8211 | [Humidifier crain tank full] | dmidiier dra '
Th.e hurmidifior drain @k wil Empty the humidifier drain tank.
umidifi i wi
8212 | [Humidifier drain tank full]
be full soon.
Check and see if any source produces a loud
An error has been detected noise near the printer.
8220 | [Humidification error] . e P . S
in the humidification fan. If the problem persists even after reactivating
the printer, please contact your dealer.
An error has been detected Check and see if any source produces a loud
in the remaining volume noise near the printer.
8221 | [Machine Error] 9 print -
sensor of the water supply If the problem persists even after reactivating
tank of the humidifier unit. the printer, please contact your dealer.

In the event that other error codes than those that are mentioned above are displayed, please contact your dealer for

help.
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How to resolve carriage errors 6130 and 6131

(1) Unlock and open the right-side cover.

=~ Keyhole

i

<IMPORTANT>
. Loosen the two bolts until there is a gap between each bolt's face and the part.

(3) Tighten the two bolts on the carriage belt holder to 3.5 N-m.

(4) Close and lock the right-side cover.

Contact your dealer if you have any questions.
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10-1. Apparatus

Printing method Direct cloth printing by color ink jet printing
Head Quantity 6 pcs.
Resolution Maximum 1200 dpi x 1200 dpi
Ink Type Water-based ink
Number of colors | 7 colors of CMYKWORGR
Material supply method Platen transportation method
Supported Size 14 in. (355.6 mm) x 16 in. (406.4 mm) (standard platen)
media Thickness Up to 1.2 in. (30 mm)
(size/thickness)
Printable area Maximum 24.2in. (615 mm) x 24.2 in. (615 mm)
Interface LAN (10BASE-T, 100BASE-TX, 1000BASE-T), USB flash memory
73.6 in. (width) x 75.6 in. (depth) x 57.5 in. (height) (1870 mm (width) x 1920
, , mm (depth) x 1460 mm (height)) (Platen is accommodated)
External dimensions ) . . . . .
73.6 in. (width) x 81.1 in. (depth) x 57.5 in. (height) (1870 mm (width) x 2060
mm (depth) x 1460 mm (height)) (including platen)
Weight 690 kg (1521 Ib) (including platen)
Power Single phase, 200 V-240 V, 50/60 Hz
Power When active: 5 A max.
consumptions
Recomm Temperature: 18 W Recommended print environment
ended to 30°C (644 to Printing-guaranteed range ™ \é\{orking environment
. 86°F) 85 orage environment
print Humidity: 35 to 80
environ
85%
ment , 704
(no condensation)
Installation Temper Temperature: 10 60
conditions ature , to 35°C (50 to 50 -
. Working
Environment and Environ 95°F) 404
humidity | Humidity: 20 to gé:
environ 85%
ment (no condensation) 20 =
Temperature: 0 to ) T ) | ) )
40°C (32to 10 15 1820 25 2930 35 40
Sto'jage 104°F) Temperature (°C) x0394
f’n”(;’r']rton Humidity: 20 to
85%
(no condensation)
Print direction Bidirectional, unidirectional
Conveyor oven (recommended): 160°C (320 °F) for 3.5 minutes, or heat press:
Fixation conditions 180°C (356°F) for 35 seconds
* The time taken for fixation differs depending on the fixation device.
Pretreatment is required when you print using white ink.
Pretreatment . . . .
Apply pretreatment with a pretreatment device and dry it up with a heat press.
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10-2. Software

0S

Windows 10 (64bit), Windows 11 (64bit), mac OS 12.0 Monterey, mac OS 13.0
Ventura

* Both Intel, M1 and M2 are supported for macOS.

Min. operating environment

CPU with 2 GHz or above
RAM with 4 GB or above

Display resolution

SXGA (1280 x 1024) or higher

Output Printer driver, GTX Graphics Lab
Application software for high-level | Adobe® Photoshop CC, Adobe® lllustrator CC, CorelDRAW® 2021/2022
image editing (Windows)

309



10-3. Ink, cleaning solution, pretreatment

10-3-1. Ink

Name Black / Magenta / Cyan / Yellow / Orange / Green / White

Use expiration date Expiration date printed on the bottle (supposing storage at normal temperature)

Storage temperature 0 to0 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.
* Take care not to lose the IC stick.
Content 9L
External
dimensions in 10.0 in. (width) x 10.0 in. (depth) x 15.9 in. (height) (254 mm (width) x 254 mm

transport 9L (1-piece set)

condition

(depth) x 405 mm (height))

10-3-2. Cleaning solution

Name Cleaning solution (for GTX-6)

Use expiration date Expiration date on the container (supposing storage at normal temperature)

Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.
-Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 9L
External
dimensions in 10.0 in. (width) x 10.0 in. (depth) x 15.9 in. (height) (254 mm (width) x 254 mm

9L (1-piece set)

transport (depth) x 405 mm (height))

condition

10-3-3. Pretreatment

Name Pretreatment
Use expiration date Expiration date on the outer case (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.

-Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 20 kg (44 Ib), 5 kg (11 Ib)
External 20 kg (44 Ib) 10.4 in. (width) x 10.4 in. (depth) x 15.9 in. (height) (265 mm (width) x 265 mm
dimensions in (1-piece set) (depth) x 405 mm (height))
transport 5kg (11 Ib) 12.6 in. (width) x 18.0 in. (depth) x 12.5 in. (height) (320 mm (width) x 456 mm
condition (4-piece set) (depth) x 318 mm (height))
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Specifications

>

10-4. About consumable supplies, optional items and replacement parts

About consumable supplies, optional items and replacement parts

e  Consumable supplies: Components required for the printing operation

e  Optional items: Available items through purchase order according to customers' usage status
e Replacement parts: Components for which periodic maintenance needs to be performed for you to optimize the

printer's operation
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Consumable supplies Code No. Optional items Code No.
Black ink bottle 9L | GCX-6K09L-1 Platen size SS SB7001
Magenta ink bottle 9L | GCX-6MO9L-1 (7.3in. (185 mm) x 9.1 in. (230 mm))
Cyan ink bottle 9L | GCX-6CO9L-1 Platen sheet 7x8 SB7002
Yellow ink bottle 9L | GCX-6Y09L-1 Platen size S SCA870
White ink bottle 9L | GCX-6WO09L (10.6 in. (270 mm) x 12.6 in. (320 mm))
Cleaning solution (for GTX-6) 9L | GCX-6EQ09L Platen sheet 10x12 SC3058
Orange ink bottle 9L | GC600OR0O9L Platen size M SCA8T1
Green ink bottle 9L | GC60GRO9L (14.6in. (370 mm) x 16.5 in. (420 mm))
5kg (111lb) | GCX-4PS05 Platen sheet 14x16 SC4577
Pretreatment
20 kg (44 Ib) | GCX-4PS20 Platen size L
SC4872
Maintenance kit A (16.5in. (420 mm) x 18.5 in. (470 mm))
<Printer-supplied items> Platen sheet 16x18 SC3060
Wiper Platen size XL
; . . SC4873

Cap foam/Cap chip SC7362 (18.2in. (463 mm) x 22.2 in. (565 mm))

Flushing foam Platen sheet 18x22 SC3541

Plastic gloves 2 Platen size XXL

. . . SC4874

Clean stick R 10 pcs. (24.2in. (615 mm) x 24.2 in. (615 mm))

Clean stick T 10 pcs. Platen sheet 24x24 SC3542
Carriage foam SC7363 Platen size S assembly X6F SCH136
Clean stick R 50-piece set SB7008 (10.9in. (277 mm) x 12.9 in. (327 mm))

Clean stick T 50-piece set SC0032 Platen sheet brush 10X12 X6 SC6156
Cap foam/Cap chip SC7360 Platen size M assembly X6F (Provided with
Flushing foam SC7361 the printer) SC6137
Wiper SC7359 (14.9in. (378 mm) x 16.9 in. (429 mm))
Mist fan filter set Platen sheet brush 14X16 X6 SC6157
<Printer-supplied items> Platen size L assembly X6F
. . SC5066 . . SC6138
Mist fan filter 2-piece set (16.9in. (429 mm) x 18.9 in. (480 mm))
Plastic gloves 2 Platen sheet brush 16X18 X6 SC6158
Platen size XL assembly X6F
. . SC6139
(18.9in. (480 mm) x 22.9 in. (582 mm))
Platen sheet brush 18X22 X6 SC6159
Water tank supply ASSY SC5068
Water T6040 20M SC5070
L-shaped fitting 06-06 SC5071
AC cord PSE SC6043
AC cord UL/CSA SC6044
AC cord EUR SC6045
AC cord China SC6047
AC cord AU SC6046




Replacement parts Code No.
White head A
White head B SC33%5
Color head A
Color head B SC3340
OR/GR head A
OR/GR head B SC3340
Main tank filter (color) SB7680
Main tank filter (OR/GR) SB7680
Main tank filter (cleaning solution) SB7680
Main tank filter (white) SC1643
Return filter (white) SC1695
Circulation filter (white) SB7680
Head filter (color) SB7093
Head filter (OR/GR) SB7093
Head filter (white) SC1695
Cleaning cup SB6925
Waste ink tank SC4946
Waste water tank SC4946
Humidifier fan filter SC5138
Encoder strip SC2555
Encoder sensor board SC3262
CR origin sensor LG2239
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Cleaning solution (for GTX-6) Pretreatment Pretreatment
9L 5kg (11 1b) 20 kg (44 Ib)

Maintenance kit A Mist fan filter set

Cap foam

Carriage foam Clean stick R Clean stick T . Flushing foam
% / "L
Water tank supply ASSY Main tank filter
White head Color head OR/GR head (white)

D D &
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Open Source Licensing Remarks
This product uses one or more of the following open software, depending on the features which each product has.
gSOAP / SNMP Software from West Hawk / OpenSSL / Lua This software is used in all our products.

MIT Kerberos
This software is used in the product which supports the Kerberos Authentication.

Cyrus SASL / OpenLDAP
This software is used in the product which supports LDAP.

expat/ LibTIFF/ libjpeg/ libpng
This software is used in the product which supports RSS Reader, XPS emulation for Direct Print feature, or PDF
creation module.

libstrophe/json-c
This software is used in the product which supports Google Cloud Print.

Open SSH
This software is used in the product which supports Secure Scan FTP.

Open NFC / linux_libnfc-nci
This software is used in the product which supports NFC.

USB Host Driver (in FreeBSD)
This software is used in the product which supports Direct Print / Scan to USB.

mDNSResponder
This software is used in the product which supports mDNS.

wpa_supplicant and hostapd
This software is used in the product which supports Wireless LAN or IEEE802.1X.

T-Kernel
This software is used in the product as Operating System.
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The following is the full text.

Part of the software embedded in this product is gSOAP software.
Portions created by gSOAP are Copyright (C) 2001 2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided
that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear
in supporting documentation. This software is provided "as is" without express or implied warranty.
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This product includes SNMP software from WestHawk Ltd.
Copyright (C) 2000, 2001, 2002 by Westhawk Ltd
Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided

that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear
in supporting documentation. This software is provided "as is" without express or implied warranty.
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MIT Kerberos statements

MIT Kerberos license copyright Version 1.6.3

Copyright (C) 1985-2007 by the Massachusetts Institute of Technology. All rights reserved.

Export of this software from the United States of America may require a specific license from the United States
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before
exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its documentation for
any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that
both that copyright notice and this permission notice appear in supporting documentation, and that the name of M.I.T.
not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
Furthermore if you modify this software you must label your software as modified software and not distribute it in such a
fashion that it might be confused with the original MIT software. M.I.T. makes no representations about the suitability of
this software for any purpose.

It is provided "as is" without express or implied warranty.

THIS SOFTWARE IS PROVIDED "AS I1S" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

Copyright (C) 1998 by the FundsXpress, INC. All rights reserved.

Export of this software from the United States of America may require a specific license from the United States
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before
exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this

software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this permission notice appear in supporting
documentation, and that the name of FundsXpress. not be used in advertising or publicity pertaining to distribution of the
software without specific, written prior permission. FundsXpress makes no representations about the suitability of this
software for any purpose. It is provided "as is" without express or implied warranty.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

Copyright 1993, 1995 by OpenVision Technologies, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice
and this permission notice appear in supporting documentation, and that the name of OpenVision not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission. OpenVision
makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or
implied warranty.

317



OPENVISION DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL OPENVISION BE

LIABLE FORANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

Copyright 2000 by Zero-Knowledge Systems, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice

appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation,
and that the name of Zero-Knowledge Systems, Inc. not be used in advertising or publicity pertaining to distribution of
the software without specific, written prior permission. Zero-Knowledge Systems, Inc. makes no representations about
the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

ZERO-KNOWLEDGE SYSTEMS, INC. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
ZERO-KNOWLEDGE SYSTEMS, INC. BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTUOUS ACTION, ARISING OUT OF OR
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2006 Red Hat, Inc.
Portions copyright (c) 2006 Massachusetts Institute of Technology All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Red Hat, Inc., nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES,

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Copyright 1995,1996,2003,2004 by Sun Microsystems, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice
and this permission notice appear in supporting documentation, and that the name of Sun Microsystems not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission. Sun
Microsystems makes no representations about the suitability of this software for any purpose. It is provided "as is"
without express or implied warranty.

SUN MICROSYSTEMS DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL SUN MICROSYSTEMS BE
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

COPYRIGHT (C) 2006-2007

THE REGENTS OF THE UNIVERSITY OF MICHIGAN ALL RIGHTS RESERVED.

Permission is granted to use, copy, create derivative works and redistribute this software and such derivative works for
any purpose, so long as the name of The University of Michigan is not used in any advertising or publicity pertaining to
the use of distribution of this software without specific, written prior authorization. If the above copyright notice or any
other identification of the University of Michigan is included in any copy of any portion of this software, then the
disclaimer below must also be included.

THIS SOFTWARE IS PROVIDED AS IS, WITHOUT REPRESENTATION FROM THE UNIVERSITY OF MICHIGAN
AS TO ITS FITNESS FOR ANY PURPOSE, AND WITHOUT WARRANTY BY THE UNIVERSITY OF MICHIGAN OF
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE REGENTS OF THE UNIVERSITY OF
MICHIGAN SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING SPECIAL, INDIRECT, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, WITH RESPECT TO ANY CLAIM ARISING OUT OF OR IN CONNECTION WITH
THE USE OF THE SOFTWARE, EVEN IF IT HAS BEEN OR IS HEREAFTER ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Copyright (c) 2002 Naval Research Laboratory (NRL/CCS)
Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided that both
the copyright notice and this permission notice appear in all copies of the software, derivative works or modified versions,

and any portions thereof.

NRLALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" CONDITION AND DISCLAIMS ANY LIABILITY OF
ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Copyright (C) 1986 Gary S. Brown. You may use this program, or code or tables extracted from it, as desired without
restriction.

Copyright (c) 1994 CyberSAFE Corporation

Copyright (c) 1993 Open Computing Security Group
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Cyrus SASL statements

The Cyrus SASL License

Copyright (c) 1998-2003 Carnegie Mellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived from this software
without prior written permission. For permission or any other legal details, please contact.

Office of Technology Transfer
Carnegie Mellon University
5000 Forbes Avenue
Pittsburgh, PA 15213-3890

(412) 268-4387, fax: (412) 268-7395
tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by Computing Services at Carnegie Mellon University (http://www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO HIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL CARNEGIE MELLON UNIVERSITY BE LIABLE FOR
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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OpenSSL statements

OpenSSL License

Copyright (c) 1998-2019 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived
from this software without prior written permission. For written permission, please contact openssicore@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without
prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (c) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so
as to conform with Netscapes SSL.
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This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The
following conditions apply to all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just the
SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the
holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is
used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the
form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can
be left out if the rouines from the library being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must
include an acknowledgement: "This product includes software written by Tim Hudson ({jh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e.
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]
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OpenLDAP Statements

This product includes software developed by the OpenLDAP Project.

Unless otherwise expressly stated herein, The OpenLDAP Public License Version 2.8 shall be applied to individual files.

Copyright 1998-2007 The OpenLDAP Foundation All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the
OpenLDAP Public License.

A copy of this license is available in the file LICENSE in the top-level directory of the distribution or, alternatively, at
<http://wmww.OpenLDAP.org/license.html>.

Portions Copyright 1999 Lars Uffmann.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the
OpenLDAP Public License.

Portions Copyright (c) 1990, 1993-1996 Regents of the University of Michigan. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that this notice is preserved and that due credit
is given to the University of Michigan at Ann Arbor. The name of the University may not be used to endorse or promote
products derived from this software without specific prior written permission. This software is provided “as is” without
express or implied warranty.

Portions Copyright (c) 1999, 2000 Novell, Inc. All Rights Reserved.

THIS WORK IS SUBJECT TO U.S. AND INTERNATIONAL COPYRIGHT LAWS AND

TREATIES. USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF
THE OPENLDAP PUBLIC LICENSE, A COPY OF WHICH IS AVAILABLE AT
HTTP:/WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF
THE DISTRIBUTION. ANY USE OR EXPLOITATION OF THIS WORK OTHER THAN AS AUTHORIZED IN VERSION
2.0.1 OF THE OPENLDAP PUBLIC LICENSE, OR OTHER PRIOR WRITTEN CONSENT FROM NOVELL, COULD
SUBJECT THE PERPETRATOR TO CRIMINAL AND CIVIL LIABILITY.

Portions Copyright (c) The Internet Society (1997).

See RFC 2251 for full legal notices.

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are
permitted provided that the following conditions are met:
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1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of conditions, and
the following disclaimer in the documentation and/or other materials provided with the distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a version
number. You may use this Software under terms of this license revision or under the terms of any subsequent revision of
the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS “AS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION, ITS

CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT,
INDIRECT,INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote the sale, use or
other dealing in this Software without specific, written prior permission. Title to copyright in this Software shall at all times
remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation. Copyright 1999-2003 The OpenLDAP Foundation,
Redwood City,California, USA. All Rights Reserved.

Permission to copy and distribute verbatim copies of this document is granted.

A number of files contained in OpenLDAP Software contain a statement:

USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF THE
OPENLDAP PUBLIC LICENSE, A COPY OF WHICH IS AVAILABLE AT
HTTP://WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF
THE DISTRIBUTION.

The following is a verbatim copy of version 2.0.1 of the OpenLDAP Public License referenced in the above statement.

The OpenLDAP Public License

Version 2.0.1, 21 December 1999

Copyright 1999, The OpenLDAP Foundation, Redwood City, California, USA. All Rights

Reserved.

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a
copy of this document.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "OpenLDAP" must not be used to endorse or promote products derived from this Software without prior
written permission of the OpenLDAP Foundation. For written permission, please contact foundation@openidap.org.

4. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear in their names
without prior written permission of the OpenLDAP Foundation. OpenLDAP is a trademark of the OpenLDAP Foundation.

5. Due credit should be given to the OpenLDAP Project (http://www.openldap.org/).

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS “AS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

RFC 2251 Full Copyright Statement
Copyright (c) The Internet Society (1997). All Rights Reserved.

This document and translations of it may be copied and furnished to others, and derivative works that comment on or
otherwise explain it or assist in its implementation may be prepared, copied, published and distributed, in whole or in part,
without restriction of any kind, provided that the above copyright notice and this paragraph are included on all such
copies and derivative works. However, this document itself may not be modified in any way, such as by removing the
copyright notice or references to the Internet Society or other Internet organizations, except as needed for the purpose of
developing Internet standards in which case the procedures for copyrights defined in the Internet Standards process
must be followed, or as required to translate it into languages other than English.

The limited permissions granted above are perpetual and will not be revoked by the Internet Society or its successors or
assigns.

This document and the information contained herein is provided on an "AS IS" basis and THE INTERNET SOCIETY
AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY WARRANTY THAT THE USE OF THE

INFORMATION HEREIN WILL NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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expat

Copyright (C) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (C) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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Libtiff Copyright and License

Use and Copyright

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon
Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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libjpeg

this software is based in part on the work of the Independent JPEG Group
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libpng

This copy of the libpng notices is provided for your convenience. In case of
any discrepancy between this copy and the notices in the file png.h that is
included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following
this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.2, April 25, 2013, are
Copyright (c) 2004, 2006-2012 Glenn Randers-Pehrson, and are
distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors

Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are
Copyright (c) 2000-2002 Glenn Randers-Pehrson, and are

distributed according to the same disclaimer and license as libpng-1.0.6
with the following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux
Eric S. Raymond
Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our
efforts or the library will fulfill any of your particular purposes
orneeds. This library is provided with all faults, and the entire

risk of satisfactory quality, performance, accuracy, and effort is with
the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are
Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are

distributed according to the same disclaimer and license as libpng-0.96,
with the following individuals added to the list of Contributing Authors:

Tom Lane
Glenn Randers-Pehrson
Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are
Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88,
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Specifications

with the following individuals added to the list of Contributing Authors:

John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs

Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are
Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors"
is defined as the following set of individuals:

Andreas Dilger
Dave Martindale
Guy Eric Schalnat
Paul Schmidt

Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,

including, without limitation, the warranties of merchantability and of

fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary,

or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this
source code, or portions hereof, for any purpose, without fee, subject
to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not
be misrepresented as being the original source.

3. This Copyright notice may not be removed or altered from any
source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without
fee, and encourage the use of this source code as a component to
supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be
appreciated.

A"png_get_copyright" function is available, for convenient use in "about"
boxes and the like:
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printf("%s",png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the
files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a
certification mark of the Open Source Initiative.

Glenn Randers-Pehrson

glennrp at users.sourceforge.net
April 25, 2013
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libstrophe

Copyright (c) 2005-2009 Collecta, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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json-c
Copyright (c) 2004, 2005 Metaparadigm Pte Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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Specifications >

Open SSH

This file is part of the OpenSSH software.

The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.

OpenSSH contains no GPL code.

* Copyright (¢) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland

* All rights reserved

* As far as | am concerned, the code | have written for this software

* can be used freely for any purpose. Any derived versions of this

* software must be clearly marked as such, and if the derived work is
* incompatible with the protocol description in the RFC file, it must be
* called by a name other than "ssh" or "Secure Shell".

[Tatu continues]

* However, | am not implying to give any licenses to any patents or

* copyrights held by third parties, and the software includes parts that

* are not under my direct control. As far as | know, all included

* source code is used in accordance with the relevant license agreements
* and can be used freely for any purpose (the GNU license being the most
* restrictive); see below for details.

[However, none of that term is relevant at this point in time. All of these restrictively licenced software
components which he talks about have been removed from OpenSSH, i.e.,

- RSAis no longer included, found in the OpenSSL library

- IDEAs no longer included, its use is deprecated

- DES is now external, in the OpenSSL library

- GMP is no longer used, and instead we call BN code from OpenSSL
- Zlib is now external, in a library

- The make-ssh-known-hosts script is no longer included

- TSS has been removed

- MD5 is now external, in the OpenSSL library

- RC4 support has been replaced with ARC4 support from OpenSSL
- Blowfish is now external, in the OpenSSL library

[The licence continues]

Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can be
found e.g. at "http://www.cs.hut.fi/crypto™.

The legal status of this program is some combination of all these permissions and restrictions. Use only at
your own responsibility. You will be responsible for any legal consequences yourself; | am not making any
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claims whether possessing or using this is legal or not in your country, and | am not taking any responsibility
on your behalf.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY

FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS I1S" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR APARTICULAR PURPOSE. THE ENTIRE RISKAS

TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILLANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED

TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

4)
The Rijndael implementation by Vincent Rijmen, Antoon Bosselaers and Paulo Barreto is in the public domain
and distributed
with the following license:

* @version 3.0 (December 2000)

*

* Optimised ANSI C code for the Rijndael cipher (now AES)

* @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>

* @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
* @author Paulo Barreto <paulo.barreto@terra.com.br>

*

* This code is hereby placed in the public domain.

* THIS SOFTWARE IS PROVIDED BY THE AUTHORS "AS IS" AND ANY EXPRESS

* OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

* WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE

* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;

OR
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* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY

OF LIABILITY,

* WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
* OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

* EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

One component of the ssh source code is under a 3-clause BSD license, held by the University of California,
since we pulled these parts from original Berkeley code.

* Copyright (c) 1983, 1990, 1992, 1993, 1995

* The Regents of the University of California. All rights reserved.

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.
* 3. Neither the name of the University nor the names of its contributors
* may be used to endorse or promote products derived from this software
without specific prior written permission.

*

*

* THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS

“AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

Remaining components of the software are provided under a standard 2-term BSD licence with the following
names as copyright holders:

Markus Friedl
Theo de Raadt
Niels Provos
Dug Song
Aaron Campbell
Damien Miller
Kevin Steves
Daniel Kouril
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Wesley Giriffin
Per Allansson
Nils Nordman
Simon Wilkinson

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

*

*

* THIS SOFTWARE IS PROVIDED BY THE AUTHOR AS IS" AND ANY EXPRESS OR

* IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
* OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
* IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
* DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

* THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR

TORT

* (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
* THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

$0penBSD: LICENCE,v 1.19 2004/08/30 09:18:08 markus Exp $
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Open NFC

Copyright (c) 2007-2010 Inside Secure, All Rights Reserved.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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linux_libnfc-nci

The original Work has been changed by NXP Semiconductors.

Copyright (C) 2015 NXP Semiconductors

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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Lua

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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USB Host Driver (in FreeBSD)

Copyright (c) 1992-2013 The FreeBSD Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS TAS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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mDNSResponder

Copyright (c) 2002-2013 Apple Computer, Inc. All rights reserved.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS
IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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wpa_supplicant and hostapd
Copyright (c) 2002-2014, Jouni Malinen <j@w1.fi> and contributors All Rights Reserved.
These programs are licensed under the BSD license (the one with advertisement clause removed).

If you are submitting changes to the project, please see CONTRIBUTIONS file for more instructions.

This package may include either wpa_supplicant, hostapd, or both. See README file respective subdirectories
(wpa_supplicant/README or hostapd/README) for more details.

Source code files were moved around in v0.6.x releases and compared to earlier releases, the programs are now built
by first going to a subdirectory (wpa_supplicant or hostapd) and creating build configuration (.config) and running 'make'
there (for Linux/BSD/cygwin builds).

License

This software may be distributed, used, and modified under the terms of BSD license:

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT

OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT

LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE

OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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T-Kernel

This Product uses the Source Code of T-Kernel under T-License 2.0 granted by the T-Engine Forum (www.tengine. org)
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*Please note that the contents of this manual may differ slightly from the actual product purchased as a result of product
improvements.

BROTHER INDUSTRIES, LTD. https://www.brother.com/
1-5, Kitajizoyama, Noda-cho, Kariya 448-0803, Japan.

© 2023 Brother Industries, Ltd. All Rights Reserved. GT60SB
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